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Welcome

Purpose

This book explains how to plan your DNA installation, how to connect your DNA 
computers to switches, voice mail systems, and other systems; how to install and 
configure DNA, how to test the installation; and how to troubleshoot it. 

Prerequisites

Planning a DNA installation requires familiarity with data networking concepts, 
knowledge of your data network topology, and proficiency with Windows NT 
administration. This knowledge is not taught in this book but is essential for a 
successful installation. For this reason, we highly recommend that data network 
administrators take the primary role in planning. PC administrators and telephone 
technicians will most likely take the primary role in actually installing DNA.

Intended Audience

We wrote different chapters of this book for different audiences. The planning 
chapters are written for LAN/WAN administrators, because they are usually most 
experienced with the data networking concepts required to successfully plan the 
installation of a distributed, client-server based software package.

The chapter on preparing your switches is written for telephone technicians, who 
typically have the switch administration knowledge and DEFINITY system 
permissions to perform this task. 

The physical connectivity, installation, configuration, testing, and troubleshooting 
chapters are written for PC administrators, because they are generally most 
familiar with computer equipment configurations and software installation 
activities. 
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Switch and voice mail administrators are not an intended audience for this book 
(unless they are installing the system). Similarly, this book is not written for 
telephony managers, telephone equipment installers, or anyone else, unless they 
are familiar with PC administration, Windows NT administration, and data 
networking concepts required for a successful installation. 

Conventions Used in This Book

In this book, we use the following typographical conventions:

■ We use bold type for emphasis and for any information that you should 
type; for example: save translation.

■ We use Courier font for any information that the computer screen displays; 
for example: login.

■ We use arrows to indicate options that you should select on cascading 
menus; for example: “Select File>Open” means choose the “Open” option 
from the “File” menu.

■ We use small type for any keyboard control keys that you should press; for 
example: Enter.

Trademarks

AUDIX®, CONVERSANT®, DEFINITY®, and Intuity® are registered trademarks of 
Avaya, Inc. Acrobat® is a trademark or registered trademark of Adobe Systems 
Incorporated. Hayes® is a trademark or registered trademark of Hayes 
Microcomputer Products, Inc. Symantec® and pcAnywhere® are U.S. registered 
trademarks of Symantec Corporation and its subsidiaries. U.S. Robotics® is a 
trademark or registered trademark of U.S. Robotics. Windows® and Windows 
NT® are trademarks or registered trademarks of Microsoft Corporation.

Additional Resources

You may find the following additional resources helpful.

For help using DNA, look in the online help. It explains how to make changes to 
DNA’s configuration and how to perform basic switch administration tasks. 

For help with complex switch administration tasks, use the DEFINITY ECS 
Administrator’s Guide (Document Number 555-233-502), which explains system 
features and interactions in detail. A copy of this document is available on the 
DNA documentation CD-ROM.

For a complete list of DEFINITY books, refer to the Avaya Publications Catalog, 
available at: http://www.lucent.com/enterprise/documentation.
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Tell Us What You Think!

Let us know how this book measured up to your expectations. Your opinions are 
crucial to helping us meet your needs! Please complete and return the comment 
card at the front of this book. Optionally, send us your comments by mail, fax, or 
e-mail, as follows:

Mail: Avaya, Inc.
Avaya University
DNA Documentation Team
Room 22-2H24
11900 North Pecos Street
Denver, CO 80234-2703
USA

Fax: DNA Documentation Team
+ 1 303 538 1741

E-mail:document@avaya.com

How to Get This Book on the Web

To view or download the latest version of this book, perform the steps listed next.

1. Install your internet browser.

Most computers are sold with browsers already installed.

2. Get access to the Internet.

If you do not already have access to the Internet, contact your local Internet 
Service Provider (ISP).

3. Set up your browser preferences.

Refer to the documentation that came with your browser.

4. Install Adobe Acrobat Reader with Search, version 3.0 or later.

This is available on your DNA CD-ROM or from: http://www.adobe.com.

5. Access http://support.lucent.com

6. Wait a moment while the web page prepares the popup menus.

7. Position your cursor over Online Services (at the top left of the 
screen).

8. From the popup menu, click Documentation.

9. Click Recent Documents.

10. Locate DEFINITY Network Administration and click it.

If you do not have a service contract, you can still order the book over the web. To 
do so, visit http://www.lucent.com/enterprise/documentation and search for 
document number 555-233-602.



DEFINITY Network Administration Release 3
Planning, Installation, and Configuration  555-233-602CI  

Issue 2
December 2000

Welcome 
4How to Get Other Books on the Web 

1

How to Get Other Books on the Web

You can access the books for many other Avaya products by visiting 
http://www.lucent.com/enterprise/documentation.

How to Order More Copies

To order this book, call or write us and request the following publication:

Order: Document Number:555-233-602CI
Issue: Issue  1
Date: December 2000

Call: Avaya Publications Center

USA
Voice: 1 800 457 1235
Fax: 1 800 457 1764

CALA Asia/Pacific Regions: China, Caribbean, Latin America
Voice: + 1 317 322 6411
Fax: + 1 317 322 6699

EMEA Region: Europe, Middle East, Africa
Voice (in EMEA) +44 1 666 832 900
Fax (in EMEA) +44 1 666 832 213
Voice (in the US): + 1 317 322 6416
Fax (in the US): + 1 317 322 6699

North America Region: Canada, American Samoa, Bahamas, Canada, 
Cayman Islands, Guam, Jamaica, Virgin Islands, and West Indies

Voice: + 1 317 322 6619
Fax: + 1 317 322 6359

Write: Avaya Publications Center
2855 N. Franklin Road
Indianapolis, IN 46219-1344
USA

You can be placed on a standing order list for this and other Avaya documents. 
Standing order enables you to automatically receive updated versions of books or 
document sets, billed to account information that you provide. For more 
information, or to be put on a list, contact the Avaya Publications Center.
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Overview

DEFINITY Network Administration (DNA) is a distributed, client-server based 
switch administration application that offers these powerful features:

■ DNA enables multiple switch administrators to administer the same switch 
(or separate switches) at the same time, remotely.

■ DNA offers improved, graphical station administration and graphical 
system administration screens.

■ DNA has easy-to-use wizards for basic administration tasks.

■ DNA lets you cut through (using terminal emulation) to administer other 
telephony devices (like DEFINITY AUDIX, Intuity AUDIX, and Intuity 
HICAP).

This installation is different

Installing DEFINITY Network Administration (DNA) is more complex than 
installing many off-the-shelf software packages because:

■ DNA is client-server based.

■ DNA server components can be distributed.

■ DNA interfaces with your telephone system.

How you install the software affects its performance and therefore how efficiently 
and reliably your switch administrators can administer your telephone network. 
We encourage you to take the time to plan; this book will aid you in that task.
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Installation Checklist

The installation will follow a process like the one listed below.

1. Design DNA Network

We recommend that a LAN/WAN administrator perform the following tasks, 
with help from the voice organization. These steps are explained in detail in 
Chapter 3 through Chapter 12 (page 13 through page 109).

a. Read about DNA system requirements and software components. 
(Chapter 2; page 5)

b. Gather information about your current PCs and telephone systems. 
(Chapter 4; page 19)

c. Create a map of your current data and telephony network.
(Chapter 5; page 33)

d. Read about how to place DNA components; connection options; 
and sample installation scenarios. (Chapter 6 through Chapter 8; 
page 37 through page 58.)

e. Design the installation by completing all of the planning questions on 
the forms in Chapter 4 (page 19), and completing the Design 
Summary forms in Chapter 9 (page 59).

f. Determine user groups, who should be in which groups, and what 
permissions each user group should have, in conjunction with the 
telecom manager (Chapter 10; page 65 through page 108).

g. If you have an Avaya support contract or you want support during 
DNA’s warranty period, determine where to install modems and 
pcAnywhere (to allow Avaya to access and troubleshoot your 
system). Then complete the TSC Cutover Assistance Request Form 
(form PA002) on page 109.

h. If your company is installing DNA, give a copy of all completed forms 
to the person(s) who will perform the installation. If Avaya is 
installing DNA, simply send the PA002 form to the fax or e-mail 
address on the form.

2. Install And Upgrade DNA Computers

We recommend that PC administrators perform the following tasks. These 
steps are beyond the scope of this book, and are not explained for this 
reason.

a. Purchase computers (if necessary), as specified by the installation 
planner on the Upgrades and Purchases form (page 61).

b. Install new computers (if necessary), and configure Windows.

c. Upgrade existing computers (if necessary) as specified by the 
installation planner on page 61.
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d. Install any necessary Windows Year 2000 patches.

e. Ensure TCP/IP connectivity between all DNA computers (that is, 
make sure they can PING each other). Troubleshoot problems with 
the LAN/WAN administrator.

3. Prepare Switches for DNA

We recommend that a switch technician perform the following tasks.

a. Upgrade DEFINITY ECS systems to R6.3 or later through an 
upgrade PEC (for switches earlier than R5) or QPPCN (for R5 and 
later). ECSs may be optioned as R5 or later.

b. Have Avaya enable the feature, “DEFINITY Network Admin” on the 
customer options form for each DEFINITY ECS system that DNA 
supports (page 114).

c. Have Avaya enable Access Security Gateway (ASG) on each 
DEFINITY ECS system that DNA supports, if you want ASG and it 
isn’t already enabled (page 115).

d. Create DNA “upload” login and “administrative” login for each 
DEFINITY ECS system that DNA supports (page 115).

e. If you purchased DNA’s Enhanced Number Portability (ENP) 
feature, enable each DEFINITY ECS system in your ENP network to 
work with DNA (page 120).

4. Connect DNA Computers to Devices

We recommend that PC administrators or telephone technicians perform 
the following steps.

a. Connect DNA computers to the switches, voice mail systems, and 
other systems specified by the installation planner on the Telephone 
Network Information Form (page 21), following the instructions in 
Chapter 14, "Connecting the Hardware" (page 121).

b. Test and troubleshoot physical connections (page 221).

5. Give Avaya Access to Your System

This step applies if you have a maintenance support agreement with us, or 
if you want us to be able to support you during the warranty period. We 
recommend that PC administrators perform the following tasks.

a. Install modems and pcAnywhere on all computers that you want 
Avaya to be able to access to support DNA.

b. Grant Avaya’s Technical Service Center (TSC) access to your IP 
network, if applicable.

c. Give Avaya the phone number or IP address to access any 
computers it will support, if applicable.
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6. Install or Upgrade DNA

We recommend that PC administrators perform the following tasks.

a. If you want to use DNA’s online help, install Internet Explorer 4.

b. If you want e-mail notification of DNA errors and warnings, install a 
MAPI e-mail client (like Microsoft Exchange or Outlook) on the 
computer that will host the DNA Core Services, and (optionally) set 
up a mailbox on the e-mail server. 

c. Install Clients, Core Services, Connection Services, Button Label 
Printer Services, Device Services, electronic documentation, and 
(optionally) Enhanced Number Portability (ENP) on the computers 
specified during planning (page 173).

7. Configure DNA Server Software

We recommend that PC administrators perform the following tasks.

a. Reboot the computer after installing DNA (before configuring).

b. Set up permissions on DNA’s “data” directories. (page 190)

c. Start DNA and log on. (page 190)

d. Set the password for the root login. (page 191)

e. Register the following:

■ all host computers (page 191)

■ all Connection Services (page 192)

■ all Button Label Printer Services (page 192)

■ all Device Services (page 193)

■ all ENP Services, if applicable (page 194)

f. Configure the following:

■ all Connection Services (page 195)

■ all Button Label Printer Services (page 200)

■ all Device Services (page 200)

■ all ENP Services, if applicable (page 194)

■ the DNA Navigator (page 205)

g. Add DNA users. (page 206)

h. Set up e-mail notification. (page 208)

i. Create groups. (page 214)

j. Assign DNA users to groups. (page 214)

k. Assign permissions. (page 214)
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l. Initialize DNA databases supporting DEFINITY ECS Systems.
(page 214)

m. Set up resynchronization intervals and scheduled maintenance 
periods. (page 218)

8. Test the Installation

We recommend that PC administrators perform the following tasks.

a. Test connections to devices (page 221).

b. Test that a client with full access permissions can connect to each 
device.

c. Test that each type of user group has the permissions specified 
during planning (page 221).

9. Troubleshoot, if appropriate

We recommend that PC administrators perform the following tasks.

a. Make sure that hardware connections were tested when they were 
installed.

b. Troubleshoot any connection problems with installed software
(page 222).

c. Troubleshoot any problems with permissions.

Getting Help with the Installation

If you are located within the United States and you want help installing DNA or 
planning the installation, call your Avaya representative.

If you are located outside the United States and you want help installing DNA or 
planning your installation, contact your Avaya representative or distributor. Call at 
least 4 weeks before the date on which you want to install DNA. 
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Understanding DNA Components

DNA is made up of the following software components:

■ DNA Client Software

■ DNA Server Software—composed of the following parts:

■ DNA Core Services—performs the following tasks:

■ Enables DNA’s different parts to recognize each other.

■ Maintains a schedule of changes to be made to the switch or 
voice mail system, and executes them.

■ DNA Device Service

The Device Service keeps information about the different telephony 
devices (switches, voice mail systems, and so on) that you are 
administering using DNA. It validates any switch data that you enter 
before sending it to the switch, it supports the user interface 
(providing drop-down lists of available ports, for example), and it lets 
you access supported devices via terminal emulation 
(“cut-through”).

■ DNA Connection Service

The Connection Service stores information about any connection 
devices (modems, data modules, terminal servers, and so on) that 
DNA uses to communicate with the telephony devices it supports. It 
also sends the commands to invoke those connections.

■ Button Label Printer Service

The Button Label Printer Service generates the forms you use to 
label telephone buttons. 

■ Enhanced Number Portability Service (optional)

This component supports DNA’s ENP wizard, an optional feature 
that enables you to move stations from one switch to another switch 
in an ENP network, and automatically update UDP tables, or move 
subscribers among voice mail systems in an ENP network. You will 
need to install only one ENP component per ENP network that DNA 
will support (most customers will install only one). 
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You can install all of the DNA components on one computer (space, and 
processor speed permitting), or you can distribute them across your network. 
Figure 1 shows one way that DNA components could be distributed to support an 
installation with two devices.

Figure 1. DEFINITY Network Administration Software Components

We explain how to place DNA components in the section, "Placing NT Servers 
and DNA Components" on page 37.
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Server: Windows NT
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of the DNA Device
Service
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Containing one copy of

the DNA Connection
Service
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Understanding System Requirements

Client Requirements

Client PCs should meet the following requirements: 

Parameter Minimum Requirement

Operating 
system

Windows 95

Other software Internet Explorer 4

Processor PII-233

RAM 64 MB

Available 
Disk Space

200 MB

CD-ROM Yes

Available Serial 
Ports

0

TCP/IP Network 
Configuration

DNS



DEFINITY Network Administration Release 3
Planning, Installation, and Configuration  555-233-602CI  

Issue 2
December 2000

Understanding System Requirements 
14Server Requirements 

3

Server Requirements

Any PC that you use to run DNA server components (see "Understanding DNA 
Components" on page 10 for a list of the DNA server components) must meet the 
following requirements:

Parameter Recommended

Operating 
system

Windows NT Server 4.0, Service Pack 5 with Year 2000 
updates

Other Software Internet Explorer 4 (for all customers)
pcAnywhere 8.0 or later (for customers with service 
contracts), plus a MAPI-compliant e-mail server (like Microsoft 
Exchange) on the network.

Processor PII-300

RAM 128 MB for Core Services + 1 DEFINITY system
160 MB for Core Services + 2 DEFINITY systems
192 MB for Core Services + 3 DEFINITY systems

Virtual Memory 200 MB for Core Services, plus
150 MB per DEFINITY device, plus
20 MB per non-DEFINITY device

Available 
Disk Space

250 MB for Core Services
150 MB for each DEFINITY version
250 MB for each DEFINITY switch

CD-ROM Yes

Available Serial 
Ports

2

TCP/IP Network Yes.

IP Addresses DNS

Display 1024 x 768, 
millions of colors
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Using Static or Dynamic IP Addresses

If a computer is running the DNA client but not the DNA server components, its IP 
address can be dynamic. If a computer is running any DNA server components, 
its IP address must be static. For this reason, on any computer running DNA 
server components, DHCP can be used only if it is configured to give the 
computer the same IP address after each reboot.

Enabling Avaya Remote Services

If you have a maintenance agreement with Avaya for support of DNA, you are 
required to install a modem and a copy of Symantec’s pcAnywhere on the 
computers that you want Avaya to be able to access. pcAnywhere enables Avaya 
personnel to troubleshoot and fix problems on your system.

Before installing pcAnywhere, please read the pcAnywhere security guidelines on 
page 174, or visit the following web site for the latest pcAnywhere security 
information: http://www.symantec.com/pcanywhere/index.html
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Supported Devices

DNA supports the following switches, voice mail systems, and other devices:

Determining software versions

To determine what version of software you are using:

■ DEFINITY ECS Systems

Access the SAT and type list config soft mem.

■ DEFINITY AUDIX Systems

Type list configuration at the command line and check the Software 
Vintage field.

■ Intuity AUDIX Systems

From the Intuity main menu, select Customer/Services Administration> 
System Verification>View Installed Software. When the system displays 
the window, look for the version number in the VERSION field.

Device Supported Releases

DEFINITY ECS R5r, R5si, R5vs
R6r, R6si, R6vs, R6csi
R7r, R7si, R7csi
R8r, R8si, R8csi
R9r, R9si, R9csi

The above releases must be running one of the following 
loads:

G3V6i.03.0.223.5 G3V6r.03.0.223.5
G3V6i.03.1.230.6 G3V6r.03.1.230.6
G3V6i.03.2.239.3 G3V6r.03.2.239.3
G3V6i.03.3.246.1 G3V6r.03.3.246.1
G3V6i.03.4.253.1 G3V6i.03.4.253.1
G3V7i.01.0.343.7 G3V7r.01.0.343.7
G3V8i.01.0.025.3 G3V8r.01.0.025.3
G3V8i.02.0.034.2 G3V8r.02.0.034.2
G3V8i.03.0.042.1 G3V8r.03.0.042.1
G3V8i.04.0.046.5 G3V8r.04.0.046.5
G3V9i.01.0.031.3 G3V9r.01.0.031.3

The Version field in the Customer Options form should have 
the value V5 or greater. 

DEFINITY AUDIX 3.2, 4.0 SLIM

Intuity AUDIX 4.3, 4.4, 5.0

Intuity HICAP 5.0
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Supported DEFINITY releases (by DNA release)

DEFINITY Release
DNA
1, 1.0.1

DNA 
1.1

DNA 
1.2

DNA 
2.0

DNA 
2.0.1

DNA 
2.0.2

DNA 
2.0.3

DNA 
3.0

G3V6(i/r).03.0.223.5 X X X X X X X X

G3V6(i/r).03.1.230.6 X X X X X X X X

G3V6(i/r).03.2.239.3 X X X X X X X

G3V6(i/r).03.3.246.1 X X X X X

G3V6(i/r).03.4.253.1 X X

G3V7(i/r).01.0.343.7 X X X X X X

G3V8(i/r).01.0.025.3 X X X X X

G3V8(i/r).02.0.034.2 X X X

G3V8(i/r).03.0.042.1 X X X

G3V8(i/r).04.0.046.5 X X

G3V9i(i/r).01.0.031.3 X
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Gathering Information About Your 
Networks

The first step in planning a DNA installation is to inventory your needs and 
resources. To do so, complete the following steps:

1. Complete a Telephone Network Information form (page 21) for each switch, 
voice mail system, or other device that DNA will support.

2. Complete a Data Network Information form (page 25) for each PC that will 
host DNA software.

NOTE:
Photocopy the forms as many times as necessary. Complete only “Basic” 
questions. Do not complete the “Planning” questions yet. 

NOTE:
The completed worksheets contain highly sensitive information about your 
telephone system. Keep them in a secure location at all times, and do not 
give them to persons without adequate security clearance and a direct need 
to know the information.

After you complete the “Basic” questions, read these chapters to understand 
planning:

■ Chapter 5, "Mapping Your Networks"

■ Chapter 6, "Placing NT Servers and DNA Components"

■ Chapter 7, "Understanding Connection Options"

■ Chapter 8, "Sample Installation Scenarios"

After you read the planning chapters, complete the questions and forms listed in 
Chapter 9, "Designing the Installation". Finally, read Chapter 10 through 12 to plan 
DNA permissions. When you are done, you will be ready to install DNA.
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Customer Name: ________________________Date: ______________ DNA Version: _______________

I. DEFINITY ECS: Complete the following. Work with your Telecom Manager for answers to questions 1-18.

CONTINUED ON NEXT PAGE

Switch 1 Switch 2 Switch 3 Switch 4

1. Switch Name:

2. Physical Location:

3. Switch Model & Release:

4. Software Load Number:

5. Use Level:

6. Switch Node Number (ENP):

7. DNA Init Login ID:

8. DNA Init Password:

9. DNA Init Secret Key:

10. DNA Admin Login:

11. DNA Admin Password:

12. DNA Admin Secret Key:

13. Connecting Method or Dev:

14. Connecting Device Model:

15. Connecting Dev Phone #:

16. Hunt Group Number:

17. Hunt Group Lead Extension:

18. System Port:

19. Connection Service PC Name:

20. CS PC COM Port:

21. CS PC COM Port IRQ:

22. Term Svr IP address (if app)

Telephone Network Information Form
Photocopy this form for each switch you want to administer with DNA.
See reverse side for instructions.

Questions 1-6 = Basic Questions 7-22 = Planning
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1. Switch Name: The name of the switch as the switch administrators know it.

2. Physical Location: The physical location of the system, in terms that are meaningful to you and the installers.

3. Switch model/release: For example, G3rV4. Supported releases are listed on page 16.

4. Software load number: Indicate the version number of the DEFINITY software that is running on your switch. 
To determine this, 1) Log into the switch. 2) type list config soft mem.

5. Use Level: Indicate whether this switch is administered lightly or heavily. If this switch is administered heavily, 
put its Device Service on dedicated servers or servers that support switches that are not heavily administered.

6. Switch Node Number: (If you purchased ENP.) To determine the node number, access the switch and type 
display dialplan on the command line. Then note the number listed in the field named “Local Node Number.”

7. DNA Init Login ID: DNA uses this login when accessing the switch to download translations to the mirror 
image database. Specify the login ID that you want DNA to use. DO NOT REUSE EXISTING or COMMONLY 
USED LOGINS or DNA’s resync function will not work properly!  (See page 115). During installation, your 
switch technician must create this login on the switch, using the instructions on page 115. In addition, the 
person who configures DNA must specify this login when configuring DNA, as specified on page 202.

8. DNA Init password:  Specify the password that you want DNA to enter when using the above login ID. Your 
switch technician must specify this password when creating the Init login on the switch.

9. DNA Init Secret Key:  This is the 20-digit key that DNA must enter along with the above login ID and 
password, only if ASG is enabled on this switch. ASG is an optional security feature on DEFINITY ECS 
switches. To determine if this switch is using ASG, see page 114. If this switch is using ASG, then your switch 
either already has an ASG Secret Key (ask the Telecom Manager for it) or your switch technician must it set up 
(see page 115). If the switch technician must set it up, you can either specify it yourself (here) or let the 
DEFINITY system create one for you. If you create it, it must conform to the rules on page 116.

10-12. DNA Admin Login ID, Password, and Secret Key:  These are as described in 7, 8, and 9, except they 
are for the switch login that DNA will use to make day-to-day administrative changes to the switch.

13. Connecting Method or Device:  Indicate how you plan to connect the PC that contains Connection Service 
for this switch, to this switch. For example: direct connect, ADU, data module, modem, terminal server.

14. Connecting Device Model:  For example, 8400B+ data module.

15. Connecting Device Phone Number: If DNA is connecting to this switch using a dial-up connection (data 
module or modem), then specify the phone number DNA should dial to access the switch. Be sure the 
number is not for the INADS port! See note on page 49.

16. Hunt Group Number:  Enter the extension number of the hunt group associated with the data module or 
modem being used to access the switch. 

17. Hunt Group Lead Extension:  Enter the lead extension associated with the above hunt group. To find this, 
enter display hunt-group <number> where <number> is the hunt group number above. 

18. System Port: Enter the extension number associated with the System Port that is connected to the 
data module or modem in Item 16.

19. Connection Service PC Name:  Indicate the name of the computer that hosts the Connection Service that 
supports this switch.

20. CS PC COM Port:  Indicate which COM port the PC is using to connect to this switch. For example: COM 1.

21. CS PC COM Port IRQ:  1) Start>Settings>Control Panel. 2) Double-click Ports. 3) Highlight the COM port that 
is connected to the data module or modem you are using to access the switch, and click Advanced.

22. Terminal Server IP address:  If DNA is connecting to the switch through a terminal server, enter the IP 
address. Not applicable if you are not connecting through a terminal server.

Questions 1-6 = Basic Questions 7-22 = Planning
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Customer Name: ________________________________________Today’s Date: _________________________

II. Voice Mail Information: If the device is a voice mail system, provide the following information.

II. Other Device Information: If the device is neither a switch nor a voice mail system, provide the following: 

Voice Mail 1 Voice Mail 2 Voice Mail 3 Voice Mail 4

23. Voice Mail System Name:

24. Physical Location:

25. Make/Model/Release:

26. Software Load Number:

27. Login:

28. Password:

29. ASG Secret Key:

30. CS PC Name:

31. CS PC COM Port:

32. Connecting method/device:

33. Connecting Dev Model:

34. Access Number/IP Address:

System 1 System 2 System 3 System 4

35. System Name:

36. Physical Location:

37. Make/Model/Release:

38. Software Load Number:

39. Login:

40. Password:

41. CS PC Name:

42. CS PC COM Port:

43. Connecting method/device:

44. Connecting Dev Model:

45. Access Number/IP Address:

Questions 23-26 & 35-38 = Basic Questions 27-34 & 39-45 = Planning
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23. Voice Mail System Name: The name of the system as the voice mail administrators know it.

24. Physical Location: The physical location of the system, in terms that are meaningful to you and the installers.

25. Make/Model/Release: Indicate the make, model, and release of the system. For example, Intuity AUDIX R4.

26. Software Load Number: Indicate the version number of the AUDIX software that is running on your system (if 
applicable). To determine this, ask the telephony manager, or complete the following steps. 

■ For Intuity AUDIX systems: From the Intuity main menu, select Customer/Services Administration> 
System Verification>View Installed Software. Look for the version number in the VERSION field.

■ For DEFINITY AUDIX systems: At the command line, type list configuration . Then check the 
Software Vintage field.

27. Login ID: Indicate the login ID that DNA should use to gain access to this voice mail system. 

28. Password: Specify the password that DNA should use with the above login ID.

29. ASG Secret Key: ASG is an optional security feature on AUDIX voice mail systems. In this row, specify the 
the 20-digit key that DNA must enter in conjunction with the login ID and password, if ASG is enabled on this 
voice mail system. To determine if ASG is enabled, complete the following steps: 1) Log in to the Intuity AUDIX 
system. 2) At the INTUITY Main Menu, select ASG Security Administration. 3) Select ASG Security Port 

Administration. If the Secure field has a value of YES for any of the ports, then your Intuity AUDIX system 

has the ASG feature enabled for that port.

30. Connection Service PC Name: Indicate the name of the computer that hosts the Connection Service that 
supports this voice mail system.

31. CS PC COM Port: Indicate which COM port the PC is using to connect to this voice mail system.

32. Connecting Method or Device: Indicate how you plan to connect the PC that contains Connection Service 
for this voice mail system, from this PC to this voice mail system. For example: data module or network.

33. Connecting Device Model: For example, 8400B+ data module.

34. Access Number / IP address: Specify the phone number DNA should dial, or the IP address DNA should 
use, to gain access to this system.

35. System Name: The name of the system as the administrators know it.

36. Physical Location: The physical location of the system, in terms that are meaningful to you and the installers.

37. Make/Model/Release: Indicate the make, model, and release of the system, as appropriate.

38. Software Load Number: Indicate the version of the software that is running on your system (if applicable). 

39. Login ID: Indicate the login ID that DNA should use to gain access to this system (if applicable). 

40. Password: Specify the password that DNA should use with the above login ID (if applicable).

41. Connection Service PC Name: Indicate the name of the computer that hosts the Connection Service that 
supports this system.

42. CS PC COM Port: Indicate which COM port the PC is using to connect to this system. For example: COM 1.

43. Connecting Method or Device: Indicate how you plan to connect the PC that contains Connection Service 
for this system, from this PC to this system. For example: data module or network.

44. Connecting Device Model: For example, 8400B+ data module.

45. Access Number / IP address: Specify the phone number DNA should dial, or the IP address DNA should 
use, to gain access to this system.

Questions 23-26 & 35-38 = Basic Questions 27-34 & 39-45 = Planning
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Customer Name: _________________________ Date: _____________ PC Name:____________________

CONTINUED ON NEXT PAGE

* If, for some reason, you are installing all DNA software on the same computer, you do not have other clients, and 
do not need to communicate with other devices on your data network, then you don’t need to answer Questions 
10, 11, 12, or 14, and you can use the computer name instead of FQDN in question 13.

1. Physical Location

2. Circle one: Is this a... Client PC Server PC Both

3. Make/Model

4. Processor Type and Speed
Compare to requirements. (page 13)

5. OS Type, Version, Service Pack
Compare to requirements. (page 13)

6. Available Memory (RAM)
Compare to requirements. (page 13) MB

7. Virtual Memory (for servers only)
Compare to requirements. (page 13) KB MB

8. Available Disk Space & Capacity
Compare to requirements. (page 13)

__: Drive MB GB (free) MB GB (total)
C: Drive MB GB (free) MB GB (total)

9. Available Serial Ports
Compare to requirements. (page 13)

10. Network Interface Card
(For troubleshooting purposes only.)

11. Network Type*
Compare to requirements. (page 13)

12. Domain Name (for servers only)*
(Used in Step 9 on page 176 and 
in Step 8 on page 181.)

13. FQDN (for servers only)*
(Used in Step 10 on page 176 and 
in Step 9 on page 182.)

14. IP Address (for servers only)*
(Used in Step 10 on page 176 and 
in Step 9 on page 182.)

Data Network Information Form
Photocopy this form (4 pages) once for each DNA client or server PC. 
See reverse side of each page for instructions.

Questions 1-14 = Basic No planning questions on this page.
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PC name: Enter the name that is most meaningful to you and the people who will maintain DNA (either the 
common name, or the name as it is known on your network). To determine the computer name as it is known 
to the network, complete the following steps: 1) Choose Start>Settings>Control Panel. 2) Double-click 
Network. 3) Click the Identification tab. The PC name is listed in the Computer Name field.

3. Make & Model: Obtain this from the documentation that came with your PC, or contact the manufacturer.

4. Processor type & speed: Obtain this from the documentation that came with your PC, or contact the 
manufacturer. 

5. OS Type, version, service pack: 1) Choose Start>Settings>Control Panel. 2) Double-click System. 3) Click 
the General tab (if it isn’t selected). Under the “System” heading, the operating system and version number 
are listed. If not, obtain them from the documentation that came with your PC, or contact the manufacturer. 
You can get the service pack by rebooting and watching for the (blue) Hardware Initialization Screen.

6. Available memory (RAM): 1) Choose Start>Settings>Control Panel. 2) Double-click System. 3) Click the 
General tab (if it isn’t selected). Under the “Computer” heading, RAM will be listed in KB. If it is not listed there, 
obtain this from the documentation that came with your PC, or contact the manufacturer.

7. Virtual memory: 1) Choose Start>Settings>Control Panel. 2) Double-click System. 3) Click the Performance 
tab. In the area called “Virtual Memory,” virtual memory will be listed after “Total paging file size for all disk 
volumes:”

8. Available disk space & Capacity: 1) Open Windows File Explorer or Windows File Manager. 2) Highlight the 
drive that contains DNA. 3) Right-click the drive and choose Properties. Click the General tab (if it isn’t 
selected). Available disk space will be listed under “Free Space.” Hard Disk Capacity: On the same tab, listed 
under “Capacity.”

9. Available serial ports: The best way to determine available serial ports is to look at the back of the computer. 
Serial ports have either a 9-pin or 25-pin female adapter. Most computers are manufactured with a default of 2 
serial ports. You may already be using both, one, or none.

10. Network Interface Card: 1) Choose Start>Settings>Control Panel. 2) Double-click Network. 3) Click the 
Adapters tab. Under the “Network Adapters,” the network card type will be listed. If it is not listed there, obtain 
this from the documentation that came with your PC, or contact the manufacturer.

11. Network Type: Indicate Ethernet, Token-Ring, etc.

12. Domain name: To determine the domain name, complete the following steps: 1) Choose 
Start>Settings>Control Panel. 2) Double-click Network. 3) Click the Identification tab. The domain name is 
listed in the Domain field.

13. FQDN: Fully-qualified domain name. The FQDN is the PC name followed by the Domain Name. For example, 
dnapc1.department.company.com. You can find the PC name and Domain as follows: 1) Choose Start> 
Settings>Control Panel. 2) Double-click Network. 3) Click the Identification tab. 

14. IP Address: 1) Choose Start>Settings>Control Panel. 2) Double-click Network. 3) Click the Protocols tab. 4) 
Highlight TCP/IP Protocol. 5) Click Properties. 6) Click the IP Address tab (if it isn’t selected). The IP address 
is listed in the area marked “Specify an IP address,” in the IP Address field. Be sure you are not using DHCP 
for the Core Services PC, because if DHCP reassigns the IP address of the Core Services PC, DNA will 
not function and may require a reinstallation.

CONTINUED ON NEXT PAGE

Questions 1-14 = Basic No planning questions on this page.
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Customer Name: _________________________  Date: _____________  PC Name:______________________

* If, for some reason, you are installing all DNA software on the same computer, you do not have other clients, and 
do not need to communicate with other devices on your data network, then you don’t need to answer Questions 
15 through 19.

15. Subnet Mask:* (for server PCs only)
(For troubleshooting purposes only.)

16. Gateway:* (for server PCs only)
(For troubleshooting purposes only.)

17. DNS Server:* (for server PCs only)
(For troubleshooting purposes only.)

18. Primary WINS Server:* (servers only)
(For troubleshooting purposes only.)

19. Secondary WINS Server:* (servers only)
(For troubleshooting purposes only.)

20. pcAnywhere version: (servers only) (required for Avaya support)

21. pcAnywhere access number: (required for Avaya support)

22. pcAnywhere Login: (required for Avaya support)

23. pcAnywhere password: (required for Avaya support)

24. Currently loaded applications: pcAnywhere (required for Avaya support)

Questions 15-19 & 24 = Basic Questions 20-23 = Planning
CONTINUED FROM PREVIOUS PAGE.
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15. Subnet Mask (for server PCs only): 1) Choose Start>Settings>Control Panel. 2) Double-click Network. 3) 
Click the Protocols tab. 4) Highlight TCP/IP Protocol. 5) Click Properties. 6) Click the IP Address tab (if it isn’t 
selected). Subnet mask is listed on this page.

16. Gateway (for server PCs only): 1) Choose Start>Settings>Control Panel. 2) Double-click Network. 3) Click 
the Protocols tab. 4) Highlight TCP/IP Protocol. 5) Click Properties. 6) Click the IP Address tab (if it isn’t 
selected). Gateway is listed on this page.

17. DNS Server (for server PCs only): 1) Choose Start>Settings>Control Panel. 2) Double-click Network. 3) 
Click the Protocols tab. 4) Highlight TCP/IP Protocol. 5) Click Properties. 6) Click the DNS tab. DNS server is 
listed on this page.

18. Primary WINS server (servers only): 1) Choose Start>Settings>Control Panel. 2) Double-click Network. 3) 
Click the Protocols tab. 4) Highlight TCP/IP Protocol. 5) Click Properties. 6) Click the WINS Address tab. 
Primary WINS server is listed on this page.

19. Secondary WINS server (server only): Same steps as in Item 18.

20. pcAnywhere version: If your company has a contract with Lucent for DNA support , you are required to 
install pcAnywhere on all computers where DNA server components (Core Services, Connection Services, 
Device Services, Button Label Printer Service, or ENP services) are installed. You must install pcAnywhere 
version 8 or later. Indicate on this row the version of pcAnywhere installed on this computer.

21. pcAnywhere access number: Indicate the phone number that Lucent remote support should dial to gain 
access to this computer via pcAnywhere.

22. pcAnywhere login: Indicate the login ID that Lucent remote support should enter to gain access to this PC 
via pcAnywhere.

23. pcAnywhere password: Indicate the password that Lucent remote support should enter to gain access to 
this PC via pcAnywhere.

24. Currently loaded applications: List all applications that are installed on this PC.

Questions 15-19 & 24 = Basic Questions 20-23 = Planning
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Customer Name: _________________________ Date: _____________ PC Name:____________________

25. Check the DNA components you want on this PC and provide requested information for checked boxes.

❒ Core Services 

❒ Connection Service:

Serial Port Connection Information: If you need space for more serial ports, create a table like this and 
attach it to this form.

Network Connection Information: If you need space for more network connections, create a table like 
this and attach it to this form.

COM Port # ____ COM Port # ____

a. Name of device:

b. Make and model of device:

c. Connecting method or device:

d. Connecting device model:

e. Serial Device Script to use: 

f. End Point Script to use:

g. Name of Device Service this COM port serves:

h. DNA name for this Serial Port Connection.

i. Access number:

Network Cnxn# ___ Network Cnxn# ___

j. Name of device:

k. Make and model of device:

l. End Point Script to use:

m. Name of Device Service this network connection 
serves:

n. DNA name for this Network Connection.

o. IP Address:

p. TCP/IP Service/Socket

Question 25 = Planning
CONTINUED FROM PREVIOUS PAGE.
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25. Core Services: Check this box only if you want the DNA Core Services software installed on this PC.

Connection Service: Check this box only if you want the Connection Services software installed on this PC.

Serial Port Connection Information: Complete this table only if this PC connects to devices via serial 
ports. The information will be used when configuring the Connection Service. 

a. Name of device: For reference purposes only. If you have completed the Telephone Network 
Info Form, you can get this information from Q.1, p. 21; Q.23, p. 23; or Q.35, p. 23.

b. Make and model of device: For troubleshooting purposes only. You can get this information 
from Q.3, p. 21; Q.25, p. 23; or Q.37, p. 23.

c. Connecting method or device: For troubleshooting purposes only. You can get this information 
from Q.13, p. 21; Q.32, p. 23; or Q.43, p. 23.

d. Connecting device model: For troubleshooting purposes only. You can get this information from 
Q.14, p. 21; Q.33, p. 23; or Q.44, p. 23.

e. Serial Device Script to use: This is used on page 195 and in Step 5 on page 197. Choose none 
for (direct connect), 7400, 8400, ADU, Generic Modem, PDU, or specify the name for another.)

f. End Point Script to use: This is used on page 196 and in Step 5 on page 198. Choose 
DEFINITYAudix, DEFINITYECS, DEFINITYECSdirect, or specify the name for another.

g. Name of Device Service this COM port serves: Complete this question after you determine the 
name of the Device Service for the device that this connection will serve. You may not know this 
until you complete the Device Service section (page 31) for each DNA computer. This 
information is used in Step 2 on page 198. 

h. DNA name for this Serial Port Connection. For example, COM1 to WestCampusSwitch. This 
is used in Step 7 on page 199.

i. Access number: This is used in Step 7 on page 199. You can get this information from Q.15, p. 
21; Q.34, p. 23; or Q.45, p. 23.

Network Connection Information: Complete this table only if this PC connects to devices via the 
network. The information will be used when configuring the Connection Service. 

j. Name of device: For reference purposes only. If you have completed the Telephone Network 
Info Form, you can get this information from Q.1, p. 21; Q.23, p. 23; or Q.35, p. 23.

k. Make and model of device: For troubleshooting purposes only. You can get this information 
from Q.3, p. 21; Q.25, p. 23; or Q.37, p. 23.

l. End Point Script to use: This is used on page 196 and in Step 5 on page 198. Choose 
DEFINITYAudix, DEFINITYECS, DEFINITYECSdirect, or specify the name for another.

m. Name of Device Service this network connection serves: Complete this question after you 
determine the name of the Device Service for the device that this connection will serve. You may 
not know this until you complete the Device Service section (page 31) for each DNA computer. 
This information is used in Step 2 on page 198.

n. DNA name for this Network Connection: For example, TCP/IP to EastCampusSwitch. This is 
used in Step 6 on page 198.

o. IP Address:
This is used in Step 6 on page 198. If you have completed the Telephone Network Info Form, you 
can get this information from Q.22, p. 21; Q.34, p. 23; or Q.45, p. 23.

p. TCP/IP Service/Socket: This is used in Step 6 on page 198. 

Question 25 = Planning
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❒ DNA Client

❒ Button Label Printer Service: 

❒ Device Service: 

❒ Enhanced Number Portability Service:

Printer Name BLPS Name UNC Pathname

Model/Version/Load Device Name Device Service Name

ENP Network Name Device Name
Switch only:
Node Number

Switch only:
Update UDP table?

Question 25 = Planning
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Button Label Printer Service: List the UNC name of each network laser printers for which a Button Label 
Printer Service will be installed on this computer. See the example below.

NOTE:
Button Label Printer Service names are case sensitive and cannot contain special characters, 
such as / \ * ? & % @ ! ^. 

Device Services: Check this box and complete the table only if you are installing DNA Device Services on this 
PC. DEFINITY systems Model/Version/Load information must match the list of supported devices (page 16) if 
you want to use DNA’s GEDI feature.

NOTE:
Device Service names are case sensitive and cannot contain special characters, such as / \ * ? & 
% @ ! ^. We suggest naming the Device Service the same as the Device Name, so you know 
which Device Service serves which device.

Enhanced Number Portability Service: List the devices that you want to be part of the ENP network, plus 
(for switches) Node Numbers and whether or not to update the routing tables. See the example below.

Printer Name BLPS Name UNC Pathname

Example: Oilcan Oilcan \\myserver\oilcan

Model/Version/Load Device Name Device Service Name

Example: G3r R7.1 Load 343.7 West Campus West Campus

ENP Network Name Device Name
Switch only:
Node Number

Switch only:
Update UDP table?

Example:
West Campus West Campus switch 523 Yes

West Campus voice mail n/a n/a

East Campus East Campus switch 55 Yes

East Campus voice mail n/a n/a
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Mapping Your Networks

After you inventory your networks, you must create a composite map of all 
equipment that will be a part of your DNA installation. Ideally, you will also 
associate each piece of equipment on the map with the “inventory” information 
you gathered in the last chapter. Figure 2 on page 34 shows an example of what 
your map might look like before you start making design decisions. 

Your map should show: 

■ Each piece of equipment (data or telephony) that will be involved with DNA.

Ideally, the map would show all of the equipment on your entire data and 
telephony network, so that a single map could serve as your reference in 
devising multiple or alternate installation strategies. Less ideally, the map 
would show just the equipment you know will be involved with DNA.

■ The connections between these pieces of equipment.

■ The geographical location of sites, if there is more than one.

■ The “inventory” information you gathered.

You can either put the inventory information in the map or reference a 
paper record or database entry that contains the information.
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Figure 2. Example Composite Map of Data and Telephony Networks Before Installing 
DNA
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1. Client
Computer Name:  “Mariner”
Location:  Chicago
IP Address:  126.10.10.10
Processor:  Pentium 90
RAM:  32 Mb
Virtual Mem:  32 Mb
Avail Space:  150 Mb of 500
CD-ROM:  4x
Avail Ser. Ports:  1
Network Card:  Ethernet; TCP/IP
Display:  256 color, 800x600
OS:  WinNT 4

2. Client
Computer Name: “Ahab”
Location: Chicago
IP Address: 126.10.10.11
Processor: Pentium 90
RAM: 32 Mb
Virtual Mem: 75 Mb
Avail Space: 250 Mb of 1 GB
CD-ROM: 8x
Avail Ser. Ports: 1
Network Card: Ethernet; TCP/IP
Display: 256 color, 800x600
OS: WinNT 4

3. Network
Protocol: TCP/IP
Topology: Ethernet 10-base T

4. Router

5. Server
Computer Name: “Willie”
Location: Chicago
IP Address: 126.10.10.12
Processor: Pentium 120
RAM: 64 Mb
Virtual Mem: 125 Mb
Avail Space: 2 GB of 8Gb
CD-ROM: 8x
Avail Ser. Ports: 1
COM1: data module to “Chicago”
Network Card: Ethernet; TCP/IP
Display: 256 color, 800x600
OS: WinNT 4

6. File Server
Computer Name: “Moby”
Location: Chicago
IP Address: 126.10.10.13
Processor: Pentium 90
RAM: 32 Mb
Virtual Mem: 150 Mb
Avail Space: 6 GB of 36Gb
CD-ROM: 8x
Avail Ser. Ports: 1
Network Card: Ethernet; TCP/IP
Display: 256 color, 800x600
OS: WinNT 4

7. Printer
Model: HP LaserJet 4

8. Data Module
Model: AT&T 7400B

9. Switch
Name: “Chicago”
IL Number: 0123456789
Location: Chicago
Model: DEFINITY G3r
Version: G3V6r.03.0.223.5
Connection Type: Dial-up serial
(digital port through data module to 
COM1 on “Willie”)
IP address: Not applicable
Dial-up number: 555-6622
Trunked?Yes
Trunked to which?19 (“Atlanta”)
Using UDP?No
Digital trunk?Yes
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10. Voice Mail
IL Number: 0123456789
Location: Chicago
Model: INTUITY AUDIX
Version: Release 4
Connection Type: Network connection
IP address: 126.10.10.14
Dial-up number: Not applicable
Supported switch: 9 (“Chicago”)

11. PSTN

12. LAN or WAN

13. Client
Computer Name: “Pandora”
Location: Atlanta
IP Address: 125.10.10.10
Processor: Pentium 90
RAM: 32 MB
Virtual Mem: 32 MB
Avail Space: 1 GB
CD-ROM: 4X
Avail Ser. Ports: 1
Network Card: Ethernet:  TCP/IP
Display: 256 color, 800x600
OS: Windows 95

14. Client
Computer Name: “Circe”
Location: Atlanta
IP Address: 125.10.10.11
Processor: Pentium 90
RAM: 32 MB
Virtual Mem: 64 MB
Avail Space: 1 GB
CD-ROM: 4X
Avail Ser. Ports: 2
Network Card: Ethernet; TCP/IP
Display: 256 color, 800x600
OS: Windows 95

15. Router

16. Network
Protocol: TCP/IP
Topology: Ethernet 10-base T

17. Printer
Model: HP LaserJet 4

18. Server
Computer Name: Sisyphus
Location: Atlanta
IP Address: 125.10.10.12
Processor: Pentium 133
RAM: 128 MB
Virtual Mem: 270 MB
Avail Space: 3 GB
CD-ROM: 8X
Avail Ser. Ports: 2
Network Card: Ethernet:  TCP/IP
Display: 256 color, 800x600
OS: Window 4.0, Serv Pck 3

19. Switch
Name: “Atlanta”
IL Number: 1234567890
Location: Atlanta
Model: DEFINITY G3i
Version: G3V6i.03.0.223.5
Connection Type: Direct serial (to SAT)
IP address: Not applicable
Dial-up number: Not applicable
Trunked?Yes
Trunked to which?10 (“Chicago”)
Using UDP?No
Digital trunk?Yes

20. Voice Mail
IL Number: 4567891011
Location: Atlanta
Model: DEFINITY AUDIX
Version: 3.2
Connection Type: Dial-up serial
IP address: Not applicable
Dial-up number: 555-6789
Supported switch: 19 (“Atlanta”)

21. System Administration Terminal
Model: 715
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Placing NT Servers and 
DNA Components

Placing NT Servers

In general, place NT servers close to people who can maintain and troubleshoot 
them, in a way that reduces network traffic and saves connection costs. Where 
you put NT servers may depend on where you place DNA components; for this 
reason, review the following sections before making your final decisions.

Placing DNA Components

DNA’s components must be installed on computers that use the operating 
systems listed in the following table. For operating system requirements, see 
"Understanding System Requirements" on page 13.

DNA Component Win95 Win98 WinNT4

Client software X X X

Connection Service X X X

Core Services X

Device Services X

Button Label Printer Service X

Enhanced Number Portability X
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As long as a DNA component is installed on the correct operating system, you can 
place it anywhere on your network. Many customers place all DNA components 
on a single server, but your ability to do this depends on the number of switches 
and voice mail systems you are supporting. If you choose to distribute DNA 
components over multiple servers, we suggest the following placement 
guidelines, which are explained in detail in the sections that follow.

Placing Core Services

DNA’s Core Services component supplies DNA’s scheduling functionality and task 
repository, among other functionality.

How many to install

Install only one copy of the Core Services component for a given DNA installation.

Where to install

Install the Core Services component on a server that is close to the 
most-frequently-accessed clients. The farther away the Core Services software is 
from the client, the slower the client will respond.

How this affects placing the NT server

Put an NT server close to the most frequently-used clients, so you can install the 
Core Services component close to them.

When placing the... Be sure to...

Core Services Put it near the clients.

Device Service Put it near the device.

Connection Service Put it near the device.

Button Label Printer Service Put it near the button label printer.

Enhanced Number Portability Put it near the Core Services.
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Placing Device Services

DNA’s Device Service component stores information about each device that DNA 
supports. For DEFINITY ECS switches, the Device Service stores a local copy of 
the translations; switch administrators interact with the local copy rather than with 
the switch itself. This enables DNA to validate data before sending it to the switch. 
It also enables multiple switch administrators to administer a single switch 
simultaneously, because the Device Service handles all of the administration 
requests and sends a single set of instructions to the DEFINITY ECS.

How many to install

Install one copy of the Device Service for each device you want to support. For 
example, if you are using one NT server to support three devices, install three 
Device Services on that server.

Where to install

When placing the Device Service, follow these guidelines:

■ Don’t install Device Services for more than two or three 
simultaneously-accessed switches on the same NT server.

■ If possible, do not allow network bottlenecks or large distances to separate 
the Device Service from a switch.

How this affects placing the NT server

Put an NT server close to the devices it supports, and allocate one server for 
every two to three DEFINITY ECS switches you want to access.
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Placing Connection Services

DNA’s Connection Service component stores information about how to connect to 
the devices that DNA supports. It also sends the necessary commands to invoke 
those connections.

How many to install

How many copies you install depends on how you are connecting to your devices:

■ If you are connecting via dial-up serial connection (modems or data 
modules) or direct serial connection (null modems or ADUs), install one 
copy of the Connection Service on each computer that is connected to the 
devices. 

Figure 3. Placing the Connection Service on computers with direct or dial-up 
connections to devices
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■ If you are connecting via network connection (terminal server or network 
port), install one copy of the Connection Service for all of the devices that 
are being accessed via network connections.

Figure 4. Placing the Connection Service on computers with network 
connections to devices

Where to install

Where you install the Connection Service depends on whether you will be using a 
private network (WAN or private telephone network) or the Public Switched 
Telephone Network (PSTN) to communicate with your devices. To decide where 
to install the Connection Service, answer the following questions:
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Using the Connection Service with the PSTN

1. Do you only have access to the PSTN?

■ If yes, you can only use dial-up connections to access your remote 
devices. Ignore the remaining questions. Install the Connection 
Service on the computer that has the dial-up connection to the 
device. 
(See Figure 5.)

■ If no, read the next two questions.

Figure 5. Placing the Connection Service on computers with only PSTN 
dial-up access to devices
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Using the Connection Service with a 
Private Telephone Network

1. Do you have a private telephone network to your devices?

■ If yes, you can probably afford to install the Connection Service far 
from the remote device (and use dial-up connections), because you 
do not have to pay regular long-distance charges. However, before 
choosing this option, you may want to evaluate the effects of adding 
traffic to your private telephone network. (See Figure 6.)

■ If no, you can still save on long-distance costs if you have a WAN 
out to the remote devices. Read the next question. 

Figure 6. Placing the Connection Service on computers with PTN dial-up 
access to devices
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Using the Connection Service with a WAN

1. Do you have a WAN out to your devices?

If yes, you can either:

■ Install the Connection Service on a computer close to the devices 
(for dial-up or direct connections from that computer to the device). 
(See Figure 7.)

Figure 7. Placing the Connection Service on computers with WAN access to 
devices (Option 1)
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■ Or, you can install the Connection Service far from the devices, 
using the WAN to communicate (via terminal server for DEFINITY 
ECS — see Figure 8, or via a network connection for Intuity AUDIX).

Figure 8. Placing the Connection Service on computers with WAN access to 
devices (Option 2)
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Summary for placing the Connection Service

Whether you should use the PSTN, a private telephone network, or a WAN 
ultimately depends on availability (most companies use whatever network they 
have), your performance expectations, and cost to your company for each option.

We recommend the following strategies:

■ If you have a computer close to the devices, and it has enough available 
COM ports to connect to the devices or COM ports can easily be installed, 
then install the Connection Service on it.

■ If you do not have a computer close to the devices, install the Connection 
Service wherever it minimizes long-distance costs.

■ If you have a WAN and you can connect to all of your devices via network 
connections (see the table in "Understanding Connection Options" on page 
49), then install the Connection Services anywhere.

Placing Button Label Printer Services

The Button Label Printer Service generates the forms you use to label telephone 
buttons. It works in conjunction with your laser printer to print telephone labels.

Printer requirements

To print button labels, DNA must have access to a laser printer. You can use any 
network laser printer that has a UNC name (for example, \\myserver\deptprinter), 
for which you have installed a printer driver.

How many to install

Install one Button Label Printer Service for each network laser printer you want to 
use with DNA. You can install multiple Button Label Printer Services on the same 
computer.

Where to install

In general, place the Button Label Printer Service on any computer that is close to 
the printer it supports. Doing so makes it easier to manage or troubleshoot any 
printing problems, and can reduce network traffic.
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Placing Enhanced Number Portability 
(ENP) Services

Enhanced Number Portability is an optional DNA feature designed to support 
customers who manage networks of DEFINITY ECS switches and AUDIX voice 
mail systems. DNA’s ENP wizard automates the process of moving stations from 
one switch to another and subscribers from one voice mail system to another.

When you configure DNA’s ENP feature, you tell DNA which switches are in the 
network, what their node numbers are, and whether you want DNA to update their 
routing tables when you move a station from one switch to another. For voice mail 
systems, you simply tell DNA which systems are in the network. 

The ENP Service keeps track of this information. If a particular switch or voice 
mail system has not been specified (in the ENP Service) as part of a network, 
then DNA’s ENP wizard will not be able to move stations (and subscribers) to or 
from that system.

How many to install

Although DNA does not pose any restrictions on the number of ENP Service 
components you can install, most customers will need to install only one.

Where to install

We recommend installing the ENP Service on the Core Services computer. Doing 
so makes it more convenient to upgrade DNA and its services, or perform any 
other configuration changes, because more services are located centrally on one 
computer.
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Understanding Connection Options

The easiest way to connect a DNA computer to any device is via a direct serial 
connection. Direct serial connections require less hardware, and less hardware 
reduces the chances of hardware failure. 

However, you can connect your computers to your telephony devices in several 
other ways, which are summarized below.  

* These connection methods are explained and illustrated in "Connecting the 
Hardware" on page 121.

NOTE:
Do not connect to a DEFINITY switch via the INADS port. Doing so prevents 
the switch from reporting alarms to Lucent and prevents Lucent personnel 
from remotely servicing the switch. Also, in some countries, connecting to 
the INADS port can be a violation of local laws.

You can connect DNA computers to telephony devices via direct serial, dial-up 
serial, and network connections. Figure 9 on page 50 illustrates one possible 
arrangement of these connections. Specific options are discussed in detail on 
page 121.

Device Direct Serial Dial-Up Serial TCP/IP

DEFINITY ECS RS-232 cable ADU*

data module*

modem pooling*

terminal server*

terminal server & 
ADU*

terminal server & 
data module*

Intuity AUDIX or 
Intuity HICAP

RS-232 cable with 
null modem*

ADU*

data module*

analog modem

network port*

DEFINITY AUDIX RS-232 cable with 
null modem*

ADU with null 
modem*

data module*

analog modem*

terminal server & 
RS-232 cable*
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Figure 9. Example Direct, Dial-Up, and TCP/IP Connections
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Sample Installation Scenarios

In this chapter, we illustrate how you might place NT servers and DNA 
components in several different situations. This chapter does not focus on how to 
connect your computers to your telephony devices because you can connect 
them in several different ways.

Work with your phone technician to determine the best connection methods for 
your site; refer to "Understanding Connection Options" on page 49 or "Connecting 
the Hardware" on page 121 for more information.

Scenario One:
Simple

One switch administrator needs to be able to administer one 
medium-sized DEFINITY and one AUDIX. 

Scenario Two:
Typical

Ten people need to be able to administer four DEFINITYs and 
four AUDIXs in two sites. “Site A” has three of the DEFINITYs 
and AUDIXs; “Site B” has one of each. All administration 
occurs from Site A, which has a LAN. Site A and Site B are 
linked only by a private telephone network.

Scenario 
Three:
Low Use

Three switch administrators need to be able to administer two 
DEFINITY switches in two remote sites, using dial-up PSTN 
connections. The switch administrators rarely need to make 
any changes to these switches.

Scenario Four:
Using terminal 
servers

Three switch administrators in two locations need to be able 
to administer three DEFINITYs, one Intuity AUDIX, and one 
DEFINITY AUDIX. “Site A” has two administrators, “Site B” 
has one administrator and a terminal server.
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Scenario One: Simplest Installation

One switch administrator needs to be able to administer one medium-sized 
DEFINITY ECS and one AUDIX. 

Figure 10 illustrates one possible arrangement of hardware and software to meet 
these needs. For precise hardware configuration options, refer to "Connecting the 
Hardware" on page 121.

Figure 10. Configuration for simple installation
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Scenario Two: Typical Installation

Ten people need to be able to administer four DEFINITY systems and four AUDIX 
systems in two sites. “Site A” has three of the DEFINITY systems and AUDIX 
systems; “Site B” has one of each. All administration occurs from Site A, which 
has a LAN. Site A and Site B are linked only by a private telephone network.

Figure 11 illustrates one possible arrangement of hardware and software to meet 
these needs. For precise hardware configuration options, "Connecting the 
Hardware" on page 121.

Figure Notes

Figure 11. Configuration for a typical installation
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Scenario Three: Infrequent Access

Three switch administrators must administer two DEFINITY switches in two 
remote sites, using dial-up PSTN connections. They rarely need to make changes 
to these switches.

Figure 12 on page 55 illustrates one possible arrangement. For precise options, 
refer to "Connecting the Hardware" on page 121.
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Figure 12. Configuration for a Low-Use Installation
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Scenario Four: Using Terminal Servers

Three switch administrators in two locations need to be able to administer three 
DEFINITY systems and one Intuity AUDIX. “Site A” has two administrators, “Site 
B” has one and a terminal server.

Figure 13 on page 57 illustrates one possible arrangement. For precise options, 
refer to "Connecting the Hardware" on page 121.
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Figure 13. Configuration using terminal servers

iodr014 EWS 051200

Site A

Site B

Client Client

Client

DNA computer with
Core Services, 

Connection Service, 
and Device Services 
for DEFINITY ECS 
and Intuity AUDIX

DNA computer containing 
one Connection Service 

and two Device Services for 
DEF ECS

DEFINITY ECS

Intuity AUDIX

Direct serial 
connection

Terminal Server

WAN

Data module

Data module

DEFINITY ECS

DEFINITY ECS



DEFINITY Network Administration Release 3
Planning, Installation, and Configuration  555-233-602CI  

Issue 2
December 2000

Sample Installation Scenarios 
58Scenario Four: Using Terminal Servers 

8



Designing the Installation 
59Making Design Decisions 

9

DEFINITY Network Administration Release 3
Planning, Installation, and Configuration  555-233-602CI  

Issue 2
December 2000

9
Designing the Installation

By now, you should have completed the “basic” questions on the Telephone and 
Data Network Information forms, and created a map of your network. You should 
also have read "Mapping Your Networks", "Placing NT Servers and 
DNA Components", "Understanding Connection Options", and "Sample 
Installation Scenarios".

Making Design Decisions

In the simplest scenario, the decision-making process is as follows: count the 
number of switches you want to support, divide by three, find that many NT 
servers, and place them on the network wherever they reduce network traffic and 
connection costs.

The formula above may be modified by your answers to the following questions:

1. Can you group your DEFINITY systems by version? 

If yes, you may be able to save hard disk space by putting the them on the 
same server.

2. Do you administer some DEFINITY systems heavily? 

If yes, you may want to put those DEFINITY systems on dedicated servers, 
or on servers with DEFINITY systems that are not administered much. 
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Recording Design Decisions

To record your design decisions, complete the following tasks:

1. Complete the design questions on the Telephone Network Information 
Form (Questions 7-21, 26-33, and 38-44)

2. Complete the design questions on the Data Network Information Form 
(Questions 20-23 and 25).

3. Complete the "Upgrades and Purchases" on page 61.

4. Complete the "DNA Systems" on page 63.

5. Revise your network map diagram to include any new PCs you plan to add.

6. If you have a Lucent support agreement for DNA, or if you want Lucent 
support during the DNA warranty period, you must also complete the TSC 
Cutover Assistance Request form, Form PA002 (page 109). 

NOTE:
The completed worksheets contain highly sensitive information about your 
telephone system. Keep them in a secure location at all times, and do not 
give them to persons without adequate security clearance and a direct need 
to know the information.

7. Give a copy of the network map and all forms to DNA installers. 

Installers need this design information to set up DNA, and you may want 
this information if you need to troubleshoot or modify your design.

Planning Permissions

After you make the above decisions, you must plan DNA permissions, as 
explained on page 65.
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1. Which of your switches, voice mail systems, and other telephony devices (if any) need to be upgraded? 

2. How many server PCs and client PCs do you currently have available for DNA? How many (if any) do you 
need to purchase? 

3. Which of your PCs (if any) need to be upgraded? 

Device Name Old Make/Model/Version Upgrade to

Server PCs Client PCs

Currently available

Need to purchase

PC Name Old Spec (what to upgrade) Upgrade to

Upgrades and Purchases
Complete this form once for each DNA installation.
Give a copy of the complete form to the person(s) performing the installation.
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What systems go on which PCs and how will they be connected? (Use whichever of the following lists you prefer).

By System Name

By PC Name

System Name PC Name Connection Method

PC Name System Name Connection Method

DNA Systems
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Permissions Overview

DNA enables you to set permissions that control the access of DNA users to 
specific DEFINITY commands, to specific folders in the DNA Navigator window, 
and to other DNA capabilities. This section explains DNA’s permissions and helps 
you specify them for each user.

Understanding Permissions Categories

DNA permissions fall into the following main categories:

Category Privileges

Device permissions These allow DNA users to run specified DEFINITY 
commands on a specific switch.

Folder permissions These allow DNA users to access specific folders in the 
DNA Navigator.

Services 
permissions

Services permissions are of three types:

Scheduling permissions allow DNA users to view or 
change other users’ scheduled tasks.

Call accounting permissions allow DNA users to generate 
and send data to Call Accounting packages.

History Log permissions allow DNA users to view the 
history of tasks that other DNA users have executed using 
DNA.
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Understanding User Groups

Setting up user groups can save you time when you assign permissions because 
you can define permissions once for the group rather than for each user 
individually. You may want to set up user groups by their permission levels, by 
company organization, by the devices they can administer, or by some other 
method. A single user can belong to many groups.

DNA comes with four predefined user groups, described below. Using these 
groups saves you the effort of creating a user group yourself. It may not save you 
time in assigning permissions, however, because the permissions for these 
groups are (for the most part) undefined. To assign permissions, see ‘‘Assigning 
Permissions’’ on page 214.

The table below describes the default permissions assigned to each predefined 
user group. 

In addition, you can create your own.

The next chapters explain how to plan device permissions, folder permissions, 
and services permissions.

Predefined 
Group Default Permissions

DNA 
Administrators

These are DNA “superusers.” By default, DNA gives this group 
all permissions, including folder, device, and services 
permissions. Assign to this group only the DNA users that you 
want to have full access to all DNA windows and devices.

Device 
Administrators

These are day-to-day administrators of switches and voice mail 
systems. By default, DNA gives this group all device 
permissions (that is, members can execute all commands on a 
DEFINITY switch). You can modify the default device 
permissions (see ‘‘Assigning Device Permissions’’ on page 
214). By default, DNA does not assign any folder permissions 
or services permissions to this group. If you want members to 
have specific folder or services permissions, you must assign 
them.

Device Browsers These are typically managers or others who do not need to 
make changes to a switch, but need to be able to see switch 
administration screens and run reports. By default, DNA does 
not assign any permissions to this group. You must assign 
them yourself. 

All 
Administrators

This group includes all DNA users. Do not add members to this 
group; DNA does it automatically for you.

DNA does not assign any permissions to this group. You must 
assign them yourself. However, any permission you assign to 
this group is granted to every DNA user, so exercise caution 
when granting this group a permission.
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Planning Device Permissions

DNA lets you specify which user groups can perform which commands on a given 
switch. You can do this in three ways:

■ assign users to DNA’s predefined user groups and accept the default 
permissions,

■ assign users to DNA’s predefined user groups and modify the default 
permissions to meet your needs, or 

■ create your own user groups and set the permissions from scratch.

The person who sets up device permissions on DNA will use a special window in 
the DNA Navigator (see Figure 14 on page 68). The window displays folders that 
correspond to the commands you can issue on a DEFINITY ECS system. You can 
view sub-commands (if there are any) by opening the given command folder. 

A fully expanded tree displays approximately 700 DEFINITY commands, which 
are listed in the Device Permissions Worksheet.
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Figure 14. Device Permissions window in DNA Navigator
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Understanding the permissions hierarchy

When you assign command permissions, the following principles apply:

1. You assign groups to commands, not the other way around.

The commands in the tree are fixed. The groups or individuals assigned to 
each entry may vary.

2. If you give a group (or individual) permission to command, you grant 
access to that command and all its sub-commands, with the exception 
explained in Principle 3.

3. If you give a group permissions to a sub-command, you override the 
permissions for that sub-command that were granted via Principle 2.

For example, if you give Person 1 permission to the “change” command, 
you thereby grant Person 1 permission to change every object. If you then 
give Person 2 permission to “change station,” you undo Person 1’s 
permission to “change station” until you expressly grant Person 1 that 
permission again by adding Person 1 into the “change station” folder.
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Example

Figure 15. DEFINITY Command Tree, Root Level

In Figure 15, the “Device Administrators” group, the “Device Browsers” group, and 
the individuals “mstukas” and “lula” have access to all DEFINITY commands 
because their names are at the root level of the tree. 



DEFINITY Network Administration Release 3
Planning, Installation, and Configuration  555-233-602CI  

Issue 2
December 2000

Planning Device Permissions 
71Understanding the permissions hierarchy 

11

If you wanted someone else (named Person1), who is not already assigned to the 
root level of the tree, to have permission to issue only the “Set” command, you 
might think that you could simply add Person1 to the “set” folder on the command 
tree. (See Figure 16.)

Figure 16. DEFINITY Command Tree, “Set” Command
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However, as explained in Principle 3, doing so would undo the permission that 
anyone on the root level of the tree has to the “Set” command. In this example, 
this would mean:

■ Person1 could issue “Set” commands on the switch.

■ Person1 could not issue any other commands on the switch.

■ Device Administrators, Device Browsers, mstukas, and lula could not issue 
any “Set” commands.

To enable them to issue “Set” commands, you must expressly put them in the 
“Set” command folder (along with Person1).

For this reason, when you fill out the Device Permissions Worksheet, if you 
indicate that you want someone to have permission to a sub-command, be sure to 
indicate, in the row dedicated to that sub-command on the form, who else you 
want to have access to that sub-command, too.

Using DNA’s Default User Group 
Permissions

DNA comes with default user groups (see page 66) already set up. If you want to 
use the default user groups and accept the permissions that are already set up 
(also defined on page 66), complete the following steps:

1. Photocopy the first page of the Device Permissions Worksheet once for 
each switch that DNA will support.

2. Write the name and location of the switch.

3. List who you want to go in each predefined user group. 

4. Give the completed form to the person who will be setting up permissions 
on DNA.
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Modifying Default User Group 
Permissions

If you want to use DNA’s default user groups, but you want to change the 
permissions associated with a default user group, complete the following steps:

NOTE:
You cannot change the permissions for the DNA Administrator group. You 
can change the permissions for DNA’s other default groups, but it may be 
preferable to create a new group entirely (see the next section) and assign 
the customized permissions to that (new) group.

1. Photocopy the Device Permissions Worksheet once for each switch that 
you will administer using DNA.

2. Write the name and location of the switch.

3. List who you want to go in each user group. 

4. In the DEFINITY command table, under columns for Device Administrator 
or Device Browsers simply mark off any changes you want to make. 

5. Give the completed form to the person who will set up permissions on 
DNA.
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Creating Custom User Groups and 
Permissions

You also can build your own user groups and set permissions to meet your needs. 
To do so, complete the following steps:

1. Photocopy the Device Permissions Worksheet once for each switch that 
you will administer using DNA.

2. Write the name and location of the switch.

3. On the user group form, pick an empty user group, write the name of the 
group at the top of the box, and then list the individuals you want in that 
group.

If you want to set up permissions for a single person, you can still use this 
form. Just set up a user group for that person.

4. On the DEFINITY commands table, in the column corresponding to the 
user group that you want to create, check off the DEFINITY commands you 
want that user group to be able to perform.

5. Repeat this process for each user group on each switch that DNA 
supports.

6. Give the completed forms to the person who will set up permissions on 
DNA.

NOTE:
If you give someone permission to execute a command that is at a lower 
level than a parent command (for example, “station” is at a lower level than 
“add”) that has already been assigned to other users, you will also have to 
explicitly assign everyone else (that you want to have permission to that 
command) permission to the command. You must understand this concept 
before planning or setting up permissions. For a more detailed explanation, 
see "Understanding the permissions hierarchy" on page 69. 
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User Group #1:
All Administrators

User Group #2: 
Device Administrators

User Group #3:
Device Browsers

User Group #4: User Group #5: User Group #6:

User Group #7: User Group #8: User Group #9:

Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
DEFINITY Network Administration Planning, Installation, and Configuration, 
555-233-602.



Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
DNA Planning, Installation, and Configuration, 555-233-602.
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User Group #10: User Group #11: User Group #12:

User Group #13: User Group #14: User Group #15:

User Group #16: User Group #17: User Group #18:
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User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
root X X

add
abbreviated-dialing

7103A-buttons
enhanced
group
system

access-endpoint
administered-connection
agent-loginID
atm pnc
atm trunk-board
attendant
bcms-vustats loginIDs
best-service-routing
bri-trunk-board
cabinet
conference
conference override
coverage

answer-group
path
time-of-day

data module
ds1
eda-external-device-alrm
fiber-link
group-page
hunt-group
intercom-group
intra-switch-cdr
ip-route
login
masi

terminal
trunk-group

mcu-extension
modem-pool
personal-CO-line
pgate
pickup-group
pri-endpoint
radio-controller
second-digit
signaling-group
station

Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
DNA Planning, Installation, and Configuration, 555-233-602.



Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
DNA Planning, Installation, and Configuration, 555-233-602.
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add (continued)
term-ext-group
test-schedule
trunk-group
vdn
vrt

backup disk
busyout

access-endpoint
board
cau
cdr-link

primary
secondary

data-module
disk
ds1-facility
fiber-link
host-adapter
journal-printer

pms-log
wakeup-log

link
mis
modem-pool
pms-link
pnc-standby
port
pri-endpoint
sp-link
station
tape
tdm
tone-clock
trunk
wfb

cancel hardware-group
change

aar
analysis
digit-conversion

abbreviated-dialing
7103A-buttons
enhanced
group
personal

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18



Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
DNA Planning, Installation, and Configuration, 555-233-602.
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change (continued)
abbreviated-dialing

system
access-endpoint
adjunct-names
administered-connection
agent-loginID
alias station
alphanumeric-dial-table
alternate-frl
announcements
ars

analysis
digit-conversion
toll

atm
pnc
pnc-pairs
trunk-board

attendant
authorization-code
bcms-vustats loginIDs
best-service-routing
bri-trunk-board
bulletin-board
cabinet
call-screening
cama-numbering
carrier-frequencies
circuit-packs
communication-interface

hop-channels
links
processor-channels

conference
console-parameters
cor
cos
coverage

answer-group
path
remote
time-of-day

data-module
daylight-savings-rules
dialplan

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18



Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
DNA Planning, Installation, and Configuration, 555-233-602.
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change (continued)
digit-absorption
display-messages

ad-programming
auto-wakeup-dn-dst
call-identifiers
date-time
leave-word-calling
malicious-call-trace
miscellaneous-features
property-management
self-administration
softkey-labels
time-of-day-routing
transfer
view-buttons
vustats

ds1
eda-external-device-alrm
enp-number-plan
extended-pickup-group
feature-access-codes
fiber-link
group-page
hunt-group
integ-annc-brd-loc
intercom-group
intra-switch-cdr
ip-interfaces
ip-parameters
ip-route
isdn

mwi-prefixes
network-facilities
private-numbering
public-unknown-numbering
tsc-gateway

ixc-codes
listed-directory-numbers
locations
login
masi

path-parameters
terminal
trunk-group

mct-group-extensions

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18



Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
DNA Planning, Installation, and Configuration, 555-233-602.
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change (continued)
mcu-extension
meas-selection

coverage
principal
route-pattern
trunk-group
wideband-trunk-group

modem-pool
mst
music-sources
node-names
node-routing
paging

code-calling-ids
loudspeaker
partition-route-table

password
permissions
personal-CO-line
pgate
pickup-group
pri-endpoint
radio-controller
reason-code-names
remote-access
report-scheduler
rhnpa
route-pattern
second-digit
signaling-group
sit-treatment
site-data
station
synchronization
system-parameters

atm
cdr
country-options
coverage-forwarding
crisis-alert
customer-options
duplication
features
hospitality
maintenance

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18



Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
DNA Planning, Installation, and Configuration, 555-233-602.
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change (continued)
system-parameters (continued)

mode-code
multifrequency-signaling
ocm-call-classification
security
special-applications
wireless

telecommuting access
tenant
term-ext-group
terminal parameters

603/302B1
6400
8400

test-schedule
time-of-day
toll
trunk-group
udp
vdn
vector
video-processors
vrt
vustats-display-format

clear
amw

all
asai
audix
msa
pms

audits
peak-hour
cumulative

errors
firmware-counters
hardware-group
isdn-testcall
link
measurements

ds1
ds1-facility
occupancy
security-violations

mst

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
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DNA Planning, Installation, and Configuration, 555-233-602.
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clear (continued)
pgate-port
pkt
port

configure tape
control conference
copy

announcements
bootimage
coredump
update-file

disable
administered-connection
all
login
MO
MO-all
mst
remote-access
syspend-alm-orig
synchronization-switch
test-number
wt-upgrade

display
aar

analysis
digit-conversion

abbreviated-dialing
7103A-buttons
enhanced
group
personal
system

access-endpoint
adjunct-names
administered-connection
agent-loginID
alarms
alias station
alphanumeric-dial-table
alternate-frl
announcements
ars

analysis
digit-conversion
toll

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18



Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
DNA Planning, Installation, and Configuration, 555-233-602.
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display (continued)
atm

pnc
pnc-pairs
ports
trunk-board

attendant
authorization-code
available-ports

2B
128K
192K
256K
320K
384K
512K
768K
1472K
1536K
1920K
b112/128K
b168/192K
b224/256K
b280/320K
b336/384K
b448/512K
b672/768K
t.120
ucc

bcms-vustats loginIDs
best-service-routing
bri-trunk-board
bulletin-board
button-location-aca
cabinet
call-screening
capacity
carrier-frequencies
circuit-packs
communication-interface

hop-channels
links
processor-channels

conference
console-parameters
cor

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18



Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
DNA Planning, Installation, and Configuration, 555-233-602.
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display (continued)
cos
coverage

answer-group
path
remote
sender-group
time-of-day

data-module
daylight-savings-rules
dialplan
digit-absorption
disabled-tests

ad-programming
auto-wakeup-dn-dst
call-identifiers
date-time
leave-word-calling
malicious-call-trace
miscellaneous-features
property-management
self-administration
softkey-labels
time-of-day-routing
transfer
view-buttons
vustats

ds1
eda-external-device-alrm
enp-number-plan
errors
events
extended-pickup-group
feature-access-codes
fiber-link
group-page
hunt-group
initcauses
integrated-annc-boards
intercom-group
internal-data

atd-pott
bconf-tab
bhist-tab
bept_rec
bri-port

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18



Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
DNA Planning, Installation, and Configuration, 555-233-602.
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display (continued)
internal-data (continued)

callr
conf-tab
ext-map
mhh-bd
hmm-pt
isg-callr
isg-cnfr
masi
mmi-tab
s-tab
sta-port
susr_rec
trk-port
uid-map
vc-tab

intra-switch-cdr
ip-interfaces
ip-parameters
ip-routine
isdn

mwi-prefixes
network-facilities
private-numbering
public-unknown-numbering
tsc-gateway

ixc-codes
listed-directory-numbers
locations
login
masi

path-parameters
terminal
trunk-group

mct-group-extensions
mcu-extension
meas-selection

coverage
principal
route-pattern
trunk-group
wideband-trunk-group

memory-configuration
modem-pool
mst

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18



Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
DNA Planning, Installation, and Configuration, 555-233-602.
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display (continued)
music-sources
node-names
node-routing
paging

code-calling-ids
loudspeaker

partition-route-table
permissions
personal-CO-line
pgate
pickup-group
port
pri-endpoint
radio-controller
reason-code-names
remote-access
rhnpa
route-pattern
second-digit
signaling-group
sit-treatment
site-data
software
station
svn-button-location
synchronization
system-parameters

atm
cdr
country-options
coverage-forwarding
crisis-alert
customer-options
duplication
features
hospitality
maintenance
mode-code
multifrequency-signaling
ocm-call-classification
offer-options
security
special-applications
wireless

telecommuting-access

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
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display (continued)
tenant
term-ext-group
terminal-parameters

603/302B1
6400
8400

test-schedule
time
time-of-day
toll
trunk-group
udp
vdn
vector
video-processors
vrt
vustats-display-format

download
firmware
translation
update-file

duplicate
access-endpoint
administered-connection
data-module
masi terminal
station

enable
administered-connection
all
login
MO
MO-all
mst
remote-access
save-translation
suspend-alm-orig
synchronization-switch
test-number
wt-update

erase announcements
format disk
get vector

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18



Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
DNA Planning, Installation, and Configuration, 555-233-602.

Issue 2   December 2000 89

list
aar

analysis
digit-conversion
route-chosen

abbreviated-dialing
group
personal

aca-parameters
access-endpoint
administered-connection
agent-loginID
announcements
ars

analysis
digit-conversion
route-chosen

asg-history
atm pnc
authorization-code
bcms

agent
skill
split
summary
trunk
vdn
vustats loginIDs

best-service-routing
bridged-extensions
cabinet
call-forwarding
conference
configuration

all
atm
board
carrier
control
ds1
firmware-versions
port-network
radio-controller
software-versions
stations
trunks

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
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list (continued)
configuration (continued)

wt-stations
cor
coverage

answer-group
path
time-of-day

data-module
disabled-MOs
do-not-disturb

group
station

eda-external-device-alrm
emergency
extended-pickup-group
extension-type
fiber-link
group-page
groups-of-extension
history
hunt-group
integrated-annc-boards
intercom-group
internal-data login
intra-switch-cdr
ip-route
isdn-testcall
logins
marked-ports
masi

terminal
trunk-group
tsc

mct-history
measurements

aca
atm board
atm latency-histogram
atm pnc-latency
atm setup-events
attendant
blockage
call-rate
call-summary
cbc-trunk-group

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
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list (continued)
measurements (continued)

cell-traffic
clan
communications-links
coverage-path
ds1
ds1-facility
expansion-services
hunt-group
ip-signaling groups
lar-route-pattern
lightly-used-trunk
load-balance
modem-pool
multimedia-interface
occupancy
outage-trunk
principal
route-pattern
security-violations
summary
tone-receiver
trunk-group
voice conditions
wideband-trunk-group

mcu-extension
members hunt-group
members trunk-group
mmi
modem-pool
monitored-station
mst
multimedia

endpoints
h.320-stations
ip-softphones

node-routing
partition-router-table
partitioned-group
performance

attendant
hunt-group
summary
trunk-group

personal-CO-line

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18



Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
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list (continued)
pgate
pickup-group
pms-down
pri-endpoint
report-scheduler
route-pattern
set-data
signaling-group
station
suspend-alm-orig
sys-link
term-ext-group
test-schedule
testcalls

detail
summary

toll
all
restricted-call
toll-list
unrestricted-call

trace
advocate
ewt
previous
vdn
vector

trunk-group
udp
unstaffed-agents
usage

button-type
extension
hunt-group
vector

vdn
vector
video-processors
vrt
vustats-display-format
wakeup

incomplete
requests
station

load translation

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
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mark port
monitor

bcms
skill
split
system
vdn

conference
health
security-violation

authorization-code
login
remote-access
station-security-codes

system
conn
scr
view1
view2

traffic
hunt-groups
trunk-groups

trunk
recycle carrier
refresh spe-standby
release

access-endpoint
board
cau
cdr-link

primary
secondary

data-module
disk
ds1-facility
fiber-link
host-adapter
journal-printer

pms-log
wakeup-log

link
mis
modem-pool
pms-link
pnc-standby
port

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18



Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
DNA Planning, Installation, and Configuration, 555-233-602.
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release (continued)
pri-endpoint
sp-link
station
tape
tdm
tone-clock
trunk
wfb

remove
abbreviated-dialing

7103A-buttons
enhanced
group
system

access-endpoint
administered-connection
agent-loginID
atm pnc
atm trunk-board
attendant
best-service-routing
bri-trunk-board
cabinet
conference
coverage

answer-group
path
time-of-day

data-module
ds1
eda-external-device-alrm
fiber-link
group-page
hunt-group
intercom-group
ip-route
login
masi

terminal
trunk-group

mcu-extension
modem-pool
personal-CO-line
pgate
pickup-group

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
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remove
pri-endpoint
radio-controller
report-scheduler
second-digit
signaling-group
station
term-ext-group
test-schedule
trunk-group
update-file
vdn
vrt

reset
board
disk
esm
fiber-link
host-adapter
maintenance
packet-interface
pnc
port
port-network
system
tape

restore
announcements
disk

resume hardware-group
save

announcements
translation

set
options
pnc
secret-key
signaling-group
switch-node-clock
synchronization
tdm
time
tone-clock
vector

status
access-endpoint

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18



Device Permissions Worksheet
For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
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status (continued)
administered-connection
all-conference
attendant
audits

cumulative
peak-hour

bri-port
cabinet
cdr-link
cleared-alarm-notif
conference
data-module
hardware-group
health
isdn-testcall
journal-link

pms-log
wakeup-link

link
logins
masi

terminal
trunk-group

mst
packet-interface
periodic-scheduled
pgate-port
pms-link
pri-endpoint
pnc
port-network
processor-channels
radio-controller
remote-access
signaling-group
spe
sp-link
station
switch-node
synchronization
sys-link
system

1st-cabinet
2nd-cabinet
3rd-cabinet

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
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status (continued)
system (continued)

all-cabinets
to-conference
trunk
tsc-administered
tti
wt-upgrade
ww-conference

test
access-endpoint
alarms
analog-testcall

trunk
port
board

board
cau
cdr-link

primary
secondary

customer-alarm
data-module
disk
ds1-facility
ds1-loop
eda-external-device-alrm
environment
fiber-link
hardware-group

board
cabinet
carrier
pnc
port-network
spe
system

host-adapter
inads-link
isdn-testcall
journal-printer

pms-log
wakeup-log

led
link
maintenance

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
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For completion instructions, see ‘‘Planning Device Permissions’’ on page 67 of 
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test (continued)
mass-storage
memory
MO

User Group Number (see page 71 of this form)
DEFINITY Command Folder 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18
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Planning Folder Permissions

To access the switches and voice mail systems using DNA, you must use the 
DNA Navigator window. The DNA Navigator window displays the switches and 
voice mail systems that you can administer using a tree-like directory structure. 
You can open the folders in the tree and click on objects in the folder to access 
different devices. 

You can control who can access which folders in the tree by setting folder 
permissions. To set folder permissions, you use a special window in the DNA 
Navigator. (See Figure 17 on page 100.)

Understanding folder permissions

Folders have two permissions settings: read, or read/write. Users that have read 
permission can view the contents of the folder and may be able to access the 
devices (depending on the device permissions they have), but they cannot add or 
delete objects in the folder. Users that have read/write permission can access, 
add, and delete objects in the folder.

By default, DNA gives all users read/write permission to all folders placed in this 
window. Unless you change the permissions yourself, all DNA users have full 
access to all folders, including the ability to delete folders. You can modify the 
default permissions and set your own up in any way necessary to meet your 
company’s needs.

In addition, by default, DNA always allows the DNA Administrators user group full 
permissions to everything in DNA. Even though the DNA Administrators group is 
not visible in the folder permissions window, this group always has full access to 
all folders.
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Figure 17. Folder Permissions Window in DNA Navigator
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Understanding folder permissions hierarchy

When assigning folder permissions, the following principles apply:

1. You assign user groups (or individuals) to folders, not the other way 
around.

The folders you add to the window serve as the basis upon which you build 
folder permissions. Once you assign folders to the window, you will assign 
user groups or individuals to the folders.

2. If you give a group or individual permission to a folder, you grant access to 
that folder and all folders beneath it, with the exception explained in 
Principle 3.

3. If you give a group or individual permission to a sub-folder, you override the 
permissions for that sub-folder that were granted via Principle 2.

For example, let’s say you have a folder named “Tokyo,” which contains 
three folders for the following switches: V6i, V6r, and V6csi. If you give 
Person 1 read/write permission to the “Tokyo” folder, you thereby grant 
Person 1 permission to access and change all folders within it. If you then 
give Person 2 read/write permission to “V6i,” you undo Person 1’s 
permission to “V6i” until you expressly grant Person 1 that permission 
again.

For this reason, when you complete the Folder Permissions Worksheet, if you 
indicate that you want someone to have access to a sub-folder, be sure to 
indicate, in the row dedicated to that sub-folder on the form, who else you want to 
have access to that sub-folder, too.
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Example

In the following example, we created folders that correspond to the geographical 
locations in a hypothetical DNA installation. (See Figure 18.) Within each location 
folder, we created folders for the different types of devices that DNA will support at 
the location. We can then place the icons for individual switches and voice mail 
systems within these folders.

We also created folders for the people who will use DNA in our hypothetical 
installation. We created a folder for Management; managers might want a folder 
that no one else can modify. We created a folder for each administrator; individual 
administrators also want folders that no one else can modify. Finally, we created a 
“shared” folder that all administrators could access, add objects to, and delete 
objects from.

Figure 18. Folders for a Hypothetical Installation
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Restricting default permission to 
read-only

If you do not want all DNA users to automatically have full read/write permissions 
to all folders, you can add the “All Administrators” user group to the root level of 
the tree and give this group read-only permission. Because the group is at the root 
level of the tree and no permissions have been specified for folders that are more 
indented on the tree, the read-only permission applies to all folders, which 
prevents DNA users from modifying any folders by default. However, you can still 
give specific groups or individuals read/write permissions, which we will do next.

Assigning write permissions

You can assign read/write permissions to specific folders simply by placing the 
user groups (and individuals) that you want to have this permission in the given 
folder, and specifying that their permission should be read/write. As you place 
permissions, remember:

■ Granting someone permission to a folder gives them permission to its 
sub-folders, unless you give someone else permission to the sub-folder.

For example, if you grant UserGroup1 read/write permission to the New 
York folder and you do not specify any other permissions for the 
sub-folders, then anyone in UserGroup1 can access, add, and delete 
objects in all of the New York sub-folders, including the Management folder, 
which you may want to keep secure. For this reason, in this hypothetical 
scenario, you would want to be careful when assigning read/write 
permissions to high levels on the tree. 

■ If you give someone permission to a sub-folder, you may be taking 
permissions away from a group or individual that has permissions at a 
higher level in the tree.

For example, if you give UserGroup1 read/write permission to the New 
York folder, and then you give PersonX read/write permission to the G3V5 
folder within it, UserGroup1 will no longer have read/write permission to the 
G3V5 folder until you expressly place them in that folder.
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Mixing permissions

You can give one person read/write permission to a folder and give another 
person read-only permission to the same folder. In this way, you can give 
managers (for example) permission to modify the Management folder, while 
allowing everyone else permission only to view the folder.

Creating shared folders

To create a “shared” folder, in which multiple people or groups can not only view 
the objects in the folder, but add or delete objects, simply add the user groups (or 
individuals) to the folder and give all of them read/write permissions to that folder. 
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User Groups (fill in the blanks)
Folder, Sub-Folder or 
Object ↓

Folder Permissions Worksheet

Photocopy as many times as necessary to list all your DNA folders.
See reverse for instructions.



Folder Permissions Worksheet
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1. If you have more folders, more users, or more user groups than you can list on this form, photocopy this form 
as many times as you need before proceeding.

2. Down the left column, list the folders you want to create, list any folders that go inside folders, and list which 
devices or button label printer services should go in each folder.

Some companies create folders for different geographical locations and then put devices (switches, voice mail 
systems, and so on) within them. Other companies create folders for different kinds of devices (G3r; AUDIX, 
and so on). In the same way, for button label printer services, you may want to put each one in the appropriate 
location folder, or create a special folder for all of your button label printer services.

3. Across the top, list the accounts (individuals or user groups) that will use DNA.

4. On folder rows only, in each cell, indicate whether you want the given individual or group to have read-only or 
read/write permissions to the folder.

You cannot assign permissions for an object from the DNA Navigator. Therefore, for the rows that correlate to 
a device or a button label printer service, do not indicate read or read/write permissions.

5. Give the completed worksheet to the person who will set up permissions on DNA.

NOTE:
If you give someone permission to a sub-folder when the parent folder already has 
permissions assigned to other users, you will also have to explicitly assign those “other 
users” (or whomever you want to have permission to that sub-folder) permission to the 
sub-folder. This is a tricky concept that you must understand before planning or setting up 
permissions. For a more detailed explanation, see ‘‘Planning Folder Permissions’’ on 
page 99.
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Service → Administration Scheduling History Log

User/User Group ↓

Access
Admin 
Windows

Access
Call Acctg 
Windows

Shut 
Down
DNA

View 
Scheduled 
Events

Change 
Scheduled 
Events

View 
Others’ 
Logs

Services Permissions Worksheet
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Services permissions include:

■ access to DNA Administration windows

This enables the user to add devices or button label printer services to the DNA Navigator, create 
user groups, create DNA user logins, change permissions, and so on.

■ access to Call Accounting windows

This enables the user to extract data from the switch and send it to a shared file that a third-party 
call accounting software package can use.

■ ability to shut down DNA

This enables the user to terminate the operation of DNA server software everywhere it is 
installed. Shutting down DNA prevents anyone from logging into a DNA client, halts all 
administration through DNA, and halts all pending administration tasks that have been scheduled 
using DNA.

■ ability to view all scheduled tasks

Without this permission, DNA users can view only the tasks that they scheduled. Granting this 
permission enables the user to view tasks that other users have scheduled.

■ ability to change all scheduled tasks

Without this permission, DNA users can change only the tasks that they scheduled. Granting this 
permission enables the user to change tasks that other users have scheduled.

■ ability to view other administrators’ history logs.

The history log contains a detailed list of the user’s actions and whether these actions succeeded 
or failed. Without this permission, an administrator cannot view other administrators’ history logs.

Do this

1. Down the left column, list your user accounts.

2. In each cell, indicate whether you want the given individual or group to have the permission 
shown on the right.

3. Give the completed worksheet to the person who will be setting up permissions on DNA.
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If you have a Lucent support agreement, or if you want Lucent support during the DNA warranty period, install 
pcAnywhere on all computers that host a DNA server component. Then, complete this form and send it to to 
System Management Provisioning. For technical assistance, call 1 (800) 242-2121.

1. DNA Release: ______________ 2.Version: ____________

3. DNA Components to be installed: 

4. Customer Contact Information: 

5. Project Contact Information: 

6. Enable DNA on your switch: Call the phone number listed for your area and request that Lucent turn on the 
DNA customer option (PEC number 13362). 

❑ Core Services ❑ Client

❑ Button Label Printer Service ❑ Device Service

❑ Enhanced Number Portability (ENP) option ❑ Connection Service

Company Name: ____________________________ IL: _________________________________

Address: ________________________________________________________________________

Title Name  Phone E-mail

Customer:

Customer:

Account Exec:

Project Manager:

Design Specialist:

Software Administrator

Software Specialist

CT, DC, DE, MA, ME, NH, NJ, NY, PA, RI, VA, VT, WV 1-800-632-0900

AL, AR, FL, GA, KS, KY, MO, MS, NC, SC, TN 1-800-922-1523

IA, IL, IN, MI, MN, ND, NE, OH, SD, WI 1-800-572-0036

LA, OK, TX 1-800-527-6889

AZ, Southern CA, NM, HI 1-800-829-8888

AK, Northern CA, CO, ID, MT, NV, OR, UT, WA, WY 1-800-642-4690

TSC Cutover Assistance Request Form
Form PA002
Fax to 1 (303) 488-3365 or 
e-mail to fsireno@lucent.com



TSC Cutover Assistance Request Form
Form PA002
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7. Network Map:

Attach a drawing of the configuration of the DNA portion of the network, referencing the specific customer and 
locations. Preferred file formats include Microsoft Word or Microsoft PowerPoint. The TSC does not currently 
support Visio, so any Visio drawings must be embedded in one of the previous types of files.

8. pcAnywhere Information: 

9. Server Information: 

Access Number:

Login:

Password:

Make/Model:

Operating System:

Processor:

RAM:

Virtual Memory:

HD Capacity:

LAN OS:

Server Name:

IP Domain Name:

FQDN:

IP Address:

Subnet Mask:

Gateway:

DNS Server:

WINS Primary:



TSC Cutover Assistance Request Form
Form PA002
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10. Client Information: 

11. Switch Information: 

Make/Model:

Operating System:

Processor:

RAM:

HD Capacity:

LAN OS:

Switch 1 Switch 2 Switch 3 Switch 4

Switch Name:

Version Number:

DNA Upload Login ID:

DNA Upload Password:

DNA Upload Secret Key:

DNA Admin Login ID:

DNA Admin Password:

DNA Admin Secret Key:

User Login:

User Password:

8400B Data Module:

HG Number:

HG Lead Ext:

System Port:

Server COM Port:

COM Port IRQ:



TSC Cutover Assistance Request Form
Form PA002
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12. Voice Mail Information: 

13. Other Device: 

14. Button Label Printer Information: 

AUDIX 1 AUDIX 2 AUDIX 3 AUDIX 4

AUDIX Name:

Version Number:

Passwords:

User Login:

User Password:

IP Address:

Device 1 Device 2 Device 3 Device 4

Device Name:

Version Number:

Passwords:

User Login:

User Password:

IP Address:

Printer 1 Printer 2 Printer 3 Printer 4

Device Name:

Device Type:

UNC:
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Preparing Switches for DNA

Before you can use DEFINITY Network Administration (DNA) to administer a 
DEFINITY ECS, the following activities must happen. A number of these activities 
require you to call Lucent. To avoid calling Lucent repeatedly, read all of the 
sections first, and then determine what activities you need Lucent to perform, 
before you call.

These activities are explained in the sections that follow.

1. You must be using a supported switch and software load.

2. Lucent must enable each of your switches to work with DNA. 

3. If you want to use Access Security Gateway (ASG), your switch must have 
ASG enabled.

4. On each switch that you plan to use with DNA, you must add a login that 
DNA can use to upload translations, and then have Lucent enable it.

5. On each switch that you plan to use with DNA, you must add a login that 
DNA can use for all other administration.

A DEFINITY ECS can support only 11 logins, and you need two for DNA. 
However, to keep DNA synchronized with your switch, no one should 
administer your switch using a tool other than DNA. For this reason, you 
should not use more than two logins per switch: the ones you set up for 
DNA.

Using a Supported Switch and 
Software Load

DNA works with the switch releases and software loads that are listed in 
‘‘Supported Devices’’ on page 16. If your switch is not listed, or is not running one 
of the listed loads, contact your Lucent representative to arrange an upgrade.

If you must upgrade a switch and you already have DNA installed, be sure to 
execute all scheduled DNA tasks and custom scripts for that switch, and then 
save translations, before upgrading.
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Enabling Your Switch to Work with 
DNA

Your switch will not work with DNA until Lucent turns on the DNA customer option 
on that switch. To determine whether your switch has the DNA customer option 
turned on, complete the following steps:

1. Log in to your switch

2. Type display system-parameters customer-options and press Enter.

If the DEFINITY Network Admin field has a value of y, then your switch 
will work with DNA. If it does not, ask Lucent to turn on the DNA customer 
option.

To turn on the DNA customer option, complete the following steps:

1. Call Lucent (see numbers below).

2. Give Lucent your Installation Location (IL) number.

3. Request that Lucent turn on the DEFINITY Network Administration 
customer option (request PEC number 13362).

If you are calling from outside the United States, contact your Lucent 
representative.

If you are calling from the United States... Dial...

CT, DC, DE, MA, ME, NH, NJ, NY, PA, RI, VA, VT, WV 1-800-632-0900

AL, AR, FL, GA, KS, KY, MO, MS, NC, SC, TN 1-800-922-1523

IA, IL, IN, MI, MN, ND, NE, OH, SD, WI 1-800-572-0036

LA, OK, TX 1-800-527-6889

AZ, S. CA, NM, HI 1-800-829-8888

AK, N. CA, CO, ID, MT, NV, OR, UT, WA, WY 1-800-642-4690
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Enabling ASG on Your Switch

ASG is an optional security feature that prevents unauthorized persons from 
accessing your switch. To determine if the ASG feature is enabled on your switch, 
complete the following steps:

1. Log in to your switch.

2. Type display system-parameters customer-options and press Enter. 

If the Access Security Gateway field has a value of y, then your 
switch has the ASG feature. 

If your switch does not have the ASG feature enabled, and you want it, you can 
order it by completing the following steps:

1. Call Lucent (page 114).

2. Give Lucent your Installation Location (IL) number.

3. Request that Lucent turn on the ASG customer option.

Creating the Upload Login

On each DEFINITY ECS that you will be administering using DNA, you must 
create a new login that DNA can use to upload switch translations to the server. 
For security purposes, “upload” and “logoff” are the only DEFINITY commands 
that this login can issue. To create the login, complete the following steps:

NOTE:
To perform this task, you must have permissions on the switch to add and 
change logins.

1. Log into the DEFINITY ECS.

2. At the command line, enter add login <name>

Where <name> is the word you want to use as the login. 

NOTE:
Do not reuse existing logins or login names that have been commonly used 
in the past. DNA must have a unique login so that when it resynchronizes its 
databases with the supported switch, it can distinguish between its own 
changes and those that were made using a tool other than DNA.

3. Enter your password.

4. Verify that the Login Type: field is set to customer. 

5. Verify that the Service Level: field is set to non-super-user. 

6. In the Login’s password:  field, enter the password that you want to 
associate with the login.
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7. In the Reenter Login’s password: field, enter the password again.

8. If you want this login to use ASG, then in the Access Security 
Gateway?  field, enter a y and complete the fields on page 2 of the form.

If you do not see this field, your switch does not have the ASG feature 
enabled. To enable it, see ‘‘Enabling ASG on Your Switch’’ on page 115.

9. Press Enter to submit the form.

Field Description

Blocked Enter y to temporarily disable the login ID from accessing 
the switch through ASG.

System Generated 
Secret Key?

To use ASG, either you or the switch must generate a 
Secret Key, which you must enter on the switch and in 
DNA when you are configuring it. Enter a y to have the 
switch generate the Secret Key.

Secret Key If you want to create your own Secret Key, enter it in this 
field. Be sure to note the Secret Key; you will need it to 
configure DNA and/or any response generation devices.

The Secret Key must conform to the following 
requirements:

■ It must be 20 digits long.

■ Each digit must be between 0 (zero) and 7, inclusive.

■ The last number must be 0 (zero).

■ The next-to-last number must be 0 (zero), 2, 4, or 6.

Expiration Date To disable this login after a certain date, enter the date in 
this field. If you enter a value in the Number of Sessions 
field, then the login will be disabled based on whichever 
criteria is satisfied first.

Number of 
Sessions

Enter the number of times this login ID can be used to 
access the switch (between 1 and 999). If you enter a 
value in the Expiration Date field, then the login will be 
disabled based on whichever criteria is satisfied first.

Restrict Days of 
Week

Enter y to restrict this login from accessing the switch on 
the specified day of the week.

Restrict From Time 
and Restrict To 
Time

Enter the time interval during which this login ID is blocked 
from accessing the switch.
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10. Call Lucent (page 114).

11. Give Lucent your Installation Location (IL) number.

12. Give Lucent the login name you just added, and request that they enable 
the System Management Data Transfer Only? field on the first 
page of the Change Permissions form for your switch.

NOTE:
Only Lucent can set the System Management Data Transfer Only? 
field to y. DNA will not work with your switch until this is enabled.

Creating the Administrative Login

The DNA administrative login is what DNA uses to make changes to your switch. 
DNA cannot make changes to your switch if you do not create this login. 

To perform this task, you must have permissions on the switch to add and change 
logins.

1. Access the DEFINITY System administration screens.

2. At the command line, enter add login <name>

Where <name> is the word you want to use as the login. 

NOTE:
Do not reuse existing logins or login names that have been commonly used 
in the past. DNA must have a unique login so that when it resynchronizes its 
databases with the supported switch, it can distinguish between its own 
changes and those that were made outside of DNA.

3. Enter your password.

4. Verify that the Login Type: field is set to customer. 

5. Verify that the Service Level: field is set to super-user. 

6. In the Login’s password:  field, enter the password that you want to 
associate with the administrative login.

7. In the Reenter Login’s password:  field, enter the password again.

8. If you want this login to use ASG, then in the Access Security 
Gateway?  field, enter a y and complete the fields on page 2 of the form.
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If you do not see this field, your switch does not have the ASG feature 
enabled. To enable it, see ‘‘Enabling ASG on Your Switch’’ on page 115.

9. Press Enter to submit the form.

10. At the command line, enter change permissions <name>.

Where <name> is the word you used as the login in Step 2. The system 
displays the Command Permission Categories form. 

Field Description

Blocked Enter y to temporarily disable the login ID from accessing 
the switch through ASG.

System 
Generated 
Secret Key?

To use ASG, either you or the switch must generate a 
Secret Key, which you must enter on the switch and in 
DNA when you are configuring it. Enter a y to have the 
switch generate the Secret Key.

Secret Key If you want to create your own Secret Key, enter it in this 
field. Be sure to note the Secret Key; you will need it to 
configure DNA and/or any response generation devices.

The Secret Key must conform to the following 
requirements:

■ It must be 20 digits long.

■ Each digit must be between 0 (zero) and 7, inclusive.

■ The last number must be 0 (zero).

■ The next-to-last number must be 0 (zero), 2, 4, or 6.

Expiration 
Date

To disable this login after a certain date, enter the date in 
this field. If you enter a value in the Number of Sessions 
field, then the login will be disabled based on whichever 
criteria is satisfied first.

Number of 
Sessions

Enter the number of times this login ID can be used to 
access the switch (between 1 and 999). If you enter a 
value in the Expiration Date field, then the login will be 
disabled based on whichever criteria is satisfied first.

Restrict Days 
of Week

Enter y to restrict this login from accessing the switch on 
the specified day of the week.

Restrict From 
Time and
Restrict To 
Time

Enter the time interval during which this login ID is blocked 
from accessing the switch.
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11. Set the fields to y to enable DNA to perform the listed activity.

Use the table below to decide which of the fields to set to y. If you think that 
even one of your DNA users will need to perform one of these tasks, set 
the field to y. If you set the field to n, no DNA users will be able to perform 
the listed task.

If you set a field to y, it does not mean that all of your DNA users will be 
able to perform the listed task. You can tell DNA exactly which users should 
be able to perform which tasks when you configure DNA. For now, 
however, enter a y in any field that any of your DNA users will need.

The fields listed in the following table are for a basic switch configuration. 
Your switch may display more than the following fields. For help setting 
those fields, refer to the DEFINITY Enterprise Communications Server 
Administrator’s Guide, 555-233-502.

12. Press Enter.

If this field is 
set to Y... Then...

Display Admin 
and Maint 
Data?

DNA can issue display, list, monitor, status, and 
schedule (reports) commands. 

System 
Measurements?

DNA can issue the list measurements command (vs/si 
systems only).

System Mgmt 
Data Transfer 
Only?

DNA can upload translations from the switch to a local 
hard drive on a DNA server. Only Lucent can set this 
field, and will set it to Y only for one login (your 
upload login).

Administer 
Stations?

DNA can issue add, change, duplicate, or remove 
commands for stations, data modules, and associated 
features, such as abbreviated dialing, vectors, and 
routing tables.

Administer 
Trunks?

DNA can issue commands to administer AAR/ARS, 
trunk groups, remote access, and route patterns.

Administer 
Features?

DNA can issue commands to administer feature-related 
system parameters, such as coverage paths, class of 
service, class of restriction, system parameters, 
authorization codes, and security.

Administer 
Permissions?

DNA can issue commands to administer logins and 
command permissions.

Restricted 
Objects?

You can list any objects that DNA cannot access, like 
stations, trunks, or hunt groups. Since you probably 
want DNA to be able to access any object on the switch, 
be sure this field is set to n.
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Enabling Your Switch to Work with ENP

DNA’s Enhanced Number Portability feature requires that your switch network use 
node number routing and 4 or 5-digit dialing.

Your network must also be configured in such a way that moving a station from 
one switch to another makes the exact same change in all of the affected routing 
tables. DNA’s ENP feature does not support network configurations in which 
different changes must be made to different routing tables.

This book does not endeavor to explain how to set up a network of switches. If 
you have questions or need help designing your switch network, refer to your 
DEFINITY ECS system documentation or contact your Lucent representative. 
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Connecting the Hardware

This chapter explains how to connect DEFINITY Network Administration (DNA) 
computers to DEFINITY, DEFINITY AUDIX, and Intuity AUDIX Systems, and how 
to test the connections.

For a quick summary of connection options and an illustration of one theoretical 
network setup, see ‘‘Understanding Connection Options’’ on page 49.

Reusing Existing Connections

If you are currently using another system administration program, the connections 
you need for DNA are most likely already installed and functioning. In that case, 
you may be able to skip this chapter. You may want to test the connections to 
each device to be sure they work, however. In that case, refer to the specific 
section in this chapter dealing with that type of connection.
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Protecting Telephone Network Circuits

Any equipment you use to make connections over the Public Switched Telephone 
Network (PSTN) must have circuit protection to protect central office equipment 
and your own. 

Your telephony service provider will perform the installation, and will know which 
type of circuit protection is preferred for your region and your particular interface 
to the central office. However, the following books explain, in general, what type of 
circuit protection you need under what circumstances.

DEFINITY ECS Version Refer to these DEFINITY books:

R5r, R6r, R7r, or R8r
Multi-Carrier Cabinet
and
R5si, R6si, R7si, or R8si
Multi-Carrier Cabinet

DEFINITY Enterprise Communications Server
Installation and Test for Multi-Carrier Cabinets
(Release 5, 6, 7, or 8 as appropriate)
“Install Sneak Fuse Panels” in Chapter 2
Document Number: 555-230-112.

R5si, R6si, R7si, or R8si
Single-Carrier Cabinet

DEFINITY Enterprise Communications Server
Installation and Test for Single-Carrier Cabinets
(Release 5, 6, 7, or 8 as appropriate)
“Install Sneak Fuse Panels” in Chapter 2
Document Number: 555-230-894.

R5vs or R6vs DEFINITY Enterprise Communications Server
Installation and Upgrades
(for Release 5 or 6, as appropriate)
“Install Sneak Fuse Panels” in Chapter 2
Document Number: 555-230-124.

R6csi, R7csi, or R8csi DEFINITY Enterprise Communications Server
Installation, Upgrades, and Additions for Compact 
Modular Cabinets
“Install Sneak Fuse Panels” in the section called
“Install Equipment Room Hardware” in Chapter 1
Document Number: 555-230-128.
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Connecting to DEFINITY Systems

When connecting DNA computers to DEFINITY Systems, follow the guidelines 
below:

■ Use a direct connection whenever possible.

For direct connections, use the TERMINAL port (SAT port). Using any 
other port interferes with the proper operation of DNA. 

■ Do not dial into a DEFINITY switch via the INADS port. 

Dialing into the INADS port prevents the switch from reporting alarms to 
Lucent, and prevents Lucent personnel from remotely servicing the switch. 
Also, in some countries, connecting to the INADS port can be a violation of 
local laws.

■ Connect to the PPN, not an EPN.

Connect DNA computers to the Processor Port Network (PPN), not the 
Expansion Port Network (EPN). Connecting via the EPN can compromise 
the security of your switch.

■ Connect to a circuit pack type that matches the line type.

When you wire a connection into the DEFINITY switch, the circuit pack 
type must match the type of phone line you are using. See ‘‘Determining 
DEFINITY Line Types’’ on page 124.

■ Wire to the Main Distribution Frame (MDF) according to Figure 36 on page 
226.

If you cannot connect DNA computers to DEFINITY Systems via a direct 
connection, use one of the following methods:

■ terminal server (page 125)

■ terminal server and ADU (page 126)

■ terminal server and data module (page 129)

■ ADUs (page 133)

■ data modules (page 136)

■ modem pooling (page 140)

NOTE:
In all of the diagrams on the following pages, EIA-232 cables can be used in 
place of RS-232 cables.
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Determining DEFINITY Line Types

If you are using dial-up connections to communicate with a DEFINITY ECS, the 
circuit pack that you connect to on the DEFINITY ECS must match the type of 
phone line you are using to reach it. For example, if you are using an 8400B+ data 
module, the line type is digital, so you must connect to a port on a 2-wire digital 
line circuit pack. The following table lists which circuit pack type to connect to for 
common connection devices.

NOTE:
For non-United States installations, use the international line-type 
equivalents with A-law companding.

For this Connection Device... Use this Circuit Pack...

ADU Data line circuit pack

8400B+ data module 2-wire digital line circuit pack

7400A or 7400B+ data module 4-wire digital line circuit pack

analog modem analog line circuit pack
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Connecting to DEFINITY via Terminal Server

Figure 19. Connecting to DEFINITY via Terminal Server 

1. Connect the equipment as shown in Figure 19.

NOTE:
When using a terminal server, be sure to use asynchronous serial ports only 
and ensure that all in-band flow control (for example, Xon/Xoff) is disabled 
and that you have a clear 8-bit connection (that is, no 7-bit telnet protocol).

Testing Hardware Connections

1. Using a terminal emulator, telnet to the DEFINITY System. 

A login prompt should appear. If no login prompt appears, check the wiring 
at the wall jack, the MDF, and the terminal server.
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Connecting to DEFINITY 
via Terminal Server and ADU

Figure 20. Connecting to DEFINITY via Terminal Server and Data Module
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1. Connect the equipment as shown in Figure 20 on page 126.

2. Configure the Terminal Server to issue a break signal followed by a 
carriage return on the serial interface, when a network session is 
established.

NOTE:
When using a terminal server, be sure to use asynchronous serial ports only 
and ensure that all in-band flow control (for example, Xon/Xoff) is disabled 
and that you have a clear 8-bit connection (that is, no telnet protocol).

Adding an ADU to the Switch

1. If system access ports and hunt groups have not been set up, set them up 
as explained on page 145.

2. Using a SAT, access the DEFINITY system administration screens and 
enter add data-module <number> or add data-module next.

3. In the Type: field, enter data-line.

4. In the Port: field, enter the location of the data line circuit pack connected to 
the ADU (for example 01B0801).

5. In the Special Dialing Option: field, enter hot-line.

6. In the Abbreviated Dialing Dial Code: field, enter the extension of the 
system access port hunt group from Step 1.

7. On page 2 of the Add Data-Module form, set the fields as shown in Table 1. 

Table 1. Add Data-Module Settings (ADU)

Field Name Setting
Kybd Dialing? y
Busyout? n
Configuration? n
Speeds? 9600 (y) (all 

others n)
Permit 
Mismatch?

n

Dial Echoing? y
Disconnect 
Sequence:

two-breaks

Answer Text? y
Parity: even
Connected 
Indication?

y
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Testing Hardware Connections

1. Using a terminal emulator, telnet to the terminal emulator and connect to 
the DEFINITY System. 

A login prompt should appear. If no login prompt appears, check the wiring 
at the wall jack, the MDF, and the terminal server.
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Connecting to DEFINITY via Terminal Server 
and Data Module

Figure 21. Connecting to DEFINITY via Terminal Server and Data Module
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1. Connect the equipment as shown in Figure 21 on page 129.

In place of a 7400B+ data module, you can use a 7400A data module. If 
you do, set the 7400A to AT Commands Mode. See below.

2. Wire the digital line circuit pack to the wall jack as follows:

■ For a 7400B+, wire to the second and third pair of the wall jack.

■ For an 8400B+, wire to the first pair of the wall jack.

3. Configure the Terminal Server to issue an ‘ATDT’ command followed by a 
carriage return to the serial interface, when a network session is 
established.

NOTE:
When using a terminal server, be sure to use asynchronous serial ports only 
and ensure that all in-band flow control (for example, Xon/Xoff) is disabled 
and that you have a clear 8-bit connection (that is, no telnet protocol).

Setting a 7400A Data Module to AT Commands 
Mode

You can use a 7400A in place of a 7400B+ if you set the 7400A to AT Commands 
mode. To do so, complete the following steps:

1. Press NEXT/NO until SET INTERFACE? displays.

2. Press ENTER/YES.

3. Press NEXT/NO until AT COMM? displays.

4. Press ENTER/YES. 

The unit automatically resets itself.

Adding a Data Module to the Switch

1. If system access ports and hunt groups have not been set up, set them up 
as explained on page 145.

2. Using a SAT, add the data module to the switch by entering add 
data-module <number> or add data-module next.

3. In the Type: field, enter pdm.

4. In the Port: field, enter the location of the digital line circuit pack connected 
to the data module (for example 01A1503).

5. In the Special Dialing Option: field, enter hot-line.

6. In the Abbreviated Dialing Dial Code: field, enter the extension of the 
system access port hunt group from Step 1.
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Testing Hardware Connections

In the table below, find your data module and follow the instructions for testing and 
troubleshooting it.

Setting the Data Module Operating Mode

1. Connect an RS-232 cable from the DNA computer to the data module.

If you are using an 8400B+, connect the DNA computer to the data module 
using the supplied adapter cable.

2. Using a terminal emulator, set the emulation to vt100 mode.

3. Type AT at the prompt and press Enter.

The data module should return an OK. If it does not, be sure that a 
standard RS-232 or EIA-232 cable is connected (not a null modem cable).

Type of 
Data 
Module How to Test and Troubleshoot

8400B+ The red LED should be steady on. If the red and green LEDs are 
blinking, the unit is not communicating with the DEFINITY 
System. Check the wiring at the MDF, wall jack, and the 
8400B+. 

7400B+ The Power and TR LEDs should be steady on. If the Power and 
Data LEDs are blinking, the unit is not communicating with the 
DEFINITY System. Check the wiring at the MDF, wall jack, and 
the 7400B+. 

7400A Set the 7400A to AT Commands mode. See ‘‘Setting the Data 
Module to DCE Mode’’ on page 137. The Power LED must be 
steady on. The DTR, DSR, DCD, RTS, and CTS settings must 
be highlighted in the display. If the Power LED is blinking, the 
data module is not communicating with the DEFINITY System. 
Check the wiring at the MDF, wall jack, and 7400A.
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4. Set the operating mode as described in the following table. 

5. Disconnect the terminal from the data module and reconnect the data 
module to the system cabling.

Setting the 7400B+ Options

1. Set the DIP switches for the 7400B+ using Table 4. 

The DIP switches are located inside the unit. Refer to the 7400B+ 
instruction book.

2. If any switches were set in Step 1, cycle the power to the data module so 
that the firmware can read the new switch settings. 

Testing Hardware Connections

1. Using a terminal emulator, telnet to the terminal serer and connect to the 
DEFINITY System. 

A login prompt should appear. If no login prompt appears, check the wiring 
at the wall jack, the MDF, and the terminal server.

Type of 
Data 
Module How to set the operating mode

8400B+ Type ATS24=1 and press Enter. Type AT&WØ  and press 
Enter to save the operating mode into non-volatile RAM.

7400B+ Type AT&F  and press Enter. Type AT&WØ  and press Enter 
to save the operating mode into non-volatile RAM.

7400A Type AT&F  and press Enter. Type AT&WØ  and press Enter 
to save the operating mode into non-volatile RAM.

Table 2. DIP Switch Settings (7400B+)

Option
DIP 
Switch Setting

No Telephone Connected 1 On

Data Metering 5 Off

Suppress Touch-tone/Dial Tone 6 Off

Speakerphone Disable/Enable 7 Off

Busyout on Local Loop 8 Off

Unused DIP Switches 2, 3, 
and 4

Off
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Connecting to DEFINITY 
via Asynchronous Data Unit

Figure 22. Connecting to DEFINITY via ADU

1. Connect the equipment as shown in Figure 22. 
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Adding an ADU to the Switch

1. Using a SAT, access the DEFINITY system administration screens and 
enter add data-module <number> or add data-module next.

2. In the Type: field, enter data-line.

3. In the Port: field, enter the location of the data line circuit pack connected 
to the ADU (for example 01B0801).

4. On page 2 of the Add Data-Module form, set the fields as shown in Table 3. 

5. If system access ports and hunt groups have not been set up, set them up 
as explained on page 145.

Testing Hardware Connections

1. Using a terminal emulator, connect to the serial port that the ADU is 
connected to, and set the emulation to vt100 mode.

2. Press the Break key on the keyboard.

A login prompt should appear. If it does not, the MDF wiring, the wall jack 
wiring, or an ADU is bad. Perform the loop-around test.

Table 3. Add Data-Module Settings (ADU)

Field Name Setting
Kybd Dialing? y
Busyout? n
Configuration? n
Speeds? 9600 (y) (all 

others n)
Permit 
Mismatch?

n

Dial Echoing? y
Disconnect 
Sequence:

two-breaks

Answer Text? y
Parity: even
Connected 
Indication?

y
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Performing a loop-around test

In the following tests, a Windows PC with terminal emulation may be substituted 
for the dumb terminal. 

1. Cut the modular plug off one end of a spare D8W modular cord.

2. Connect the blue lead to the black lead. 

3. Connect the orange lead to the yellow lead.

4. Disconnect the D8W modular cord (Figure Note 7) from the 400B2 adapter 
(Figure Note 8) at the DNA computer location. 

5. Plug the loop-around test cord (that you made in Steps 1-3) into the 400B2.

6. Disconnect the RS-232 cable from the DNA computer and connect it to an 
RS-232 connector on a dumb terminal.

7. Set the dumb terminal to full duplex mode and echo off.

8. Type a few characters on the keyboard. 

The characters should display exactly as you type them. If they do, the 
wiring is correct between Figure Notes 8 and 13 in Figure 22 on page 133. 
The problem lies between Figure Notes 10 and 1. Check port connections 
and cabling. If that does not resolve the problem, check the wiring at the 
MDF and wall jacks.

If the characters do not display exactly as you type them, the ADU is 
defective or the wiring is incorrect between Figure Notes 8 and 13 
(including 9 and 10). Check port connections and cabling.

9. When finished troubleshooting, remove the loop-around test cord and 
reconnect the system cabling. See Figure 22 on page 133.
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Connecting to DEFINITY via Data Module

Figure 23. Connecting to DEFINITY via Data Module
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NOTE:
With a 7400A or 7400B+ data module, use a 4-wire digital line circuit pack. 
With the 8400B+ data module, use a 2-wire digital line circuit pack.

1. Connect the equipment as shown in Figure 23 on page 136. 

In place of a 7400B+ data module, you can use a 7400A data module. If 
you do, set the 7400A to DCE Mode. See below.

2. Wire the digital line circuit pack to the wall jack as follows:

■ For a 7400B+, wire to the second and third pair of the wall jack.

■ For an 8400B+, wire to the first pair of the wall jack.

Setting the Data Module to DCE Mode

1. Cycle the power to the data module.

The unit performs a self test and displays its operating mode.

2. Observe the display.

a. If the display reads DCE mode, proceed to the next section.

b. If the display reads DTE mode, complete the following steps:

1. Remove the power cord from the unit.

2. Remove the cover from the top rear of the unit.

3. Remove the mode select circuit board and turn it around.

4. Replace the cover.

5. Connect the power cord.

The unit performs a self test.

NOTE:
The power LED must be steady on. If the power LED is blinking, the data 
module is not communicating with the DEFINITY ECS. Check the wiring at 
the MDF, wall jacks, and data module.

Adding a Data Module to the Switch

1. Using a SAT, add the data module to the switch by entering add 
data-module <number> or add data-module next.

2. In the Type: field, enter pdm.

3. In the Port: field, enter the location of the digital line circuit pack 
connected to the data module (for example 01A1503).

4. If system access ports and hunt groups have not been set up, set them up 
as explained on page 145.
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Testing Hardware Connections

In the table below, find your data module and follow the instructions for testing and 
troubleshooting it.

Setting the Data Module Operating Mode

1. Connect an RS-232 cable from the DNA computer to the data module.

If you are using an 8400B+, connect the DNA computer to the data module 
using the supplied adapter cable.

2. Using a terminal emulator, connect to the serial port that the data module is 
connected to, and set the emulation to vt100 mode.

3. Type AT at the prompt and press Enter.

The data module should return an OK. If it does not, be sure that a 
standard RS-232 or EIA-232 cable is connected (not a null modem cable).

4. Set the operating mode as described in the following table. 

5. Disconnect the terminal from the data module and reconnect the data 
module to the system cabling.

Type of 
Data 
Module How to Test and Troubleshoot

8400B+ The red LED should be steady on. If the red and green LEDs 
are blinking, the unit is not communicating with the DEFINITY 
System. Check the wiring at the MDF, wall jack, and the 
8400B+. 

7400B+ The Power and TR LEDs should be steady on. If the Power and 
Data LEDs are blinking, the unit is not communicating with the 
DEFINITY System. Check the wiring at the MDF, wall jack, and 
the 7400B+. 

7400A Set the 7400A to DCE mode. See ‘‘Setting the Data Module to 
DCE Mode’’ on page 137. The Power LED must be steady on. 
The DTR, DSR, DCD, RTS, and CTS settings must be 
highlighted in the display. If the Power LED is blinking, the data 
module is not communicating with the DEFINITY System. 
Check the wiring at the MDF, wall jack, and 7400A.

Type of 
Data 
Module How to set the operating mode

8400B+ Type AT&F and press Enter. Type ATS24=1 and press 
Enter. Type AT&WØ  and press Enter to save the operating 
mode into non-volatile RAM.

7400A
7400B+

Type AT&F  and press Enter. Type AT&WØ  and press Enter 
to save the operating mode into non-volatile RAM.
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Setting the 7400B+ Options

1. Set the DIP switches for the 7400B+ using Table 4. 

The DIP switches are located inside the unit. Refer to the 7400B+ 
instruction book.

2. If any switches were set in Step 1, cycle the power to the data module so 
that the firmware can read the new switch settings. 

Table 4. DIP Switch Settings (7400B+)

Option DIP Switch Setting

No Telephone Connected 1 On

Data Metering 5 Off

Suppress Touch-tone/Dial Tone 6 Off

Speakerphone Disable/Enable 7 Off

Busyout on Local Loop 8 Off

Unused DIP Switches 2, 3, and 4 Off
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Connecting to DEFINITY via Modem Pooling

Figure 24. Connecting to DEFINITY via Modem Pooling
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1. Connect the equipment as shown in Figure 24 on page 140.

2. Wire the data module to the second and third pair of the 103A or Lucent 
modular wall jack.

3. Wire tip and ring from both modems to the first pair of each 103A or Lucent 
modular wall jack.

Setting Up the Data Module at the Remote Site

Setting the Data Module to DCE Mode

1. Cycle the power to the data module.

The unit performs a self test and displays its operating mode.

2. Observe the display.

a. If the display reads DCE mode, proceed to the next section.

b. If the display reads DTE mode, complete the following steps:

1. Remove the power cord from the unit.

2. Remove the cover from the top rear of the unit.

3. Remove the mode select circuit board and turn it around.

4. Replace the cover.

5. Connect the power cord.

The unit performs a self test.

NOTE:
The power LED must be steady on. If the power LED is blinking, the data 
module is not communicating with the DEFINITY ECS. Check the wiring at 
the MDF, wall jacks, and data module.

Setting the Data Module Operating Mode

1. Connect an RS-232 cable from the DNA computer to the data module.

2. Using a terminal emulator, connect to the serial port that the data module is 
connected to, and set the emulation to vt100 mode.

3. Type AT at the prompt and press Enter.

The data module should return an OK. If it does not, the data module is not 
communicating with the terminal emulator. Be sure that a standard RS-232 
or EIA-232 cable is connected (not a null modem cable).

4. Set the operating mode as follows:

■ Type AT&F and press Enter.

■ Type AT&WØ  and press Enter to save the operating mode into 
non-volatile RAM.
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5. Disconnect the terminal from the data module and reconnect the data 
module to the system cabling.

Setting the Data Module to DTE Mode

1. Cycle the power to the data module.

The unit performs a self test and displays its operating mode.

2. Observe the display.

a. If the display reads DCE mode, complete the following steps:

1. Remove the power cord from the unit.

2. Remove the cover from the top rear of the unit.

3. Remove the mode select circuit board and turn it around.

4. Replace the cover.

5. Connect the power cord.

The unit performs a self test.

b. If the display reads DTE mode, proceed to the next section.

NOTE:
The power LED must be steady on. If the power LED is blinking, the data 
module is not communicating with the DEFINITY ECS. Check the wiring at 
the MDF, wall jacks, and data module.

Setting Up the Analog Modems

Setting the Local Modem Operating Mode

1. Using a terminal emulator, connect to the serial port that the modem is 
connected to, and set the emulation to vt100 mode.

2. At the computer, set the local modem to the factory default mode by typing 
AT&F and pressing Enter. 

3. Type AT&WØ  and press Enter to save the operating mode into non-volatile 
RAM.

4. If using a U.S. Robotics® Model 839 modem, also use Table 5 on page 143 
to set the options.

NOTE:
When calling from a remote modem, you may need to disable error 
correction to allow the modems to connect. For example, the AT&T 
Paradyne KeepInTouch® modem may require the AT\N0 command. The 
U.S. Robotics Model 839 does not recognize this command.
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5. Reconnect the modem to the system cabling.

Setting the Remote Modem Operating Mode

1. Connect a computer to the modem using an RS-232 cable.

2. Using a terminal emulator, connect to the serial port that the modem is 
connected to, and set the emulation to vt100 mode.

3. At the computer, set the remote modem to the factory default mode by 
typing AT&F and pressing Enter. 

4. Type ATSØ=3&WØ  and press Enter to set the modem to answer only mode 
and save the operating mode into non-volatile RAM.

5. If using a U.S. Robotics® Model 839 modem, also use Table 5 to set the 
options.

6. Reconnect the modem to the system cabling.

Administering the Remote DEFINITY ECS

Adding Modem Pooling

1. At the SAT, type add modem-pooling <number> or add modem-pooling 
next and press Enter.

2. In the Group Type: field, type combined. 

3. In the Speed: field, type 9600.

Table 5. U.S. Robotics Model 839 External Modem Switch Settings

Switch Setting Function

1 OFF (Up) DTR (Data Terminal Ready) override

2 OFF (Up) Provides verbal result codes (text-formatted feedback 
characters such as connected or no carrier)

3 ON (Down) Enables result codes

4 OFF (Up) Displays keyboard commands (local echo)

5 ON (Down) Auto answer (modem answers on preset number of 
rings). Set Auto Answer Ring Number on System 
Parameters Maintenance form.

6 OFF (Up) CD (Carrier Detect) override (modem sends CD signal 
on connect, drops CD on disconnect)

7 OFF (Up) Power-on and ATZ reset software defaults (loads Y or 
Y1 configuration from NVRAM)

8 ON (Down) AT (Attention) command set recognition (enables 
recognition, smart mode)
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4. In the Analog: field, type the carrier, port, and slot number of the analog 
line circuit pack that is connected to the remote analog modem (for 
example, 1A1001).

5. In the Digital: field, type the carrier, port, and slot number of the circuit 
pack that is connected to the data module (for example, 2B1001).

6. Press Enter when finished.

7. If system access ports and hunt groups have not been set up, set them up 
as explained on page 145.

Administering the Local DEFINITY ECS

Adding the Local Analog Modem to the Switch

1. At the SAT, type add station <number> or add station next and press 
Enter.

2. In the Type: field, type 2500.

3. In the Port: field, type the carrier, port, and slot number of the analog line 
circuit pack that is connected to the local analog modem (for example, 
1A1306).

4. Press Enter when finished.

Testing Hardware Connections

1. To verify the connection, place a remote administration call to the remote 
DEFINITY System using the hunt group extension.

If a login prompt appears, the wiring and administration are correct. If a 
login prompt does not appear, go to Step 2.

2. Check the wiring at the data module and analog modems.

Be sure the 7400A is set to DTE mode. If the Power LED is blinking, that 
data module is not communicating with the DEFINITY System. Check the 
wiring at the MDF and the wall jacks. 

3. Verify that all administration at the local and remote sites is correct.
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Setting Up System Access Ports

DNA computers cannot dial into a DEFINITY ECS switch until the system access 
ports on the DEFINITY are set up. 

NOTE:
Most switches’ system access ports are set up when the switch is installed; 
if this is true for your switch, or if you plan to connect via direct connection, 
you do not have to perform this task.

1. Associate an extension with a netcon channel or system port by entering 
add data-module <number> or add data-module next.

2. Administer the following fields: 

3. Add the netcon extension number or the system port extension number to 
a hunt group by entering add hunt-group <number> or add hunt-group 
next. 

■ In the Group Extension: field, enter the extension number to dial 
for access to the hunt group. Give this number to the person who 
will configure DNA.

■ On page 3 of the Hunt Group form, add the netcon extension 
number or the system port extension number as a member.

4. For Release 5r and later, jumper the data line circuit pack to the packet 
data line circuit pack, via the MDF. 

See Figure 36 on page 226. 

DEFINITY 
Release Fields to administer

R5vs/si 
R6vs/si/csi
R7si/csi
and
R8si/csi

In the Type: field, enter netcon.

In the Physical Channel: field, enter the physical 
channel number (01 to 04) for the netcon channel.

In the Maintenance Extension: field, enter an unused 
station number.

R5r and later In the Type: field, enter system-port.

In the Port: field, enter the location of the data line 
circuit pack (for example 01B0903)

In the PDATA Port: field, enter the location of the 
packet data line circuit pack (for example 01B0510).
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Connecting to Intuity AUDIX

This section explains how to connect DNA computers to Intuity AUDIX Systems 
via the following methods:

■ direct connection via null modem cable (preferred) (page 147)

■ network port (page 148)

■ ADUs (page 149)

■ data modules (page 151)

NOTE:
In all of the diagrams on the following pages, EIA-232 cables can be used in 
place of RS-232 cables.
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Connecting to Intuity AUDIX
via Null Modem Cable

Figure 25. Connecting to Intuity AUDIX via Null Modem Cable

1. Connect the equipment as shown in Figure 25.
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Connecting to Intuity AUDIX via Network Port

Figure 26. Connecting to Intuity AUDIX via Network Port

1. Connect the equipment as shown in Figure 26.

Testing Hardware Connections

1. Using a terminal emulator, telnet to the Intuity System. 

A login prompt should appear. If no login prompt appears, check the wiring 
at the wall jack and test network connectivity.
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Connecting to Intuity AUDIX 
via Asynchronous Data Units

Figure 27. Connecting to Intuity AUDIX via ADUs
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1. Connect the equipment as shown in Figure 27 on page 149. 

Testing Hardware Connections

1. Using a terminal emulator, set the emulation to vt100 mode.

2. Press the Esc key on the keyboard. 

A login prompt should appear. If it does not, the MDF wiring, the wall jack 
wiring, or an ADU is bad. 

3. Swap the positions of the ADUs and press the Esc key again. 

If the login prompt now appears, the ADU that is connected directly to the 
power supply is good and the other ADU is bad. If the login prompt does 
not appear, proceed as follows.

Performing a Loop-Around Test

NOTE:
In the following tests, a Windows 95 or Windows NT PC with terminal 
emulation may be substituted for the dumb terminal. 

1. Cut the modular plug off one end of a spare D8W modular cord.

2. Connect the blue lead to the black lead. 

3. Connect the orange lead to the yellow lead.

4. Disconnect the D8W modular cord (Figure Note 2) from the modular wall 
jack at the DNA computer location. 

5. Plug the loop-around test cord (that you made in Steps 1-3) into the wall 
jack at the DNA computer location.

6. Remove the modular-to-25-pin adapter cable (Figure Note 3) from the 
circuit and connect a dumb terminal to the RS-232 connector (Figure Note 
4).

7. Set the dumb terminal to full duplex mode and echo off.

* If you are connecting the D8W 
modular cord to...

Then the RS-232 null modem 
cable is...

COM1 or COM2 of Intuity AUDIX not required

Remote Maintenance Board (RMB) 
using a DCE plug as the 
modular-to-25-pin adapter

required

RMB using a DTE plug as the 
modular-to-25-pin adapter

not required
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8. Type a few characters on the keyboard. 

The characters should display exactly as you type them. If they do, the 
wiring is correct. If they do not, check the data module, cabling, and port 
connections. If that does not fix the problem, check the wiring at the 
modular wall jacks and MDFs. 

9. When finished troubleshooting, remove the loop-around test cord and 
reconnect the system cabling. See Figure 27 on page 149.

Connecting to Intuity AUDIX via Data Modules

Figure 28 on page 152 shows a dial-up connection using 2 data modules: a 
7400A data module on the Intuity AUDIX side and a 7400B+ or 8400B+ on the 
DNA side.
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Figure 28. Connecting to Intuity AUDIX via Data Modules
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NOTE:
With a 7400A or 7400B+ data module, use a 4-wire digital line circuit pack. 
With the 8400B+ data module, use a 2-wire digital line circuit pack.

1. Connect the equipment as shown in Figure 28 on page 152. 

2. Wire the digital line circuit pack to the wall jack as follows:

■ For a 7400A or 7400B+, wire to the second and third pair of the wall 
jack.

■ For an 8400B+, wire to the first pair of the wall jack.

Adding a Data Module to the Switch

1. Using a SAT, add the data module to the switch by entering add 
data-module <number> or add data-module next.

2. In the Type: field, enter pdm.

3. In the Port: field, enter the location of the digital line circuit pack 
connected to the data module (for example 01A1503).

Testing Hardware Connections

In the table below, find your data module and follow the instructions for testing and 
troubleshooting it.

Type of 
Data 
Module How to Test and Troubleshoot

8400B+ The red LED should be steady on. If the red and green LEDs are 
blinking, the unit is not communicating with the DEFINITY System. 
Check the wiring at the MDF, wall jack, and the 8400B+. 

7400B+ The Power and TR LEDs should be steady on. If the Power and 
Data LEDs are blinking, the unit is not communicating with the 
DEFINITY System. Check the wiring at the MDF, wall jack, and the 
7400B+. 

7400A Set the 7400A to Answer Only mode. See ‘‘Setting the 7400A 
Options’’ on page 155. The Power LED must be steady on. If the 
Power LED is blinking, the data module is not communicating with 
the DEFINITY System. Check the wiring at the MDF, wall jacks, and 
7400A.
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Setting the Data Module Operating Mode

1. Connect an RS-232 cable from the DNA computer to the data module.

2. Using a terminal emulator, connect to the serial port that the data module is 
connected to, and set the emulation to vt100 mode.

3. Type AT at the prompt and press Enter.

The data module must return an OK. If it does not, the data module is not 
communicating with the DEFINITY System. Be sure that a standard 
RS-232 cable is connected (not a null modem cable).

4. Set the operating mode as described in the following table. 

5. Reconnect the data modules to the system cabling.

Setting the 7400B+ Options

If you are using a 7400B+ data module, set the options by completing the 
following steps:

1. Set the option switches as described in Table 6. 

The DIP switches are located inside the unit. Refer to the 7400B+ 
instruction book.

2. If any switches were set in Step 1, cycle the power to the data module so 
that the firmware can read the new switch settings.

Type of 
Data 
Module How to set the operating mode

8400B+ Type AT&F and press Enter. Type ATS24=1 and press Enter. 
Type AT&WØ  and press Enter to save the operating mode 
into non-volatile RAM.

7400A
7400B+

Type AT&F  and press Enter. Type AT&WØ  and press Enter to 
save the operating mode into non-volatile RAM.

Table 6. DIP Switch Setting (7400B+)

Option DIP Switch Setting

No Telephone Connected 1 On

Data Metering 5 Off

Suppress Touch-tone/Dial Tone 6 Off

Speakerphone Disable/Enable 7 Off

Busyout on Local Loop 8 Off

Unused DIP Switches 2, 3, and 4 Off
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Setting the 7400A Options

If you are using a 7400A data module, set the options by completing the following 
steps:

1. Check that the 7400A data module is set to DCE mode by completing the 
following steps:

a. Unplug power from the 7400A.

b. Restore the power to the 7400A and observe the display. 

After the Self Test Passed message, the 7400A DCE Mode 
message should display. If the message 7400A DTE Mode displays, 
turn the EIA card around to the DCE mode. Refer to the 7400A 
instruction book. 

2. The 7400A is factory-set to the AT Commands mode. Change the 7400A to 
Answer Only mode by completing the following steps:

a. Press NEXT/NO until SET INTERFACE? displays.

b. Press ENTER/YES.

c. Press NEXT/NO until INT = ANS ONLY? displays.

d. Press ENTER/YES. The unit automatically resets itself.

e. Press NEXT/NO until SET OPTIONS? displays.

f. Press ENTER/YES.

3. Set the data module options using Table 7 on page 156. 
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4. When finished, press ENTER/YES when DONE? displays.

5. Press ENTER/YES when SAVE CHANGES? displays. 

Table 7. 7400A Data Module Options (Answer Only Mode)

Set Option Display Abbreviation Setting Default

Set 300 SPEED? 300 ON ON

Set 1200 SPEED? 1200 ON ON

Set 2400 SPEED? 2400 ON ON

Set 4800 SPEED? 4800 ON ON

Set 9600 SPEED? 9600 ON ON

Set 19200 SPEED? 19200 ON ON

Set ANSWER? ANS AUTO AUTO

Set BREAK DISC BRKDISC LONG LONG

Set CI LEAD? CI OFF OFF

Set CH LEAD? CH OFF OFF

Set CTS LEAD? CTS ON ON

Set DCD LEAD? DCD ON ON

Set DSR LEAD? DSR ON ON

Set DTR DETECT? DTR 50 MSEC 50

Set DTR LEAD? DTR FOLLOW1

1. Indicates settings that are not defaults.
2. This option not available on all units.

IGNORE

Set LL LEAD? LL OFF OFF

Set PARITY?2 PARITY SPACE1 NONE

Set REMOTE LOOP? REMLOOP GRANT GRANT

Set RI LEAD? RI ON ON

Set RL LEAD? RL OFF OFF

Set SIGLS DISC? SIGLS DISC ON ON

Set TM LEAD? TM OFF OFF
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Connecting to DEFINITY AUDIX

This section explains how to connect DNA computers to DEFINITY AUDIX 
Systems via the following methods:

■ RS-232 cable (page 158)

■ terminal server and RS-232 cable (page 159)

■ ADUs (page 160)

■ data modules (page 163)

■ analog modems (page 169)

NOTE:
In all of the diagrams on the following pages, EIA-232 cables can be used in 
place of RS-232 cables.



DEFINITY Network Administration Release 3
Planning, Installation, and Configuration  555-233-602CI  

Issue 2
December 2000

Connecting the Hardware 
158Connecting to DEFINITY AUDIX 

14

Connecting to DEFINITY AUDIX 
via RS-232 Cable

Figure 29. Connecting to DEFINITY AUDIX via RS-232 Cable

1. Connect the equipment as shown in Figure 29. 
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Connecting to DEFINITY AUDIX 
via Terminal Server and RS-232 Cable

Figure 30. Connecting to DEFINITY AUDIX via Terminal Server and RS-232 Cable

1. Connect the equipment as shown in Figure 30.

Testing Hardware Connections

1. Using a terminal emulator, telnet to the terminal server and connect to the 
AUDIX System. 

A login prompt should appear. If no login prompt appears, check the wiring 
at the terminal server.
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Connecting to DEFINITY AUDIX 
via Asynchronous Data Units

Figure 31. Connecting to DEFINITY AUDIX via ADUs

1. Connect the equipment as shown in Figure 31.
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Testing Hardware Connections

1. Using a terminal emulator, connect to the serial port that the ADU is 
connected to, and set the emulation to vt100 mode.

2. Press the Esc key on the keyboard. 

A login prompt should appear. If it does not, the MDF wiring, the wall jack 
wiring, or an ADU is bad. 

Performing a Loop-Around Test

NOTE:
In the following tests, a Windows 95 or Windows NT PC with terminal 
emulation may be substituted for the dumb terminal.

1. Cut the modular plug off one end of a spare D8W modular cord.

2. Connect the blue lead to the black lead. 

3. Connect the orange lead to the yellow lead.

4. Disconnect the D8W modular cord from the modular wall jack at the DNA 
computer location. 

5. Plug the loop-around test cord (that you made in Steps 1-3) into the wall 
jack at the computer location.

6. Disconnect the RS-232 cable from Port B on the MFB Y cable and connect 
it to an RS-232 connector on a dumb terminal.

7. Set the dumb terminal to full duplex mode and echo off.

8. Type a few characters on the keyboard. 

The characters must display exactly as you type them. If so, the system is 
wired properly. Reconnect the cabling as shown in Figure 31 on page 160. 
If the characters do not display as typed, the modular wall jacks or the MDF 
are not wired properly. The ADU may also be defective. 
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To Further Isolate the Problem:

1. Disconnect the D8W modular cord from the D8AM-87 crossover cord 
(Figure Note 10).

2. Disconnect the loop-around test cord from the wall jack at the computer 
location and connect it to the D8AM-87 crossover cord.

3. Type a few characters on the keyboard. 

The characters must display exactly as you type them. If not, the ADU or 
the crossover cord is bad. If the characters do display as typed, but did not 
in Step 8, above, then: 

■ The D8W modular cord may be defective. 

■ The modular wall jacks may be wired incorrectly. 
Ask your telephone cable installer to check them.

■ The MDF may be wired incorrectly. 
Ask your telephone cable installer to check it.

4. When the troubleshooting is finished, remove the loop-around test cord 
and reconnect the system cabling. See Figure 31 on page 160.
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Connecting to DEFINITY AUDIX 
via Data Modules

1. Connect the equipment as shown in Figure 32 or Figure 33 on page 164. 

Figure 32. Connecting to DEFINITY AUDIX via 7400A and 7400B+
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Figure 33. Connecting to DEFINITY AUDIX via 7400A and 8400B+ 

2. Wire the digital line circuit pack to the wall jack as follows:

■ For a 7400A or 7400B+, wire to the second and third pair of the wall 
jack.

■ For a 8400B+, wire to the first pair of the wall jack.
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Adding a Data Module to the Switch

1. Using a SAT, add the data module to the switch by entering add 
data-module <number> or add data-module next.

2. In the Type: field, enter pdm.

3. In the Port: field, enter the location of the digital line circuit pack 
connected to the data module (for example 01A1503).

Setting the Data Module Operating Mode

1. Connect an RS-232 cable from the DNA computer to the data module.

2. Using a terminal emulator, connect to the serial port that the data module is 
connected to, and set the emulation to vt100 mode.

3. Type AT at the prompt and press Enter.

The data module should return an OK. If it does not, the data module is not 
communicating. Be sure that a standard RS-232 or EIA-232 cable is 
connected, and an RS-232 null modem cable.

4. Set the operating mode as described in the following table. 

5. Disconnect the terminal from the data module and reconnect the data 
module to the system cabling.

Setting the 7400B+ Options

If you are using a 7400B+ data module, set the options by completing the 
following steps:

1. Set the option switches for the 7400B+ using Table 8 on page 166. 

The DIP switches are located inside the unit. Refer to the 7400B+ 
instruction book.

2. If any switches were set in Step 1, cycle the power to the data module so 
that the firmware can read the new switch settings. 

Type of 
Data 
Module How to set the operating mode

8400B+ Type ATS24=1 and press Enter. Type AT&WØ  and press Enter 
to save the operating mode into non-volatile RAM.

7400B+ Type AT&F  and press Enter. Type AT&WØ  and press Enter to 
save the operating mode into non-volatile RAM.

7400A Set the 7400A to Answer Only mode. See ‘‘Setting the 7400A 
Options’’ on page 166. Type AT&F and press Enter. Type 
AT&WØ  and press Enter to save the operating mode into 
non-volatile RAM.
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Setting the 7400A Options

If you are using a 7400A data module, set the options by completing the following 
steps:

1. Check that the 7400A data module is set to DCE mode by completing the 
following steps:

a. Unplug power from the 7400A.

b. Plug in the power back and observe the display. 

After the Self Test Passed message, the 7400A DCE Mode 
message should display. If the message 7400A DTE Mode displays, 
turn the EIA card around to the DCE mode. Refer to the 7400A 
instruction book. 

2. The 7400A is factory-set to the AT Commands mode. Change the 7400A to 
Answer Only mode:

a. Press NEXT/NO until SET INTERFACE? displays.

b. Press ENTER/YES.

c. Press NEXT/NO until INT = ANS ONLY? displays.

d. Press ENTER/YES. 

The unit automatically resets itself.

e. Press NEXT/NO until SET OPTIONS? displays.

f. Press ENTER/YES.

3. Set the data module options using Table 9 on page 167.

Table 8. DIP Switch Setting (7400B+)

Option
DIP 
Switch Setting

No Telephone Connected 1 On

Data Metering 5 Off

Suppress Touch-tone/Dial Tone 6 Off

Speakerphone Disable/Enable 7 Off

Busyout on Local Loop 8 Off

Unused DIP Switches 2, 3, and 4 Off
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4. When finished, press ENTER/YES when DONE? displays.

5. Press ENTER/YES when SAVE CHANGES? displays.

Table 9. 7400A Data Module Options (Answer Only Mode)

Set Option Display Abbreviation Setting Default

Set 300 SPEED? 300 ON ON

Set 1200 SPEED? 1200 ON ON

Set 2400 SPEED? 2400 ON ON

Set 4800 SPEED? 4800 ON ON

Set 9600 SPEED? 9600 ON ON

Set 19200 SPEED? 19200 ON ON

Set ANSWER? ANS AUTO AUTO

Set BREAK DISC BRKDISC LONG LONG

Set CI LEAD? CI OFF OFF

Set CH LEAD? CH OFF OFF

Set CTS LEAD? CTS ON ON

Set DCD LEAD? DCD ON ON

Set DSR LEAD? DSR ON ON

Set DTR DETECT? DTR 50 MSEC 50

Set DTR LEAD? DTR FOLLOW1

1. Indicates settings that are not defaults.
2. This option not available on all units.

IGNORE

Set LL LEAD? LL OFF OFF

Set PARITY?2 PARITY SPACE1 NONE

Set REMOTE LOOP? REMLOOP GRANT GRANT

Set RI LEAD? RI ON ON

Set RL LEAD? RL OFF OFF

Set SIGLS DISC? SIGLS DISC ON ON

Set TM LEAD? TM OFF OFF
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Testing Hardware Connections

To test the connections, complete the following steps:

1. Connect an RS-232 cable between the computer and the data module. 

2. Using a terminal emulator, connect to the serial port that the data module is 
connected to, and set the emulation to vt100 mode.

3. Type AT at the prompt and press Enter.

The data module should return an OK. If it does not, the data module is not 
communicating. Be sure that a standard RS-232 or EIA-232 cable is 
connected, and an RS-232 null modem cable.

4. Reconnect the data module to the system cabling.

The power LED should be steady on. The DTR, DSR, DCD, RTS, and CTS 
settings should be highlighted in the display. If the power LED blinks, the 
data module is not communicating.

5. Dial a telephone number for the data module attached to the AUDIX.

A login prompt should appear.
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Connecting to DEFINITY AUDIX via Modems

Figure 34. Connecting to DEFINITY AUDIX via analog modems

1. Connect the equipment as shown in Figure 34. 

2. Wire the analog line circuit pack to the wall jack using the first pair.

Adding an Analog Modem to the Switch

1. At the SAT, type add station <number> or add station next and press 
Enter.

2. In the Type: field, type 2500.
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3. In the Port: field, type the carrier, port, and slot number of the analog line 
circuit pack that is connected to the analog modem (for example, 1A1306).

4. Press Enter when finished.

Setting Up the Analog Modems

Setting the Local Modem Operating Mode

1. Using a terminal emulator, connect to the serial port that the modem is 
connected to, and set the emulation to vt100 mode.

2. At the computer, set the local modem to the factory default mode by typing 
AT&F and pressing Enter. 

3. Type AT&WØ  and press Enter to save the operating mode into non-volatile 
RAM.

4. If using a U.S. Robotics® Model 839 modem, also use Table 10 to set the 
options.

NOTE:
When calling from a remote modem, you may need to disable error 
correction to allow the modems to connect. For example, the AT&T 
Paradyne KeepInTouch® modem may require the AT\N0 command. The 
U.S. Robotics Model 839 does not recognize this command.

5. Reconnect the modem to the system cabling.

Table 10. U.S. Robotics Model 839 External Modem Switch Settings

Switch Setting Function

1 OFF (Up) DTR (Data Terminal Ready) override

2 OFF (Up) Provides verbal result codes (text-formatted feedback 
characters such as connected or no carrier)

3 ON (Down) Enables result codes

4 OFF (Up) Displays keyboard commands (local echo)

5 ON (Down) Auto answer (modem answers on preset number of 
rings). Set Auto Answer Ring Number on System 
Parameters Maintenance form.

6 OFF (Up) CD (Carrier Detect) override (modem sends CD signal 
on connect, drops CD on disconnect)

7 OFF (Up) Power-on and ATZ reset software defaults (loads Y or 
Y1 configuration from NVRAM)

8 ON (Down) AT (Attention) command set recognition (enables 
recognition, smart mode)
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Setting the Remote Modem Operating Mode

1. Connect a computer to the modem using an RS-232 cable.

2. Using a terminal emulator, connect to the serial port that the modem is 
connected to, and set the emulation to vt100 mode.

3. At the computer, set the remote modem to the factory default mode by 
typing AT&F and pressing Enter. 

4. Type ATSØ=3&WØ  and press Enter to set the modem to answer only mode 
and save the operating mode into non-volatile RAM.

5. If using a U.S. Robotics® Model 839 modem, also use Table 10 on page 
170 to set the options.

6. Reconnect the modem to the system cabling.
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Installing or Upgrading DNA

Your installation planner already should have specified where to put new NT 
servers and where to install each component of the DEFINITY Network 
Administration (DNA) software. If you do not have this information, do not proceed 
with the installation. Contact your installation planner or plan the installation 
yourself, referring to Chapters 1 through 10 of this book. 

Installation Prerequisites

Before you install DNA, be sure that the computers you plan to install it on meet 
the hardware requirements listed in ‘‘Understanding System Requirements’’ on 
page 13 and that you have patched your operating systems so they are Year 2000 
compliant. As of this writing, information about Windows patches is available from 
http://www.microsoft.com/technet

DNA requires a functioning LAN or loop-back host to operate. The instructions in 
this section assume that your LAN is fully operational and that all DNA computers 
can PING each other. In addition, to install DNA, you must have an NT login with 
NT Administrator privileges.

If you want to use DNA’s online help, you must have Microsoft Internet Explorer 4 
installed on the given computer, at least in a browser-only configuration. However, 
on the computer that will host the Core Services, be sure that IE4 desktop 
extensions are not installed. If they are, you may experience problems with OLE 
and DDE applications installed on this computer.

If you want to use DNA’s Event Notification feature, which sends DNA users 
e-mail when DNA encounters errors or other situations, you must install and 
configure a MAPI e-mail client (like Microsoft Exchange or Outlook) on the 
computer you will be installing DNA’s Core Services on. 

If your company has a Lucent support agreement, you need to install a modem 
and a copy of Symantec’s pcAnywhere on all computers that will host DNA server 
components. pcAnywhere enables Lucent personnel to troubleshoot and fix 
problems on your system. For the required version number of pcAnywhere, see 
‘‘Understanding System Requirements’’ on page 13.
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Understanding pcAnywhere Security

Before you install a copy of Symantec’s pcAnywhere on any of your computers, 
read this section. 

You are responsible for the security of your data network and for preventing 
unauthorized individuals from accessing it. Therefore, exercise caution when 
using pcAnywhere. Having it installed does not pose a security risk; it must be up 
and running, and be configured to receive calls, before a remote user can enter 
the system. In addition, pcAnywhere offers a number of security features. 

Follow these guidelines to protect PCs with pcAnywhere installed:

1. Unplug the modem from the phone jack when pcAnywhere is not in use.

2. Only run pcAnywhere when necessary.

3. Do NOT publish the phone number for the modem that people use to 
access the computer.

4. Change your password after Lucent personnel leave your site and after 
Lucent personnel terminate a remote service session.

5. Configure the following pcAnywhere security options:

■ Require login names for callers.

■ Make passwords case sensitive.

■ Log all failed connection attempts.

■ Set a maximum number of login attempts per call.

■ Allow time to enter the complete login.

■ Disconnect if inactive.

6. Configure pcAnywhere to log remote call and online sessions.

For more information on pcAnywhere, including acquisition and security, visit the 
following web site:

http://www.symantec.com/pcanywhere/index.html
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Installing DNA Components on the 
Correct OS

Not all DNA components can be installed on all Windows operating systems. The 
following table indicates where you can install DNA components.

Installing Standard DNA Components

Standard DNA components are: client, Core Services, Device Services, Button 
Label Printer Services, and Connection Services. This section describes how to 
install these components. To install the optional Enhanced Number Portability 
(ENP) feature, see page 181.

Installation is simplest if you first install DNA on the computer that will host the 
Core Services, because when you install DNA on other computers, the installation 
program asks where the Core Services component has been (or will be) installed. 
For this reason, these instructions explain how to install DNA, starting first with the 
computer that will host the Core Services. This approach simplifies the installation 
instructions; you are not required to install in this order. You can install DNA on 
other computers first, but if you do, you will need to know where you will be 
installing the Core Services component.

To install DNA, you must use an NT login that has NT Administrator privileges. 
Then complete the following steps:

1. Determine which DNA component(s) to install on this computer.

Your installation planner should have specified this for you.

2. If DNA is running on this computer, shut down DNA. 
(page 183)

3. Insert the DNA CD into the CD drive.

If you have purchased the optional Enhanced Number Portability (ENP) 
feature, you will have two CDs. Insert the DNA CD first. DNA displays a CD 
browser window.

Component Win95 Win98 WinNT4

Client X X X

Connection Service X X X

Core Services X

Device Service X

Button Label Printer 
Service

X

Enhanced Number 
Portability

X
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4. Click Install DNA.

The installation program extracts the necessary files.

5. At the Welcome window, click Next.

6. To view the release notes, click Yes.

After viewing the release notes, click X to close the window.

7. If this is the first time you have installed a DNA component on this 
computer, enter your name and company’s name or accept the defaults 
and click Next.

8. If this is the first time you have installed a DNA component on this 
computer, specify the folder where you want to install the DNA components 
and click Next.

We recommend that you accept the default destination folder, but you may 
want to alter the default drive. To do so, click Browse, reset the drive letter, 
and click OK. Click Yes to confirm that you want the new folder created if it 
does not already exist.

9. If this is the first time you have installed a DNA component on this 
computer, and if your company has DNS configured on your computer 
network, then enter the name of the DNS Domain that this computer 
belongs to.

The installation planner should have recorded this on the Data Network 
Information Form for this computer, Step 12 on page 25. If you do not have 
DNS configured, leave this field blank. If you do not have DNS configured, 
leave this field blank.

10. If this is the first time you have installed a DNA component on this 
computer, enter a fully-qualified domain name (FQDN) or IP address for 
the computer that will host the Core Services component, as described 
below, and then click Next.

The installation planner should have recorded this on the Data Network 
Information Form for the computer that hosts the Core Services, Step 13 
on page 25. If not, you can determine it by following the instructions for that 
step on the reverse side of the form, on the computer that hosts the Core 
Services.

(If you are not installing the Core Services first, then in this step you must 
specify the FQDN or IP Address of the computer where the Core Services 
will reside. See ‘‘Installing Core Services’’ on page 178 to learn why.)

NOTE:
Be sure you are not using DHCP for the Core Services PC, because if 
DHCP reassigns the IP address of the Core Services PC, DNA will not 
function and may require a reinstallation.
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What you enter (in Step 10 on page 176) depends on whether you have 
DNS configured on your network:

11. The installation program asks which of the following DNA components you 
want to install:

■ Core Services 

■ Connection Service

■ DNA Client

■ Button Label Printer

■ One or more devices

12. Select the DNA components you want to install on this computer, and 
proceed as described in the following sections.

NOTE:
Not all DNA components can be installed on all operating systems. See 
‘‘Installing DNA Components on the Correct OS’’ on page 175.

Condition What to enter, in order of preference

If you have 
DNS 
configured on 
your network...

■ Enter the FQDN of the Core Services computer.

■ Enter the IP address of the Core Services 
computer.

If you do not 
have DNS 
configured on 
your network...

■ Enter the short name of the Core Services 
computer (if you have WINS or “Hosts” files), or

■ Enter the IP address of the Core Services 
computer.
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Installing Core Services

The Core Services component is the main processing software within DNA. No 
matter how many computers are a part of your DNA installation, you will install the 
Core Services only once. This is not the case with other DNA components, which 
can have multiple copies installed on various computers throughout your network. 

Because the Core Services component is the main processing software within 
DNA, all other DNA components refer to it and interact with it in order to function. 
For this reason, when you install DNA components on other computers, you will 
indicate the location of the Core Services as part of the installation process. This 
means you cannot move the Core Services component without re-installing all 
other components. 

1. If you have not already done so, complete the steps in ‘‘Installing Standard 
DNA Components’’ on page 175.

2. Select the Core Services check box.

When you do, the installation program automatically selects Connection 
Service and Client, because in most situations, you will want these 
components on the Core Services computer. However, you can deselect 
these components if you do not want them on this computer.

3. Select any other appropriate check boxes, and click Next.

4. If you selected “Button Label Printer Services,” see page 178.

5. If you selected “One or more devices,” see page 179. 

6. To complete the installation, see ‘‘Final Installation Steps’’ on page 180. 

Installing Button Label Printer Services

You must install one Button Label Printer Service for each network laser printer 
you want DNA to use. DNA does not restrict the number of Button Label Printer 
Services you can install on a single computer.

1. If you have not already done so, complete the steps in ‘‘Installing Standard 
DNA Components’’ on page 175.

2. Select the Button Label Printer Service check box (and any other 
appropriate check boxes), and click Next.

NOTE:
Button Label Printer Service names are case sensitive and cannot be 
changed later, so choose carefully. In addition, you cannot use spaces or 
special characters, such as / \ * ? & % @ ! ^. Record what you type here. 
You will need this information when you register the services.
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3. When prompted, enter the name you want to give each Button Label 
Printer Service, and click Add. When you are finished, click Next.

Add a Button Label Printer Service for each printer that you want to be able 
to print button labels. To delete one, select it from the list and click Remove. 
Then click Next.

4. If you selected to install devices, see “Installing Device Services,” below.

Installing Device Services

Install one Device Service component for each and every device that the given 
computer will support. To do so, complete the following steps:

1. If you have not already done so, complete the steps in ‘‘Installing Standard 
DNA Components’’ on page 175.

2. Select the check box called “One or more devices,” (and any other 
appropriate check boxes), and click Next.

If you selected “Button Label Printer Services,” then the “Input Button Label 
Printer Names” screen appears. After you complete it and click Next, the 
device type screen appears.

3. When prompted, select the types of devices you want this computer to 
support, and then click Next.

For each type of device you select, the installation program will install a 
Device Service component of that type on this computer.

NOTE:
Device Service names are case sensitive and cannot be changed later, so 
choose carefully. In addition, you cannot use spaces or special characters, 
such as / \ * ? & % @ ! ^. Record what you type here. You will need it when 
you register these services.

4. For each type of device, enter the name(s) of each device that this 
computer will support, click Add to add it to the list, and then click Next.

When you click Next, the installation program displays a screen for the next 
type of device that you selected in Step 2. Repeat Step 4 until you specify 
all devices this computer will support.

5. When you finish naming the devices that this computer supports, see “Final 
Installation Steps,” below. 
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Final Installation Steps

1. If you have not already done so, complete the steps in ‘‘Installing Standard 
DNA Components’’ on page 175.

2. If this is the first time you have installed a DNA component on this 
computer, enter the name that you want to appear on the Programs folder 
(and Windows Start menu) for this application, or accept the default value, 
and click Next.

The installation program installs the selected DNA component(s). When it 
is finished, it displays the Setup Complete window.

3. Restart the computer or not, as follows:

■ If you want to immediately install other DNA components on this 
computer, click “No, I will restart my computer later” and click Finish.

■ If you do not want to install any other components on this computer, 
click “Yes, I want to restart my computer now” and click Finish.

You can now install DNA components on other computers in your network, using 
the same process.

Adding or Reinstalling Standard 
Components

You may need to add or reinstall DNA components if: 

■ You forgot to install a component.

■ Your needs change (for example, you buy a new laser printer).

■ You upgrade a switch (or voice mail system).

■ You add a switch (or voice mail system).

■ You want a different computer to support a particular switch (or voice mail 
system).

The process for reinstalling is the same as explained in ‘‘Installing Standard DNA 
Components’’ on page 175, but without questions about your name and company 
name, installation directories, domain names, FQDN or IP addresses, and 
program folder names. 

If you have used DNA on this computer since you installed DNA, be sure to back 
up DNA (see ‘‘Backing Up’’ on page 187) before you install additional components 
on this computer. 
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Installing Enhanced Number 
Portability (ENP)

DNA’s Enhanced Number Portability (ENP) feature is optional. If you have 
purchased ENP, it will arrive on a separate CD. 

This section assumes you do not have any other DNA components installed on 
this computer. If you do, the installation process is basically the same, except 
Step 6 through Step 10 will not appear.

To install ENP, complete the following steps:

1. If DNA is running on this computer, shut down DNA. 
(page 183)

2. Insert the ENP CD into the CD drive.

DNA displays a CD browser window.

3. Click Install ENP.

The installation program extracts the necessary files.

4. At the Welcome window, click Next.

5. To view the release notes, click Yes.

After viewing the release notes, click X to close the window.

6. If this is the first time you are installing a DNA component on this machine, 
enter your name and company’s name or accept the defaults and click 
Next.

7. If this is the first time you have installed a DNA component on this 
computer, specify the folder where you want to install the DNA components 
on this computer and click Next.

We recommend that you accept the default destination folder, but you may 
want to alter the default drive. To do so, click Browse, reset the drive letter, 
and click OK. Click Yes to confirm that you want the new folder created if it 
does not already exist.

8. If this is the first time you have installed a DNA component on this 
computer, and if your company has DNS configured on your computer 
network, then enter the name of the DNS Domain that this computer 
belongs to.

The installation planner should have recorded this on the Data Network 
Information Form for this computer, Step 12 on page 25. If you do not have 
DNS configured, leave this field blank.
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9. If this is the first time you have installed a DNA component on this 
computer, enter a fully-qualified domain name (FQDN) or IP address for 
the computer that hosts the Core Services, as described below, and then 
click Next.

The installation planner should have recorded this on the Data Network 
Information Form for the computer that hosts the Core Services, Step 13 
on page 25. If not, you can determine it by following the instructions for that 
step on the reverse side of the form, but follow the steps on the computer 
that hosts the Core Services to get the information. Then enter that 
information here.

What you enter (in Step 9) depends on whether you have DNS configured 
on your network:

10. If this is the first time you have installed a DNA component on this 
computer, enter the name that you want to appear on the Programs folder 
(and Windows Start menu), or accept the default value, and click Next.

The installation program installs ENP. When it is finished, it displays the 
Setup Complete window.

11. Restart the computer or not, as follows:

■ If you want to immediately install other DNA components on this 
computer, click “No, I will restart my computer later” and click Finish.

■ If you do not want to install any other components on this computer, 
click “Yes, I want to restart my computer now” and click Finish.

Condition What to enter, in order of preference

If you have 
DNS 
configured on 
your network...

■ Enter the FQDN of the Core Services computer.

■ Enter the IP address of the Core Services computer.

If you do not 
have DNS 
configured on 
your network...

■ Enter the short name of the Core Services computer 
(if you have WINS or “Hosts” files), or

■ Enter the IP address of the Core Services computer.
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Viewing Electronic Books Online

The DNA documentation CD includes electronic copies of this book, plus several 
DEFINITY system administration books. It also contains Guide Builder software 
for DEFINITY telephones, which you can use to create laser-printed user guides 
and designation cards for specific telephones.

With this CD, you can:

■ read the documentation directly from CD

■ install the documentation on your computer

■ install it on a network server, so people can access it using your LAN or 
corporate intranet.

■ install Guide Builder

For instructions on performing any of the above options, refer to the readme file 
on the documentation CD.

Uninstalling the Electronic Books

To remove the electronic books, complete the following steps:

1. From the Windows Start menu, select Programs>Lucent 
Documents>Uninstall DNA Documents.

If you installed the electronic books to a different location, select Uninstall 
DNA documents from wherever you installed them.

2. Click Yes to the confirmation dialog box.

The uninstall program removes the documentation and indicates when the 
uninstall is complete.

3. Click OK.
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Shutting Down DNA

Before you upgrade or uninstall DNA, you must shut down DNA. To do so, you 
must have access to the Core Services computer. Then complete the following 
steps:

1. Start the DNA client and log in using a DNA administration login.(page 190)

2. Click the Administration button on the DNA toolbar.

3. Select Action>Shutdown DNA.

If other clients are logged in, DNA will ask you if you want to proceed. Click 
Yes. 

4. Specify the number of minutes before shutdown and click OK.

DNA begins shutting down. You can watch the progress of the shutdown by 
opening the DNA Service Manager, as explained in the next step. When 
you do, you should see each of the DNA services terminating, except for 
the Naming Service, which requires an additional step to terminate.

5. On the Core Services computer, double-click the DNA icon (a helix) on the 
right end of the Task Bar.

DNA displays the DNA Service Manager.

6. Wait until all services have terminated except the Naming Service.

7. Select File>Exit and click Yes to the confirmation dialog box.

You must perform Steps 1-4 before 5-7. You also must perform Step 6 
before Step 7. Otherwise, DNA will not shut down cleanly.

Uninstalling DNA

To remove DNA from a computer, you must have Windows NT Administrator 
privileges. 

1. If DNA is running on this computer, shut down DNA. 
(page 183)

2. From the Windows Start menu, select Settings>Control Panel.

3. Double-click Add/Remove Programs.

4. On the Install/Uninstall tab, highlight DEFINITY Network Administration 
and click the Add/Remove button.

5. Confirm that you want to remove the selected application.

If DNA uses software components that are also used by another 
application, the system displays the Remove Shared File? dialog box. If 
you know that the shared file is not being used by any other application, 
you can delete it by clicking Yes or Yes to All.

6. Click OK.
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Removing DNA Files from Your 
Computer

If you uninstall DNA, some DNA files may remain on your computer. For example, 
DNA stores a database of translations for each supported switch, history logs of 
actions performed using DNA, and so on. If you want to remove these files, 
complete the following steps:

1. Using Windows File Manager, open the folder in which you installed DNA.

If you accepted the default installation location when you installed DNA, 
look in C:\Program Files\Lucent\DNA.

2. Delete any directories and files that DNA has created, by selecting them, 
pressing the Delete key, and clicking OK.

If you accidentally delete something, you can retrieve it from the Windows 
NT Recycle Bin, unless you turned off the Recycle Bin when you 
configured Windows NT. 

3. Repeat the above steps on all DNA servers.

Upgrading Switches

Before upgrading a switch, be sure that the new version is supported by the 
version of DNA you are using (page 17). Also be sure to execute all scheduled 
DNA tasks and custom scripts for that switch, and then save translations, before 
upgrading.

After you upgrade your switch, you must upgrade the DNA Device Service 
component that supports that switch, described next.
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Upgrading Standard DNA 
Components

When you upgrade DNA, you must upgrade every computer that has any DNA 
component installed (including the optional ENP feature or client software).

1. If DNA is running on this computer, shut down DNA. 
(page 183)

2. Back up your DNA system (page 187). 

3. Insert the DNA CD into the CD drive.

DNA displays a CD browser window.

4. Click Install DNA.

The installation program extracts the necessary files.

5. At the Welcome window, click Next.

6. To view the release notes, click Yes.

After viewing the release notes, click X to close the window.

7. View the upgrade summary page and click Next.

The summary page lists all DNA components that have been detected on 
the computer. All of these will be upgraded automatically after you 
complete the next screen. 

8. Indicate whether or not you have backed up your system.

Do not continue with the upgrade unless you have backed up. To proceed, 
click Yes. The upgrade program displays an MS-DOS window, which 
upgrades your databases to the new version. Then the installation program 
copies the new version of DNA to your computer.

9. Restart the computer or not, as follows:

■ If you want to immediately install other DNA components on this 
computer, click “No, I will restart my computer later” and click Finish.

■ If you do not want to install any other components on this computer, 
click “Yes, I want to restart my computer now” and click Finish.

10. Repeat these steps to upgrade any other DNA computers on your network.

To install additional clients, Connection Services, Button Label Printer Services, or 
Device Services on this computer, see ‘‘Adding or Reinstalling Standard 
Components’’ on page 180. 
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Upgrading the Electronic Books

If you have old DNA documentation on your computer, and you want the current 
DNA documentation, remove the old documentation before installing the new. To 
do so, complete the following steps: 

1. Close the DNA documentation if it is open.

2. Remove the old documentation by choosing Start>Programs>Lucent 
Documents>Uninstall DNA Installation Docs.

3. Install the new DNA documentation, following the instructions on the 
readme file that comes on the documentation CD.

Backing Up

It is your responsibility to back up your system regularly. You must back up every 
computer where DNA is installed (including those hosting only the DNA client). 

If you accepted the default pathnames when you installed DNA, we recommend 
that you back up the entire directory called:

■ C:\Program Files\Lucent\DNA

If you can’t back up the entire directory, then back up the following directories, at a 
minimum:

■ C:\Program Files\Lucent\DNA\rt

■ C:\Program Files\Lucent\DNA\devices

■ C:\Program Files\Lucent\DNA\data

You should also back up the computer’s registry. To do so, complete the following 
steps:

1. Choose Start>Run.

2. In the Run dialog box, type rdisk in the field, and click OK.

3. In the Repair Disk Utility dialog box, click Update Repair Info.

4. Click Yes in the confirmation dialog.

The Repair Disk Utility backs up the registry. When it is done, it asks if you 
also want to save the information to floppy disk. To do so, click Yes and 
follow the prompts.
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Configuring DNA

When you configure DEFINITY Network Administration (DNA), you enable it to 
communicate with the devices it supports. To configure DNA, you will perform the 
following main steps. The rest of this chapter explain these steps in detail.

1. Reboot the computer after installing DNA (before configuring).

2. Set up permissions on DNA’s “data” directories. (page 190)

3. Start DNA and log on. (page 190)

4. Set the password for the root login. (page 191)

5. Register the following:

■ all host computers (page 191)

■ all Connection Services (page 192)

■ all Button Label Printer Services (page 192)

■ all Device Services (page 193)

■ all ENP Services, if applicable (page 194)

6. Configure the following:

■ all Connection Services (page 195)

■ all Button Label Printer Services (page 200)

■ all Device Services (page 200)

■ all ENP Services, if applicable (page 203)

■ the DNA Navigator (page 205)

7. Add DNA users. (page 206)

8. Set up e-mail notification. (page 208)

9. Create groups. (page 214)

10. Assign DNA users to groups. (page 214)

11. Assign permissions. (page 214)

12. Initialize DNA databases supporting DEFINITY ECS Systems.
(page 218)

13. Set up resynchronization intervals and scheduled maintenance periods. 
(page 220)
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Setting Up Permissions on Data 
Directories

When people use DNA, DNA creates files in the “data” directory on your DNA 
servers. Most of the time, DNA creates data files on the Core Services computer. 
However, sometimes DNA creates data files on other DNA servers (if they exist).

If you do not set up sharing on the “data” directories appropriately, DNA users will 
not be able to read or write to these directories. From the DNA user’s perspective, 
it would appear that certain wizards (like Data Export or Data Import) are not 
functioning correctly. 

For example, if you do not share the “data” directory properly, and someone uses 
the Data Export wizard, the wizard would write the file to the “data” directory, but 
the DNA user would not be able to view or access it. Similarly, the (optional) ENP 
feature would also be affected: users would not be able to “read in” an external file 
to specify a list of extensions to move.

For these reasons, after you install DNA but before anyone uses it, be sure to set 
up appropriate network accounts, and be sure that each person who will use DNA 
has appropriate access privileges to the “data” directories on all DNA servers.

Starting DNA

1. On every computer that hosts a DNA server component, start the DNA 
Service Manager.

If you accepted the defaults when you installed DNA, you would choose 
Start>Programs>DEFINITY Network Administration>DNA Service 
Manager. A small, double-helix icon appears in the lower-right corner of the 
screen, in the Windows tray manager.

You can double-click the icon to display the DNA Service Manager and 
observe the progress of the start. You should see the following services 
appear: Administration, Naming service, EventLog service, LogicalView 
service, Scheduler service, and ScriptFactory service. If you have installed 
and configured the Connection Service and Device Services, you should 
also see the ConnSvrAdmin service, and a Device Service for each device.

2. Start the DNA client.

If you installed DNA in the default location, you would select 
Start>DEFINTY Network Administration>DNA Client.

Logging In

The first time you log in, use “root” as the username and “year2000” as the 
password.
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Setting the Root Password

To prevent others from logging into DNA as the DNA Administrator, change the 
password associated with the “root” login. 

1. Click the Administration button on the DNA toolbar.

2. Click the Administrators folder.

3. In the right pane, right-click on root and select Properties from the popup 
menu.

4. Enter the new password and re-enter it to confirm the spelling. 

A red box displays around the field until you fully enter a valid value.

5. Click OK.

If you don’t want to use the root login when you configure the software, you can 
add yourself as a user(page 206) and then assign yourself to the DNA 
Administrator group(page 214), which provides you with full administrative 
permissions. 

Registering Host Computers

Registering host computers tells DNA what computers support it. You do not need 
to register the computer that hosts the Core Services (this was done automatically 
when you installed it). Also, you do not need to register a computer if only the 
DNA client is installed on it. However, you must register all computers that host 
DNA server components. 

To register additional host computers, complete the following steps:

1. Click the Administration button on the DNA toolbar.

2. Right-click on Hosts and select New>Host Machine from the popup menu.

3. Type the FQDN or IP address of the host you want to add.

We recommend using FQDNs or IP addresses consistently for all of the 
different DNA components. That is, if you use an FQDN here, use FQDNs 
when you register all of the other DNA components, too.

4. Click OK.
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Registering Connection Services

When you register Connection Services, you tell DNA where the communications 
devices are that support it. 

To register Connection Services, complete the following steps:

1. Click the Administration button on the DNA toolbar.

2. Open the Hosts folder.

In the right pane, DNA displays all registered hosts.

3. Under Hosts, right-click on the host on which you installed the Connection 
Service you want to register.

4. Select New>Connection Service from the popup menu.

5. Confirm the addition by clicking OK.

6. Repeat these steps to for all other hosts that you installed the Connection 
Service software on.

Registering Button Label Printer 
Services

Registering Button Label Printer Services tells DNA what laser printers are 
available for printing the labels that go on your company’s telephones. 

To register Button Label Printer Services, complete the following steps:

1. Click the Administration button on the DNA toolbar.

2. Open the Hosts folder.

In the right pane, DNA displays all registered hosts.

3. Under Hosts, right-click on the host on which you installed the Button Label 
Printer Service you want to register.

4. Select New>Button Label Printer from the popup menu.

5. Enter the name you gave the Button Label Printer Service when you 
installed it on the given host machine.

You may have installed several Button Label Printer Services on a single 
computer; this step tells DNA which one you want to register. Type the 
name exactly as you typed it when you installed this Button Label Printer 
Service. The installation planner should have recorded this on the Data 
Network Information Form for this computer (page 31). 
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If you forgot the precise name of the service, you can determine it as 
follows:

a. Open Windows File Explorer on the computer where you installed 
the Core Services.

b. Open DNA’s devices folder.

If you installed DNA in the default directory, you will open 
C:\Program Files\Lucent\DNA\devices. This contains folders for 
each of the Device Services and Button Label Printer Services you 
installed. Use the same spelling (including case) as is on these 
folders when you register a service.

6. Confirm the addition by clicking OK.

7. Repeat these steps to register other Button Label Printer Services.

Registering Device Services

When you register Devices, you enable DNA to present you with a list of switches 
and voice mail systems that you can choose from during other configuration tasks. 
To register Devices, complete the following steps:

1. Click the Administration button on the DNA toolbar.

2. Open the Hosts folder.

In the right pane, DNA displays all registered hosts.

3. Right-click on a host computer, and from the popup menu, select New and 
the type of device you want to add:

4. Type the name of the device and click OK.

Type the name exactly as you typed it when you installed this Device 
Service. The installation planner should have recorded this on the Data 
Network Information Form for this computer (page 31). 

Select this option For this type of device

Definity ECS any supported DEFINITY ECS System (page 16) 
you want to administer using DNA.

AUDIX any supported DEFINITY or Intuity AUDIX system 
you want to administer using DNA.

Device for all other kinds of telephony devices, including 
DEFINITY and AUDIX Systems that are not 
supported by DNA.
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If you forgot the precise name of the Device Service, you can determine it 
as follows:

a. Open Windows File Explorer on the computer where you installed 
the Core Services.

b. Open DNA’s devices folder.

If you installed DNA in the default directory, you will open 
C:\Program Files\Lucent\DNA\devices. This contains folders for 
each of the Device Services and Button Label Printer Services you 
installed. Use the same spelling (including case) as is on these 
folders when you register a service.

5. Repeat these steps to register other Device Services.

Registering ENP Services

Registering ENP Services only if you installed the (optional) ENP feature. To 
register an ENP service, complete the following steps:

1. Click the Administration button on the DNA toolbar.

2. Open the Hosts folder.

In the right pane, DNA displays all registered hosts.

3. Under Hosts, right-click on the host on which you installed the ENP service 
you want to register.

4. Select New>ENP Service from the popup menu.

5. Type the name you want to give this ENP network.

The installation planner should have recorded this on the Data Network 
Information Form for this computer (page 31). 

6. Click OK.

DNA adds the ENP service to the DNA Navigator window.



DEFINITY Network Administration Release 3
Planning, Installation, and Configuration  555-233-602CI  

Issue 2
December 2000

Configuring DNA 
195Configuring Connection Services 

16

Configuring Connection Services

The Connection Service stores information that DNA uses to connect to the 
devices it supports. You will need to configure each copy of the Connection 
Service separately, because each copy is installed on a different computer and 
serves different devices.

Overview

To configure the Connection Service, you will complete the following basic steps, 
which are explained in detail in the procedures that follow:

1. Open the Connection Service Administration window. 
(page 195)

2. Set up serial device scripts. (page 195)

3. Set up end point scripts. (page 196)

4. Set up serial ports. (page 197)

5. Set up end points. (page 198)

Opening the Connection Service Admin Window

The Connection Service Administration window is where you will perform all 
activities to configure the Connection Service software.

1. Click the Administration button on the DNA toolbar.

2. Open the Hosts folder.

3. Under Hosts, double-click on the host containing the Connection Service 
you want to configure.

4. Double-click on ServiceConnSvrAdmin.

Setting Up Serial Device Scripts

Most likely, you will not need to create your own device scripts. If you do, read this 
section. Serial device scripts control the configuration of peripherals, such as 
modems, data modules, or whatever device you are using to connect DNA 
computers to the switches and voice mail systems that DNA supports.

DNA comes with pre-configured serial device scripts for 7400 data modules, 8400 
data modules, ADUs, PDMs, and generic modems. The generic modem script will 
work for the majority of Hayes-compatible modems. To set up a new serial device 
script, complete the following steps:

1. Right-click on Serial Device Scripts and select New>Serial device script 
from the popup menu.

2. Enter the name you want to give the serial device script.
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The installation planner should have recorded this on the Data Network 
Information Form for this computer (Step e on page 29). If the value 
recorded is 7400, 8400, ADU, Generic Modem, or PDM, these are the 
pre-configured scripts that DNA provides by default. Most likely, this means 
you should not be configuring your own script, but instead using a DNA 
default. In that case, skip this section. You will use the information that the 
installation planner recorded (above) in Step 5 on page 197.

3. Click OK.

DNA adds the script to the Connection Service Administration window. If 
you want to take the default values that DNA assigns to serial device 
scripts, STOP HERE. 

4. To set your own script for the serial device, right-click on the serial device 
script that you just added and select Properties from the popup menu.

5. Make any necessary changes to the scripts.

The script format follows UUCP conventions. See ‘‘Appendix B — UUCP 
Send/Expect Strings’’ on page 227.

6. Click OK.

Setting Up End Point Scripts

Most likely, you will not need to create your own end point scripts. If you do, read 
this section. “End points” are the switches, voice mail systems, and other 
telephony devices that DNA can communicate with. End point scripts tell DNA 
how to log into and out of these devices. 

DNA comes with pre-configured end point scripts for DEFINITY ECS, DEFINITY 
AUDIX, and Intuity AUDIX end points. If you want to use a pre-configured end 
point script, skip this section. If you want to add your own end point script, 
complete the following steps:

1. In the Connection Service Administration window, right-click on End Point 
Scripts and select New>End Point Script from the popup menu.

2. Enter a name for the end point script.

The installation planner should have recorded this on the Data Network 
Information Form for this computer (Step f on page 29). If the value 
recorded is DEFINITYECS, DEFINITYAUDIX, or Intuity AUDIX, these are 
the pre-configured scripts that DNA provides by default. Most likely, this 
means you should not be configuring your own script, but instead using a 
DNA default. In that case, skip this section. You will use the information that 
the installation planner recorded (above) in Step 5 on page 198.

3. Click OK.

DNA adds the end point script you specified to the Connection Service 
Administration window. If you want to take the default values that DNA 
assigns to end point scripts, STOP HERE. 
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4. Right-click on the end point script you just created and select Properties 
from the popup menu.

5. Make any necessary changes to the scripts.

The script format follows UUCP conventions. See ‘‘Appendix B — UUCP 
Send/Expect Strings’’ on page 227.

6. Click OK.

Setting Up Serial Ports

Setting up serial ports associates serial device scripts with a particular COM port 
on this computer. You will need to set up a serial port for each COM port that DNA 
uses to communicate with the devices it manages. So, for example, if you are 
using only one COM port on a given computer to communicate with devices, you 
would perform these steps only once on that computer.

1. In the Connection Service Administration window, right-click on Serial Ports 
and select New>Serial Port from the popup menu.

2. Select a COM port number from the drop down list.

3. Click OK.

4. Right-click on the serial port you just added and select Properties from the 
popup menu.

5. Associate a serial device script with this serial port, as follows:

NOTE:
If this is a direct serial connection, leave the Serial Device Script field blank.

a. Click the browse button.

b. In the dialog box that displays, double-click the Serial Device Script 
folder.

c. Highlight the appropriate serial device script and click Select.

The installation planner should have recorded this on the Data 
Network Information Form for this computer (Step e on page 29).

d. For the other fields, make any changes and click OK.
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Setting Up End Points

Setting up end points associates device scripts and either network connections or 
serial port connections with that device.

1. In the Connection Service Administration window, right-click on End Points 
and select New>End Point from the popup menu.

2. Type a name for the end point or click the Browse button to locate one.

This must match the name of the installed device that this end point is for.

3. Click OK.

Within the End Points folder, DNA adds a folder for the end point you 
specified.

4. Double-click on the End Points folder.

DNA displays all of the end points in the End Points folder.

5. Give the end point an end point script, as follows:

a. Right-click on the end point you just created and select New>End 
Point Script from the popup menu.

If you do not see this option, it is probably because you have already 
associated an end point script with this end point. Each end point 
can be associated with only one end point script.

b. Enter the name of the end point script in the End Point Script field or:

1. Click the browse button.

2. Highlight the appropriate end point script and click Select.

The installation planner should have recorded this on the 
Data Network Information Form for this computer (Step f on 
page 29). 

c. Click OK.

DNA adds the selected end point script to the end point folder that 
you created in Step 3 of this procedure.

6. If DNA is using a network connection to communicate with the device in 
question, then give the end point a network connection, as follows:

a. Right-click the end point you created and select New>Network 
Connection from the popup menu.

b. Type a name for the network connection.

The installation planner should have recorded this on the Data 
Network Information Form for this computer (Step n on page 29). 
For example, TCP/IP to WestCampusSwitch.

c. Click OK.

DNA adds the network connection to the end point folder you 
created in Step 3 of this procedure.
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d. Right-click the network connection in the right panel and select 
Properties from the popup menu.

e. In the TCP/IP Host Name field, type the FQDN or IP address of the 
end point.

The installation planner should have recorded this on the Data 
Network Information Form for this computer (Step o on page 29). 

f. In the TCP/IP Service/Socket field, type the socket name or number 
of the end point.

The installation planner should have recorded this on the Data 
Network Information Form for this computer (Step p on page 29). 
For example, “telnet” or “23”.

g. Click OK.

7. If DNA is using a serial port to communicate with the device in question, 
then give the end point a serial port connection as follows:

a. Right-click the end point you created and select New>Serial Port 
Connection from the popup menu.

b. Enter the name for this connection (not the serial port).

The installation planner should have recorded this on the Data 
Network Information Form for this computer (Step h on page 29). 
For example, COM1 to EastCampusSwitch.

c. Click OK.

DNA adds the connection name to the end point folder that you 
created in Step 3 of this procedure.

d. Right-click the serial port connection you just added and select 
Properties from the popup menu.

e. In the Serial Port field, enter the name of the serial port you want to 
use with this end point or:

1. Click the browse button.

2. Highlight the appropriate serial port and click Select.

The installation planner should have recorded this on the 
Data Network Information Form for this computer (COM Port 
# column header page 29). 

f. Type the phone number that DNA should use to connect from this 
Connection Service to this end point.

The installation planner should have recorded this on the Data 
Network Information Form for this computer (Step i on page 29). If 
this is a direct connection, leave this field blank. Do not include 
parentheses ( ) in this field.

g. Click OK.

8. Repeat Step 6 and Step 7 as many times as necessary to add all 
connectivity options for this device.
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Configuring Button Label Printer 
Services

Configuring Button Label Printer services tells DNA which printer to print to and 
where on the page to print the button labels.

1. Click the Administration button on the DNA toolbar.

2. Open the Hosts folder.

3. Click on the host on which you registered the button label printer service 
that you want to configure.

4. Right-click on the button label printer service you want to configure and 
select Properties from the popup menu.

5. In the General tab, in the Printer Name field, enter the UNC pathname for 
the printer that this service will use.

The installation planner should have recorded this on the Data Network 
Information Form for this computer (page 31). 

6. Adjust the positioning of the button labels on the printed page, complete 
the following steps:

a. Click the Set Types tab.

b. Select the set type you want to adjust.

c. Set Horizontal Offset and Vertical Offset fields.

These fields accept multiple-character entries (in 1/100 of an inch).

7. Click OK.

Configuring Device Services

When you configure a device, you are giving DNA the information it needs to 
connect, log in, and communicate with the device.

1. Click the Administration button on the DNA toolbar.

2. Open the Hosts folder.

3. Click on the host containing the device you want to configure.

4. In the right-hand pane, right-click on the device you want to configure and 
select Properties from the popup menu.

5. In the General tab, enter a description of the device.

DNA does not require this information; enter it here only to help you 
remember important facts about the device.

6. Click the Communications tab.
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7. Click Browse to search for the FQDN or IP address of the computer on 
which you registered the Connection Service software that will serve the 
device in question.

If you click Browse, highlight the host and then click Select.

8. If you are configuring a DEFINITY ECS, in the Maximum Simultaneous 
Physical Connections field, enter the number of active connections you 
want to allow at one time through this Connection Service. 

This is typically 1, although it may be greater if you have configured 
multiple connections (network or serial).

9. If you are configuring a DEFINITY ECS, in the Disconnection Inactivity 
Timeout field, enter the number of seconds that you will allow without 
activity before the Device Service terminates the connection to this device.

Recommended value: 300 seconds (5 minutes).

10. On the DEFINITY ECS (or AUDIX) tab, select the First Name First 
check box if you want DNA to send users’ names to the switch (or voice 
mail system) with first name first.

On DEFINITY ECS and AUDIX systems, there is only one field for the 
user’s name. However, on DNA, there are two: one for first name and one 
for last name. This check box tells DNA how to combine the two name 
fields before sending the information to the switch or voice mail system.

11. Click the Admin tab.

For a DEFINITY ECS, complete the following fields:

Field Entry

Administration 
Account

In this field, type name of the DNA Administrative 
Login you created in ‘‘Creating the Administrative 
Login’’ on page 117.

Password In this field, type the password of the DNA 
Administrative Login you created in ‘‘Creating the 
Administrative Login’’ on page 117.

Password check Type the password again.

ASG Secret Key If your switch has ASG enabled, and you want to 
use ASG for this login, then enter the Secret Key 
that you or the switch generated in ‘‘Creating the 
Administrative Login’’ on page 117.

Use ASG login If your switch has ASG enabled and you want to 
use ASG for this login, select this check box.
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For an AUDIX, complete the following fields:

12. If you are configuring a DEFINITY ECS, click the Init tab and complete the 
following fields.

If you are configuring a DEFINITY ECS and you have not yet initialized the 
DNA database, you will be prompted to do so now. 

Field Entry

Administration 
Account

In this field, type the login for your AUDIX system.

Administration 
Account Password

In this field, type the AUDIX password.

Password check Type the password again.

ASG Secret Key If you are using ASG with this login, enter the 
Secret Key that DNA will use to access AUDIX 
using this login.

Use ASG login If your AUDIX has ASG enabled and you want to 
use ASG for this login, select this check box.

Field Entry

Initialization 
Account

In this field, type the name of the DNA upload login 
you created in ‘‘Creating the Upload Login’’ on page 
115.

Password In this field, type the password you assigned to the 
upload login.

Password check Type the password again.

ASG Secret Key If your switch has ASG enabled, and you want to 
use ASG for this login, then enter the Secret Key 
that you or the switch generated in ‘‘Creating the 
Upload Login’’ on page 115.

Use ASG login If your switch has ASG enabled and you want to 
use ASG for this login, select this check box.
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13. We recommend that you test connections before you initialize, because if 
the connection were not to work, DNA could not initialize. 

NOTE:
Initializing a DEFINITY database can take several hours, and during that 
time you cannot use DNA to perform any other activity on that switch. 
Initialization time varies depending on the number of stations, trunks, and 
enabled switch features, as well as the dial plan configuration and other 
variables. Perform this activity during low-use periods.

a. To initialize now, click OK.

b. To test first and initialize later, click Cancel. Then see Chapter 16, 
"Configuring DNA".

When you are ready to initialize, see ‘‘Initializing DEFINITY 
Databases’’ on page 218.

14. Click OK.

Configuring ENP Services

DNA’s Enhanced Number Portability wizard will not move a station (or a 
subscriber) from one switch (or voice mail system) to another until DNA knows 
which switches (or voice mail systems) are a part of the network. This section 
explains how to tell DNA which systems are a part of a network. 

Prerequisites

Before you can configure DNA’s ENP Services, you must have performed the 
following tasks:

1. Create the switch and voice mail network.

Your switches and voice mail systems must be networked before you can 
use DNA’s ENP feature. If you haven’t already created the network, either 
contact your Lucent representative to set one up, or refer to the 
documentation that came with your switch or voice mail system. 

2. Install, register, and configure DNA Device Services for each switch or 
voice mail system that you want to administer with DNA’s ENP feature.

This step puts the correct DNA software in place to support the switches 
and voice mail systems that you networked in Step 1. Until you have 
Device Service components set up for each of your devices, you cannot 
configure the ENP Service.
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Opening the ENP Properties Dialog

Once you have set up your network and Device Services, then you can configure 
DNA’s ENP Service by completing the following steps:

1. Click the Administration button on the DNA toolbar.

2. Open the Hosts folder.

3. Click on the host on which you registered the ENP Service.

4. Right-click on the ENP Service and select Properties from the popup 
menu.

Specifying the Switches on Your Network

1. On the DEFINITYECSs tab, click Add to List.

2. In the Select Device dialog box, navigate to the switch you want to add to 
this ENP network.

Putting a switch on this list does not make it a part of the physical switch 
network; it just tells DNA which switches are already a part of a network. 
For help using this screen, click the Help button.

3. Repeat Steps 1 and 2 until you have added all of the switches you want to 
the list.

4. Select the Extension Number Portability (ENP) routing radio button.

5. Enter the Node Number for each of the switches on the list. 

You installation planner should have gathered the Node Numbers of all 
switches on your network. To enter the Node Number, click in the Node 
Number box, type the number, and press Enter.

6. For each switch, select the Update check box if you want DNA to 
automatically update the switch’s routing table when a station is moved 
from one switch to another.

DNA will make the same change to all selected routing tables. DNA does 
not support making different changes to different routing tables. Therefore, 
do not select the Update check box for switches that need to be updated 
differently than the other switches on the list.
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Specifying the Voice Mail Systems on Your 
Network

This procedure is continued from "Opening the ENP Properties Dialog" (page 
204).

1. Click the AUDIXs tab, and then click Add to List.

2. In the Select Device dialog box, navigate to the voice mail system you want 
to add to this ENP network.

Putting a voice mail system on this list does not make it a part of the 
physical network; it just tells DNA which voice mail systems are already a 
part of a network. For help using this screen, click the Help button.

3. Repeat Steps 1 and 2 until you have added all of the voice mail systems 
you want to the list.

Configuring the DNA Navigator

DNA Navigator is the main window you use to view or access the devices DNA 
supports. In this task, you create the folders and place objects (devices or button 
label printer services) in the appropriate folder. Then, anyone who uses DNA can 
see what objects are available, and access them if they have appropriate 
permissions.

Creating Folders

Your installation planner should have specified what folders to create using the 
Folder Permissions Worksheet. When you know what folders to create, create 
them by completing the following steps:

1. Click the DNA Navigator button on the toolbar.

2. In the DNA Navigator window, right-click on the root folder and select 
New>Folder from the popup menu.

3. Type the name you want to give the folder.

4. Click OK.

To rename a folder, delete the folder and create a new one.
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Adding Objects to Folders 

After you create the folder hierarchy, you can add objects (devices or button label 
printer services) to the folders. Your installation planner should have specified 
which objects go in which folders. To add objects to folders, complete the 
following steps:

1. Right-click on the folder where you want to add the service and, from the 
popup menu, select New and the type of service you are adding.

DNA displays a selection window.

2. Double-click on the host computer that contains the service you want to 
add.

3. Highlight the service you want to add and click OK.

DNA places the service you selected inside the folder. This action merely 
inserts a shortcut; it does not copy or move the service from the location 
where you originally installed it.

Adding DNA Users

DNA users are the switch administrators, AUDIX administrators, and others who 
use DNA. Adding DNA users gives each person a login and password to access 
DNA, among other things.

To add a DNA user, complete the following steps:

1. Click the DNA Admin button on the toolbar.

2. Right-click on Administrators and select New>Administrator.

3. Complete the appropriate fields, as follows:

Field Value

Login Name Enter the login name for this DNA user. This is the name 
that the user must type at the DNA Login dialog box, to 
access DNA.

Name Enter the real first and last name of the DNA user.

MAPI- 
Compliant 
E-mail 
Address

If you want DNA to send this person e-mail when certain 
conditions arise, enter the user’s e-mail address, in a 
format appropriate to your e-mail application. For help, 
see ‘‘Specifying the Recipient’s E-mail Address’’ on page 
210.

Description Completing this field is optional. You can use it to store 
administrator-specific information. DNA does not display 
this information in any other DNA screens, and the 
information you enter here has no effect on DNA, your 
switches, or other applications.
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4. Click OK.

Password/ 
Confirmation

In both of these fields, enter the password that this 
administrator would type to access DNA (regardless of 
whether you are using ASG for this login). 

You must enter a password here, even if you plan to use 
ASG. 

The Password and Confirm Password boxes are outlined 
in red until you enter a password in BOTH boxes that 
meets the following requirements: passwords must 
contain at least 7 characters, at least 1 character must be 
numeric, and at least 1 character must be alphabetic.

ASG Complete this field only if you are enabling ASG for this 
login. Otherwise, leave this field blank.

Either create a Secret Key of your own, or Click Create 
ASG Key to have DNA create one for you. If you create 
one on your own, it must conform to the following 
requirements:

■ It must be 20 digits long.

■ Each digit must be between 0 (zero) and 7, inclusive.

■ The last digit must be 0 (zero).

■ The next-to-last digit must be 0 (zero), 2, 4, or 6.

Note the Secret Key and keep it in a secure location. 
Ideally, you should program your administrator’s 
hand-held ASG PassKey immediately with the Secret 
Key. Less ideally, you can give the administrator the 
Secret Key using a secure method (for example, by telling 
them in person). Do not e-mail the Secret Key! (E-mail is 
not a secure transmission method!)

Use ASG 
login

Select this box if you want this user to have to enter an 
ASG response, instead of a password, to access DNA. 
This check box turns ASG on or off for this administrator, 
but does so only between the administrator and DNA. 
This field does not affect whether ASG is set up between 
DNA and a switch or voice mail system.

Field Value
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Receiving E-mail Event Notification

DNA can send you (or any DNA user) e-mail when it encounters errors and other 
situations. To use this feature, you must first install a MAPI-compliant e-mail client 
(like Microsoft Outlook or Microsoft Exchange Client) on the Core Services 
computer, and install an e-mail server somewhere else on the network. The e-mail 
server must be running at all times. However, the e-mail client (on the Core 
Services computer) does not have to be running.

To configure e-mail notification, you must perform the following activities:

1. (Optional) Set up a separate mailbox for DNA on the e-mail server.

When DNA sends out e-mail, it looks (to the recipient) like it is coming from 
this mailbox. Some companies set up a separate mailbox for DNA; others 
simply use an existing employee’s mailbox. The advantage to using an 
existing employee’s mailbox is that if someone inadvertently responds to a 
DNA e-mail, it is more useful if it goes to a mailbox that is checked 
regularly.

2. Create an e-mail profile called ‘DNA’ (as explained below) on the Core 
Services computer.

3. Specify the address of the person you want to receive e-mail.

4. Specify under what conditions you want DNA to send this person e-mail.

Creating an E-mail Profile for DNA

This book does not endeavor to explain how to set up all of the many different 
e-mail clients available. However, if your e-mail client is Microsoft Outlook or 
Microsoft Exchange Client, and you use Microsoft Exchange Server as your 
e-mail server, then the process for creating the 'DNA' e-mail profile is as follows:

1. From the Windows Start menu, choose Settings>Control Panel.

2. Double-click the ‘Mail’ or ‘Mail and Fax’ icon.

3. If other profiles already exist, click the Show Profiles button, or click the 
Add... button to create a new profile.

Windows displays the Microsoft E-mail setup wizard.

4. Select the ‘Manually configure information services’ radio button, and click 
Next.

5. When prompted for the profile name, type DNA and click Next.

6. Click the Add... button, select Microsoft Exchange Server, and click OK.

Windows displays a window you can use to configure the e-mail profile you 
are adding.
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7. Type the name of your Microsoft Exchange Server.

If you do not know the name, ask your e-mail administrator or refer to the 
documentation that came with the application. Optionally, you can explore 
the client e-mail application. 

Below, we describe how you can determine the name of your e-mail server 
if you are using Microsoft Exchange Client, version 5. If you are using a 
different product (or version), these instructions may not work for you; in 
that case, read the documentation that came with the application.

a. Open the e-mail application. 

b. Choose Tools>Options.

c. Click the Services tab.

d. Highlight Microsoft Exchange Server and click the Properties button.

(If this option is not on the list, contact your e-mail administrator for 
help.) When the Properties screen appears, look for the name of 
your Microsoft Exchange server on the General tab. You can copy 
this name and paste it in the ‘Mail’ or ‘Mail and Fax’ dialog boxes.

8. Type the name of the Mailbox.

If you do not know this, ask your e-mail administrator, who is responsible 
for creating mailboxes on the e-mail server. Note that this mailbox must be 
set up on the e-mail server before you can perform this step. Otherwise, 
this client will not be able to find the mailbox, and will not let you complete 
the profile. 

9. In the “When Starting” area, select “Connect with the network”. 

This question is targeted at people who use laptops or other 
non-networked computers to access e-mail. Since the Core Services 
computer is permanently connected to the network, the DNA e-mail profile 
should specify to connect with the network on startup.

10. Leave the check box called, “Choose the connection type when starting” 
unchecked.

This question is also targeted at non-networked computers.

11. Click OK to exit the configuration window.

12. Click OK to exit the Properties window.

13. Indicate whether or not you want the e-mail client to run automatically when 
you start Windows on the Core Services computer, and click Next.

14. Click Finish.

15. Click Close on the ‘Mail’ or ‘Mail and Fax’ window.

16. Close the Control Panel.

NOTE:
You do not need to make this new DNA profile the default for the Mail and 
Fax clients.
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Specifying the Recipient’s E-mail Address

You can specify the recipient’s e-mail address when you first add a DNA user (see 
‘‘Adding DNA Users’’ on page 206) or afterwards. 

To do so afterwards, complete the following steps:

1. Click the Administration button on the DNA toolbar

2. Open the Administrators folder, right-click on the administrator you want to 
configure, and select Properties.

DNA displays the User Properties dialog.

3. Enter a MAPI-compliant e-mail address in the e-mail address field. 

If you do not know the correct format, ask your e-mail administrator or 
check the documentation that came with your e-mail application. 

Optionally, you can often determine the correct format from the e-mail 
client itself (assuming you already have a working e-mail account set up). 
Below, we describe this process for Microsoft Exchange Client, version 5. If 
you are using a different product (or version), these instructions may not 
work for you; in that case, read the documentation that came with the 
application.

a. Open your e-mail application.

b. Open the address book.

(In Exchange, choose Tools>Address Book.)

c. Find the recipient’s name in the list of addresses, and highlight it.

d. When the name is highlighted, choose File>Properties.

e. Click the E-mail Addresses tab.

Any of the e-mail formats listed on this tab are acceptable for DNA’s 
E-mail Address field. 

Specifying the Events that Trigger E-mail

To specify which events will make DNA send someone e-mail, complete the 
following steps:

1. In the DNA Administration window, open the Administrators folder.

2. In the right pane, right-click on the administrator you want to configure, and 
select EMail Notification from the popup menu.

DNA displays the Select Notifications dialog box. 

3. Select the Set radio button.
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4. Click the Set... button to specify the conditions under which this DNA user 
will receive e-mail from DNA.

DNA displays a History Filter dialog box. By default, this dialog box is 
configured so that DNA sends e-mail only when an error occurs upon 
execution of a DNA task. 

5. To specify different conditions, select the appropriate boxes, as described 
below.

The boxes on this page behave as AND statements. That is, the more 
check boxes you select, the fewer situations in which you will receive 
e-mail. 

Table 11. E-mail Notification Set Filter dialog box 

Field Description

Severity:
Information

DNA enters an “information” entry in the History Log when a 
task executes without error. Select this box to receive e-mail 
whenever this happens.

Severity: 
Warning

DNA enters a “warning” entry in the History Log when potential 
problems occur. Select this box to receive e-mail whenever this 
happens.

Severity: Error DNA enters an “error” entry in the History Log when some kind 
of failure has occurred in the DNA system. Select this box to 
receive e-mail whenever this happens.

Event 
Classification

Select this box to receive e-mail when DNA encounters any of 
the situations listed when you click the Set... button. Click the 
Set... button to specify the conditions. Refer to Table 12 on 
page 212 for field descriptions.

User Name Select this box to receive e-mail whenever events occur that 
originated from the actions of a particular DNA user. To specify 
the user, type the person’s user name in the box, or click the ... 
button to choose from a list.

Service It is not likely that you will need to use this field for e-mail 
notification purposes.

Select this box to receive e-mail when DNA logs a History Log 
entry from a particular DNA service. To specify the service, 
type it in the box, or click the ... button to choose from a list. 

For example, to receive e-mail whenever someone accesses a 
particular switch, select this box and specify the name of the 
Device Service for that switch.

Continued on next page
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6. If you selected the Event Classification check box in Step 5, then click the 
Set... button and select any of the following options.

The boxes on this dialog box behave as OR statements. That is, the more 
boxes you check, the more situations in which you will receive e-mail.

 

Task ID It is not likely that you will need to use this field for e-mail 
notification purposes.

This field allows you to receive e-mail when DNA executes a 
task that has a particular identification number. DNA assigns ID 
numbers only when it executes (or attempts to execute) a task. 
For this reason, this field is useful only for notifying you about 
tasks that are being re-executed. For example, you could check 
this box if you want to be notified when DNA re-executes a 
regular task (like resynchronization) or a particular failed task.

Date It is not likely that you will need to use this field for e-mail 
notification purposes.

Select this box to receive e-mail when the DNA History Log is 
generated for a particular day.

Table 12. E-mail Notification Event Classification 

Field Description

Communications Select this box to receive e-mail when any entries appear in 
DNA’s History Log that deal with DNA’s connections to 
supported switches and voice mail systems. 

Service Manager The Service Manager is the application that coordinates all 
of the services that make DNA run. Select this box to receive 
e-mail whenever the Service Manager logs an entry in the 
DNA History Log, such as a service starting or a service 
exiting.

Logins/Logouts Select this box to receive e-mail when DNA users log into or 
log out of DNA.

DNA Administration Select this box to receive e-mail when any DNA user makes 
an administrative change to DNA, such as adding a service, 
host machine, or administrator, or changing existing settings.

Continued on next page

Table 11. E-mail Notification Set Filter dialog box  — Continued

Field Description

Continued on next page
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7. Click OK to exit the Event Classification dialog box (if you opened it).

8. Click OK to exit the User Properties dialog box.

Terminal Emulation Select this box to receive e-mail when any DNA user opens 
a terminal emulation session to a device supported by DNA. 
If someone uses another terminal emulation package to cut 
through to a switch, you will not receive e-mail, because 
DNA only keeps track of its own terminal emulation sessions.

Button Label 
Printing

It is not likely that you will need to use this field for e-mail 
notification purposes. Select this box to receive e-mail when 
a DNA user prints button labels.

ICI Script 
Execution

Some customers write customized scripts for DNA to 
execute. If your organization uses DNA to execute ICI 
scripts, you can select this box to receive e-mail whenever 
DNA executes such a script.

ENP Wizard 
Execution

Some customers have their switches (or voice mail systems) 
networked, and have purchased DNA’s optional Enhanced 
Number Portability (ENP) feature. If you are such an 
organization, and you want to know when the ENP feature 
logs any entries in the DNA History Log, select this box.

Task Execution It is not likely that you will need to use this field for e-mail 
notification purposes. Select these boxes to receive e-mail 
when a task has been scheduled, started, or completed. 
Checking more than one box behaves as an OR statement. 
That is, if you check all three, you will receive e-mail in all 
three situations.

Sub Task 
Execution

It is not likely that you will need to use this field for e-mail 
notification purposes. DNA tasks can be made up of many 
subtasks. Select one of these options if you want to be 
e-mailed when subtasks start or complete.

Device Events The Device Service for a particular switch or voice mail 
system is the DNA component that issues commands to that 
system. Select this option if you want to receive e-mail 
whenever DNA issues “read” commands (list, display, and so 
on) or “write” commands (change) for that system. Check 
“Device Events” to be notified when any other “device 
events” occur (such as accessing mirror database, 
relinquishing access to mirror database, GEDI session 
starting, and so on).

Table 12. E-mail Notification Event Classification  — Continued

Field Description

Continued on next page
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Creating User Groups

If you want to create a custom user group, complete the following steps:

1. Click the DNA Admin button on the toolbar.

2. Right-click Groups and select New>Group.

3. Type the name you want to give the group.

4. Click OK.

Adding Users to Groups

1. From the DNA Admin window, double-click Groups to see a list of user 
groups.

2. Right-click the group you want to add administrators to, then select 
New>Administrator.

DNA displays a list of DNA users.

3. Select the user or users you want to add to this group.

To select multiple entries, hold down the Ctrl key as you click the entries.

4. Click OK.

Assigning Permissions

You may want to read Chapter 10, "Permissions Overview" as well as Chapter 11, 
"Planning Device Permissions" before performing any of the activities in this 
section. Assigning Device Command Permissions

Assigning Device Permissions

Device Command permissions enable you to specify which DNA users can 
execute which commands on a given DEFINITY ECS. 

Your installation planner should already have specified which users and groups 
should have permission to issue which DEFINITY commands, for each switch that 
will be supported by DNA, using the “Device Permissions Worksheet” on page 75.

To assign DEFINITY command permissions, complete the following steps:

1. Click the DNA Admin button on the toolbar.

2. Double-click on Hosts.

3. Click a host.
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4. Right-click on a device and select Permissions from the popup menu.

DNA displays a tree view of all available commands for that device and any 
assigned permissions. By default, the Device Administrators group 
appears by default at the root level of the tree. Members of this group have 
access to all DEFINITY commands, but you can change that by removing 
this group from the root level of the tree and assigning it to the specific 
commands you want the group to be able to perform.

5. Right-click a command and select New>Command Permissions from the 
popup menu.

DNA displays the Add Permissions window, which lists all DNA users and 
groups.

6. Select the DNA users and groups you want to have permission to execute 
the selected command.

To select multiple entries, hold down the Ctrl key as you click the entries.

7. Click OK.

8. Repeat these steps for each command you want to set permissions for.

9. Repeat these steps for each DEFINITY that DNA supports.

Assigning Folder Permissions in DNA Navigator

Folder permissions enable you to specify which DNA users can access (read 
permission) or modify (read/write permission) the various folders in the DNA 
Navigator. 

Your installation planner should already have specified which folders go in the 
DNA Navigator, using the “Folder Permissions Worksheet” on page 105.

To assign folder permissions, complete the following steps:

1. Click the DNA Admin button on the toolbar.

2. Double-click on Hosts.

3. In the left pane, click the host that contains the Core Services software.

4. Right-click on Service:LogicalView and select Permissions from the popup 
menu.

DNA displays a tree view of all folders in the DNA Navigator.

5. Right-click the folder you want to set permissions for and select 
New>Folder Permissions from the popup menu.

DNA displays the Add Permissions window, which lists all DNA users and 
groups.
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6. Select the DNA users and groups you want to have permission to access 
the selected folder.

To select multiple entries, hold down the Ctrl key as you click the entries.

7. Click Read or Read/Write.

8. Click OK.

9. Repeat these steps for each folder.

Assigning Scheduler Permissions

Your installation planner should already have specified which DNA users should 
have scheduler permissions, using the Services Permission Worksheet on page 
107. By default, all DNA users have permission to view and change their own 
scheduled tasks. This section explains how to set permissions to enable DNA 
users to view and change other users’ scheduled tasks. 

1. Click the DNA Admin button on the toolbar.

2. Double-click on Hosts.

3. Click the host that contains the Core Services software.

4. Right-click on Service:Scheduler and select Permissions from the popup 
window.

5. Right-click View All Tasks and select New>Command Permission from the 
popup menu.

DNA displays the Add Permissions window, which lists all DNA users and 
groups.

6. Select the DNA users and groups you want to have permission to view all 
scheduled tasks.

To select multiple entries, hold down the Ctrl key as you click the entries.

7. Click OK.

8. Right-click Change All Tasks and select New>Command Permission from 
the popup menu.

DNA displays the Set Permissions window, which lists all registered DNA 
users and groups.

9. Select the DNA users and groups you want to have permission to change 
all scheduled tasks.

To select multiple entries, hold down the Ctrl key as you click the entries.

10. Click OK.
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Assigning Call Accounting Permissions

Call Accounting packages keep track of call information that can be used for 
billing and cost allocation purposes. DNA can gather this information from the 
switches it supports and export it in a format that Call Accounting packages can 
use. 

Your installation planner should already have specified which users and groups 
should have permission to export Call Accounting data from the switch, for each 
switch that will be supported by DNA, using the Services Permissions Worksheet 
on page 107.

To assign call accounting permissions, complete the following steps:

1. Click the DNA Admin button on the toolbar.

2. Double-click on Hosts.

3. Click the host that contains the Core Services software.

4. Right-click on DNA Administrator Service and select Permissions from the 
popup window.

5. Right-click Call Accounting and select New>Command Permission from 
the popup menu.

DNA displays the Add Permissions window, which lists all DNA users and 
groups.

6. Select the DNA users and groups you want to have permission to gather 
and export Call Accounting data.

To select multiple entries, hold down the Ctrl key as you click the entries.

7. Click OK.

Assigning History Log Permissions

DNA automatically allows all users to view their own history logs, but it does not 
automatically allow users to view other users’ history logs. This section explains 
how to give DNA users permission to view other users’ history logs.

1. Click the DNA Admin button on the toolbar.

2. Double-click on Hosts.

3. Click the host that contains the Core Services software.

4. Right-click the Event Log Service and select Permissions from the popup 
window.

5. Right-click View Other Administrator’s Events and select New>Command 
Permission from the popup menu.

DNA displays the Add Permissions window, which lists all DNA users and 
groups.



DEFINITY Network Administration Release 3
Planning, Installation, and Configuration  555-233-602CI  

Issue 2
December 2000

Configuring DNA 
218Initializing DEFINITY Databases 

16

6. Select the DNA users and groups you want to have permission to view all 
history logs.

To select multiple entries, hold down the Ctrl key as you click the entries.

7. Click OK.

Initializing DEFINITY Databases

After you register and configure the Device Services for DEFINITY ECS Systems, 
you can initialize DNA’s databases. This process loads the DEFINITY translations 
and configuration information into the Device Service database for that switch.

NOTE:
Initializing a DEFINITY database can take several hours, and during that 
time you cannot use DNA to perform any other activity on that switch. 
Initialization time varies depending on the number of stations, trunks, and 
enabled switch features, as well as the dial plan configuration and other 
variables. Perform this activity during low-use periods.

1. In the DNA Admin window, double-click the Host folder.

2. Click on the host containing the Device Service for the DEFINITY you want 
to initialize.

3. Right-click on the DEFINITY System you want to initialize and select 
Properties from the popup menu.

4. Click the DEFINITY ECS tab.

5. Click the Initialize Now button.

6. Confirm that you want to initialize the database by clicking OK.

DNA begins copying translations from the DEFINITY System to the Device 
Service database that supports it.

Setting Resynchronization Intervals

DNA’s Device Service contains a copy of a switch’s translations in a “mirror image 
database.” The database and the switch must stay in sync in order for DNA to 
work. They stay in sync if you use DNA’s wizards or GEDI to make changes to the 
switch. They can fall out of sync if you use anything else to administer the switch, 
including: terminal emulation, SAT, G3-MA, TERRANOVA, DEFINITY Site 
Administration (DSA), Centre Vu Supervisor, Call Management System (CMS), or 
any third-party software application.

To adjust for infrequent or minor differences between a switch and its database, 
DNA offers a resynchronize feature. This feature issues a “list history” command 
on the switch and compares the switch changes to those made in the database. If 
DNA finds changes in the switch’s history log that are not in its database, it will 
copy them into the database.
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However, the resynchronization feature is only a stop-gap measure:

■ DNA cannot reproduce any add <object> next commands in its 
databases (except for add station next on switches of less than 5000 
stations) because the precise extension has not been recorded in the “list 
history” log.

■ Combinations of adds, removes, and changes may result in dependencies 
that cannot be reproduced in the DNA database.

For these reasons, to ensure that DNA databases stay in sync with the switches 
DNA supports, only use GEDI or DNA’s wizards to administer DNA-supported 
switches.

NOTE:
If you make many changes or large changes to the switch using something 
other than DNA’s wizards or GEDI, you may exceed DNA’s ability to 
resynchronize its databases. If that happens, DNA will tell you in its History 
Log that you must re-initialize the DNA databases. Reinitializing can take 
several hours (see page 218).

To set the resynchronization interval, complete the following steps:

1. On the toolbar menu, select Custom Task>Resynchronization...

DNA displays the resynchronization wizard.

2. In the selection window, type the name of the switch you want to 
resynchronize DNA with. Optionally, click Browse to locate it, and then click 
Select.

3. Click Finish.

4. Accept the default values for Description, Path, Administrator, Script 
Engine, and Stop/Continue on Error fields.

5. Click Repeated.

6. Specify when you want the resynchronizations to occur:

a. In the First field, specify the date on which you want the task to start.

b. In the Last field, specify the date on which you want the task to end. 

Do not leave the date blank.

c. In the Times area, select a time from the drop-down list and click 
Add to add it to the list of times when you want the task to run. To 
delete a time, highlight it and click Delete.

d. In the Days area, click the days on which you want the task to run.

7. Click OK.
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Setting Scheduled Maintenance 
Intervals

If you know when your switch will be performing scheduled maintenance, you can 
tell DNA to stop administration activities during that period so that maintenance 
can occur without interruption. DNA users who check on the status of their 
submissions during that time will see that the submissions have failed.

NOTE:
This feature does not prevent others from accessing the switch via SAT 
terminals or other forms of terminal emulation; it merely blocks DNA tasks 
from executing on the switch.

To set a scheduled maintenance interval, complete the following steps:

1. Click the Task Editor button on the toolbar.

2. Select Edit>Insert>Custom Task>Sleep.

3. In the Device box, enter (or click Browse to search for) the name of the 
device.

4. In the Hours and Mins boxes, enter the number of hours and minutes you 
want DNA to block DNA-administration to the switch.

5. Click Finish.

DNA inserts the sleep task in the Task Editor window.

6. Highlight the sleep task and select File>Schedule.

7. Accept the default values for Description, Path, Administrator, Script 
Engine, and Stop/Continue on Error fields.

8. Click Now, Once, or Repeated.

If you click Now, go to step 10. If you click Once or Repeated, DNA 
displays the Schedule Task dialog box; go to step 9. (We recommend 
selecting Repeated.)

9. Specify when to block DNA tasks from being sent to the switch:

a. In the First field, specify the date on which you want the task to start.

b. In the Last field, specify the date on which you want the task to end. 

Do not leave the date blank.

c. In the Times area, select a time from the drop-down list and click 
Add to add it to the list of times when you want the task to run. To 
delete a time, highlight it and click Delete.

d. In the Days area, click the days on which you want the task to run.

10. Click OK.
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Testing the Installation

To test that you have correctly installed and configured all the components of 
DEFINITY Network Administration (DNA), complete the following sections.

Testing Connections

To test DNA’s connections to supported devices, complete the following steps:

1. Start DNA (page 190) and log in (page 190).

2. Click the DNA Navigator button on the toolbar.

3. Double-click the folder that contains the device you want to test.

4. Right-click the device and choose how you want to connect.

If you are testing the connections to a switch, select cut-through.

5. Enter a command and see if the device responds.

Testing Permissions

To test the permissions you set up, add some “test users” to DNA, put them in the 
user groups you have set up, and then log in as one of the test users and see if 
you can access the screens and execute the commands that you set up for that 
user group. Make sure that you cannot access areas of the system that were 
blocked to this user group, and that you cannot issue commands that were 
blocked to this user group.

If you notice problems, you either have the “test user” in the wrong user group or 
the permissions for that user group are set incorrectly.
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Troubleshooting Connections

In the table below, find the symptoms in the left column and follow the instructions 
in the right.

Symptom Solution

Folder does not appear or
folder does not open.

■ The folder has not been created (page 205), 
or 

■ The person performing the operation does not 
have permission to open the folder either 
because:

■ the user was not assigned to the proper 
group(s) (page 214), or

■ the group was not given proper 
permissions (page 214).

Device does not appear. ■ The device has not been registered (page 
193), or

■ The device has not been placed in the DNA 
Navigator (page 205), or 

■ The person performing the operation does not 
have permission to open the folder, either 
because

■ the user was not assigned to the proper 
group(s) (page 214), or

■ the group was not given proper 
permissions (page 214).

Folder and device appear, 
but right-clicking and 
selecting a connection 
method does not open the 
administration windows.

Check Connection Service settings (page 195). 
“Ping” the server. Be sure that hardware has been 
connected correctly (page 49).

Administration windows 
appear, but commands do 
not work.

Check permissions settings (page 215).
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This appendix provides the pinouts for the cables, wall jacks, and circuit packs 
described in this book. Table 13 shows the pinouts for the analog line, digital line, 
data line, and packet data line circuit packs. Use this table when wiring modems, 
data modules, and ADUs. 

Table 13. Circuit Pack Pinouts 

Wire 
Color 

Connector 
Pin 
Number

2-Wire Digital 
and Analog 
Line 16 Ports

4-Wire Digital 
and Data Line 
8 Ports

2-Wire 
Digital 
Line 24 
Ports

Packet 
Data Line

W-BL 26 T1 T1 TXT1
BL-W 01 R1 R1 TXR1
W-O 27 T2 TXT1 T2 PXT1
O-W 02 R2 TXR1 R2 PXR1
W-G 28 T3 PXT1 T3 TXT2
G-W 03 R3 PXR1 R3 TXR2
W-BR 29 T4 T4 PXT2
BR-W 04 R4 R4 PXR2
W-S 30 TXT2 T5 TXT3
S-W 05 TXR2 R5 TXR3
R-BL 31 PXT2 T6 PXT3
BL-R 06 PXR2 R6 PXR3
R-O 32 T7 TXT4
O-R 07 R7 TXR4
R-G 33 TXT3 T8 PXT4
G-R 08 TXR3 R8 PXR4
R-BR 34 T5 PXT3 T9 TXT5
BR-R 09 R5 PXR3 R9 TXR5
R-S 35 T6 T10 PXT5
S-R 10 R6 R10 PXR5
BK-BL 36 T7 TXT4 T11 TXT6

Continued on next page
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The following abbreviations apply for all circuit packs in this table. The wire colors 
apply only to B25A cables.

T Tip
R Ring
PX PBX transmit
TX Terminal transmit 

BL-BK 11 R7 TXR4 R11 TXR6
BK-O 37 T8 PXT4 T12 PXT6
O-BK 12 R8 PXR4 R12 PXR6
BK-G 38 T9 T13 TXT7
G-BK 13 R9 R13 TXR7
BK-BR 39 T10 TXT5 T14 PXT7
BR-BK 14 R10 TXR5 R14 PXR7
BK-S 40 T11 PXT5 T15 TXT8
S-BK 15 R11 PXR5 R15 TXR8
Y-BL 41 T12 T16 PXT8
BL-Y 16 R12 R16 PXR8
Y-O 42 TXT6 T17 TXT9
O-Y 17 TXR6 R17 TXR9
Y-G 43 PXT6 T18 PXT9
G-Y 18 PXR6 R18 PXR9
Y-BR 44 T19 TXT10
BR-Y 19 R19 TXR10
Y-S 45 TXT7 T20 PXT10
S-Y 20 TXR7 R20 PXR10
V-BL 46 T13 PXT7 T21 TXT11
BL-V 21 R13 PXR7 R21 TXR11
V-O 47 T14 T22 PXT11
O-V 22 R14 R22 PXR11
V-G 48 T15 TXT8 T23 TXT12
G-V 23 R15 TXR8 R23 TXR12
V-BR 49 T16 PXT8 T24 PXT12
BR-V 24 R16 PXR8 R24 PXR12
V-S 50
S-V 25

Table 13. Circuit Pack Pinouts  — Continued

Wire 
Color 

Connector 
Pin 
Number

2-Wire Digital 
and Analog 
Line 16 Ports

4-Wire Digital 
and Data Line 
8 Ports

2-Wire 
Digital 
Line 24 
Ports

Packet 
Data Line

Continued on next page
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Figure 35 shows the cross-connects between a data line circuit pack and a packet 
data line circuit pack.

Figure 35. Data Line-to-Packet Data Line Circuit Pack
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Figure 36 shows the main distribution frame (MDF) punch-downs for common 
circuit packs.

Figure 36. Punch-downs for Common Circuit Packs
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This appendix addresses some issues relating to the construction of UUCP 
send/expect strings that DNA uses for various scripts in the Connection Service.

The format of these strings is: 

send expect send expect...

where each send/expect component is separated from the next by spaces. When 
DNA executes a send/expect string, the ‘send’ component is sent and DNA waits 
for the ‘expect’ component to be received, or until some timeout expires, at which 
point the operation will fail.

To allow for some form of conditional processing, the ‘expect’ string can also be 
broken down into the following components:

subexpect-subsend-subexpect-subsend-subexpect...

where each subexpect/subsend component is separated from the next by a 
single ‘-’(minus) sign. If DNA does not receive this ‘subexpect’ within some 
timeout, it will then send the following ‘subsend’ and wait for the next ‘subexpect.’ 
If the ‘subexpect’ is received, the rest of the subexpect/subsend string is ignored, 
and processing will continue with the next ‘send’ string. This process of waiting for 
a ‘subexpect’ and sending the next ‘subsend’ will continue until a ‘subexpect’ 
match is received (at which point the following ‘send’ will be sent), or until the 
subexpect/subsend sequence is exhausted (at which point the script will fail).
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Within each send/expect/subsend/subexpect string, a number of escape 
sequences can be used that control the device in special ways. Each escape 
sequence starts with a ‘\’ character. The meaning of the various sequences are:

When a send/subsend string is sent to a device, there are no new line or carriage 
returns automatically appended. If you need one to be sent, you must include it in 
the send/subsend string.

Also, within the login and dial scripts, a number of ‘%’ delimited variables are 
recognized as follows:

Sequence Meaning

\b Backspace character

\n New line character

\p Pause for 400 milliseconds

\r Carriage return character

\s Space character

\t Tab character

\% ‘%’ character

\\ ‘\’ character

\ooo The null character represented 
by the octal (0-7) value ‘ooo’

\N NULL ‘\000’ character

\B BREAK sequence

\S Skip this whole string and go to 
the next 
send/expect/subsend/subexpec
t string

Variable Meaning

%phoneNumber% The phone number to dial

%login% The login name

%password% The login password

%termtype% The terminal type specified by the DNA application for 
this device

%%challenge% The challenge the device issued for ASG 
authentication. (%% is intentional.)

%response% The response that DNA generated for the given 
challenge.
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A sample that demonstrates most of these concepts is the following login script, 
which is used for logging into DEFINITY AUDIX devices.

\r ogin:-\r-ogin:-\r-ogin: %login%\r assword: %password%\r [513]

The processing of this string is as follows:

1. Send a carriage return.

2. Wait for the ‘ogin:’ portion of the ‘login:’ prompt. If that is received, then 
continue at Step 7.

3. If this is not seen within some timeout, then send another carriage return.

4. Wait for ‘ogin:’ once more. If that is received, then continue at Step 7.

5. If this is still not seen, send a final carriage return.

6. Wait a final time for the ‘ogin:’ prompt. If this is not seen, then abort the 
script.

7. Send the login name (expanded from %login%) that DNA provides followed 
by a carriage return.

8. Wait for the ‘assword:’ portion of the ‘password:’ prompt.

9. Send the login password (expanded from %password%) that DNA 
provides followed by a carriage return.

10. Wait for the terminal type prompt (‘[513]’) that the DEFINITY AUDIX next 
provides.
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Glossary and Abbreviations

Numerics

103A
A modular wall jack.

A

ADU
Asynchronous data unit. Once of several connection devices you can use to connect DNA comput-
ers to the telephony devices DNA supports.

ASG
Access Security Gateway. A security feature available in DNA and optionally on your DEFINITY 
ECS system or AUDIX system.

C

component
A unit of the DNA software.

connection device
A modem, data module, asynchronous data unit (ADU), null modem cable, or terminal server you 
use to connect DNA computers to the telephony devices that DNA supports.

connection method
The general means by which you can connect your DNA computers to the telephony devices that 
DNA supports: direct serial connection, dial-up serial connection, and network (TCP/IP) connection.

Connection Service
A component of DNA that keeps information about any connection devices (modems, data mod-
ules, terminal servers, and so on) that DNA uses to communicate with the telephony devices it sup-
ports. 

Core Services
A component of DNA that enables DNA’s different parts to recognize each other, provides a naviga-
tional interface to the user, maintains a schedule of changes to be made to the telephony devices, 
and executes the changes.

D

device
See telephony device or connection device.
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Device Service
A component of DNA that keeps information about the different telephony devices (switches, voice 
mail systems, and so on) that DNA supports.

DIP
Dual Inline Package.

DNA
DEFINITY Network Administration. This product.

DNS
Domain Name Server.

E

ENP
Enhanced Number Portability. An optional DNA feature that enables you to move a station (and 
optionally a voice mail subscriber) from one DEFINITY ECS (and AUDIX) to another within a 
pre-defined network. 

EPN
Expansion Port Network. In this book, an EPN can be considered a secondary switch cabinet or set 
of switch cabinets that serve the primary switch cabinet, which contains the Primary Port Network. 
See also PPN.

L

LAN
Local Area Network. A local data network. See also WAN.

P

PPN
Processor Port Network. In this book, PPN simply designates the main switch cabinet on any 
switch.

PSTN
Public Switched Telephone Network.

S

SAT
System Access Terminal. The dumb terminal that comes with a DEFINITY switch and is connected 
to it via a direct serial connection to the TERMINAL or TERM port on the back of the switch cabinet.
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telephony device
Any switch, voice mail system, or other adjunct you are using DNA to administer.

TERMINAL port
The port on the back of a DEFINITY switch that is used for direct serial connections to SATs or other 
computers used to administer the switch.

W

WAN
Wide Area Network. A data network that links two physically or geographically distant locations. 
See also LAN.
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Index

Symbols 

<next> commands and resynchronization, 219 

Numerics 

7-bit, 125, 127 
8-bit, 125, 127 

A 

access ports, setting up, 145 
access security gateway 

See ASG 
adding 

devices to DNA Navigator, 205, 206 
devices to the Admin window, 193 
DNA users, 206 
objects to folders, 206 
users to groups, 214 

admin login, 117 
ADUs 

connecting to DEFINITY AUDIX via, 160 
connecting to DEFINITY via, 133 

with terminal server, 126 
connecting to Intuity AUDIX via, 149 

aliases, 177 
answer only interface, 156, 167 
ASG 

defined, 231 
enabling 

between DNA and device, 200 
between user and DNA, 206 
on switch admin login, 118 
on switch upload login, 116 
on your switch, 115 

UUCP % delimiters, 228 
assigning 

call accounting permissions, 217 
command permissions, 214 
folder permissions, 190, 215 
history log permissions, 217 
permissions, 214 
scheduler permissions, 216 

asynchronous serial ports, 125, 127, 130 

B 

books 
uninstalling, 183 
viewing online, 183 

booting DNA, 190 
browser requirements, 173 
Button Label Printer Service 

adding more, 180 
configuring, 200 
installing, 175, 178 
names, 178 
registering, 192 
reinstalling, 180 
removing, 184 

C 

cable 
EIA & RS-232, 123 

call accounting permissions, assigning, 217 
calling Lucent, 114 
circuit packs, 123 

digital line, 137, 153 
matching to line types, 124 
pinouts, 223 

circuits, protecting, 122 
colors 

common cross-connect punch-downs, 226 
packet data line-to-data line circuit pack, 225 

command permissions, assigning, 214 
components 

installing ENP, 181 
installing standard, 175 
placing on correct OS, 175 

computers, registering, 191 
configuring 

Button Label Printer Service, 200 
Connection Service, 195 
Device Service, 200 
DNA, 189 
DNA Navigator, 205 
end point scripts, 196 
end points, 198 
ENP Service, 203 
resynchronization intervals, 218 
serial device scripts, 195 
serial ports, 197 
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connecting 
to DEFINITY 

via ADUs, 133 
via data modules, 136 
via INADS, 123 
via modem pool, 140 
via PPN, 123 
via terminal server, 125 
via terminal server & ADU, 126 
via terminal server & data module, 129 

to DEFINITY AUDIX 
via ADUs, 160 
via data modules, 163, 169 
via null modem, 158, 159 

to Intuity AUDIX 
via ADUs, 149 
via data modules, 151 
via network port, 148 
via null modem, 147 

connection 
DEFINITY 

guidelines, 123 
supported connections to, 123 

Connection Service 
adding more, 180 
configuring, 195 
installing, 175 
opening admin window, 195 
registering, 192 
reinstalling, 180 
removing, 184 

Core Services 
installing, 175, 178 
reinstalling, 180 
removing, 184 

creating 
folders in DNA Navigator, 205 
user groups, 214 

D 

data modules 
connecting to 

DEFINITY AUDIX via, 163, 169 
DEFINITY via, 136 
DEFINITY with terminal server, 129 
Intuity AUDIX via, 151 

databases 
initializing DNA, 218 

DDE interactions, 173 
default 

login, 190 
password, 190 
userid, 190 

DEFINITY 
connecting to 

via ADUs, 133 
via data modules, 136 
via modem pooling, 140 
via terminal server, 125 
via terminal server & ADU, 126 
via terminal server & data modules, 129 

connections, 123 
enabling 

ASG, 115 
DNA, 114 

initializing databases, 218 
logins 

admin, 117 
enabling upload, 117 
initialization, 115 
upload, 115 

maintenance, preparing for, 220 
matching circuit packs to line types, 124 
preparing for DNA, 113 
testing 

See connecting to 
DEFINITY AUDIX 

connecting via ADUs, 160 
connecting via data modules, 163, 169 
connecting via null modem, 158, 159 

deinstalling, 184, 185 
deleting, DNA files, 185 
Device Service 

adding more, 180 
adding to DNA Navigator, 206 
configuring, 200 
installing, 175, 179 
names, 179 
registering, 193 
reinstalling, 180 
removing, 184 

devices 
adding to DNA Navigator, 206 

digital line circuit pack, 137, 153 
DNA Navigator 

adding devices to, 206 
adding objects to folders, 206 
configuring, 205 
creating folders in, 205 

DNA users 
adding, 206 
adding to groups, 214 

DNS, 176, 181 
tables, 177 

documentation 
installing, 183 
removing, 183, 184 
upgrading, 187 
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E 
EIA-232 cables, 123 
e-mail 

configuring on DNA, 208 
format, determining, 210 
requirements, 173, 208 
specifying address, 210 
specifying triggers, 210 

end point scripts 
configuring, 196 
defined, 196 

end points 
configuring, 198 
defined, 196 

ENP 
configuring, 203 
installing, 181 
registering, 194 

EPN, 123 
event notification, 173, 208 

F 

features, enabling 
ASG on your switch, 115 
DNA on your switch, 114 

files, removing, 185 
flow control, 125, 127, 130 
folders 

adding objects to, 206 
assigning permissions, 190, 215 
creating in DNA Navigator, 205 

FQDN 
and DNS, 177 
determining, 176, 177, 182 
example, 176, 177, 182 
using consistently, 191 

G 

groups 
creating, 214 
understanding, 66 

H 

hardware 
testing 

See DEFINITY, DEFINITY AUDIX, or 
Intuity AUDIX 

help with installation, 9 

history log 
assigning permissions, 217 
reinitialize notification, 219 

host computers, registering, 191 

I 

IE 4, 173 
INADS, connecting via, 123 
in-band flow control, 125, 127, 130 
initialization account 

creating, 115 
enabling, 117 

initializing, 219 
databases, 218 

installation 
checklist, 6 
getting help, 9 
overview, 6 
planning, 173 
prerequisites, 173 
testing, 221 

installing 
Button Label Printer Service, 175, 178 
Connection Service, 175 
Core Services, 175, 178 
Device Service, 175, 179 
documentation, 183 
ENP, 181 
on correct OS, 175 

interactions, OLE & DDE, 173 
Internet Explorer 

see IE 4 
Intuity AUDIX 

connecting to 
via ADUs, 149 
via data modules, 151 
via network port, 148 
via null modem, 147 

testing 
See connecting to 

L 

line types, matching to circuit packs, 124 
list history and resynchronization, 218 
logging on, 190 
logins 

admin, 117 
default, 190 
enabling initialization, 117 
enabling upload, 117 
initialization, 115 
upload, 115 

Lucent sales support, 114 
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M 

Main Distribution Frame, 123 
maintenance, preparing DNA for, 220 
MDF, 123 
MDF punch-downs, 226 
Microsoft 

Exchange, 173, 208 
IE 4, 173 

modem pool 
connecting to DEFINITY via, 140 

N 

naming 
Button Label Printer Services, 178 
Device Services, 179 

Navigator, DNA 
adding devices to, 206 
configuring, 205 
creating folders in, 205 

network port, connecting to Intuity AUDIX, 148 
notification, e-mail, 173, 208 
NT servers, placing, 173 
null modem 

connecting to DEFINITY AUDIX via, 158, 159 
connecting to Intuity AUDIX via, 147 

O 

objects, adding to folders, 206 
OLE interactions, 173 
online 

documentation 
installing, 183 
removing, 184 
upgrading, 187 

help, requirements, 173 
opening DNA, 190 
operating systems, and DNA, 175 
options, enabling 

ASG on your switch, 115 
DNA on your switch, 114 

overview 
configuring DNA, 189 
registering the Connection Service, 195 

P 

password 
changing root, 191 
default, 190 

pcANYWHERE, 173, 174 
permissions 

assigning, 214 
call accounting, 217 
device command, 214 
folder, 190, 215 
history log, 217 
scheduler, 216 
understanding categories, 65 

phone numbers, sales support, 114 
PING, 7 
pinouts, 223 

packet data line jumpered to data line, 225 
planning, location of NT servers, 173 
ports 

asynchronous serial, 125, 127, 130 
INADS, 123 
serial, configuring, 197 
system access, setting up, 145 
TERMINAL, TERM, SAT, 123 

PPN, 123 
prerequisites, installation, 173 
printers, configuring, 200 
protection, circuit, 122 

R 

registering 
Button Label Printer Service, 192 
Connection Service, 192 
Device Services, 193 
ENP Service, 194 
host computers, 191 

reinitializing, 218, 219 
and resynchronization, 219 

reinstalling services, 180 
removing 

DNA, 184 
DNA files, 185 
documentation, 184 
electronic books, 183 

requirements 
for remote troubleshooting, 173 
pre-installation, 173 

resynchronization, 218 
and reinitialization, 219 
limitations, 219 

RS-232 cable, 123 



DEFINITY Network Administration Release 3
Planning, Installation, and Configuration  555-233-602CI    

Issue 2
December 2000

Index 
239 

S 

SAT port, 123 
scheduler permissions, assigning, 216 
scheduling 

resynchronization, 218 
switch maintenance, 220 

scripts 
end point, 196 
serial device, 195 

secret key, 116, 118 
security, 123, 174 
serial device scripts 

configuring, 195 
defined, 195 

serial ports, configuring, 197 
setting up 

Button Label Printer Services, 200 
call accounting permissions, 217 
command permissions, 214 
Connection Service, 195 
data directories, 190 
DEFINITY databases, 218 
Device Services, 200 
DNA, 189 
DNA Navigator, 205 
DNA user groups, 66 
DNA users, 206 
e-mail, 208 
end point scripts, 196 
end points, 198 
ENP, 203 
folder permissions, 215 
folders, 205 
history log permissions, 217 
maintenance intervals, 220 
resync intervals, 218 
resynchronization intervals, 218 
scheduler permissions, 216 
serial device scripts, 195 
serial ports, 197 
system access ports, 145 

sleep, 220 
starting DNA, 190 
strings, UUCP, 227 
switch maintenance, preparing for, 220 
switches 

adding administrative login, 117 
adding upload login, 115 
enabling 

ASG on, 115 
DNA on, 114 
upload login on, 117 

preparing for DNA, 113 
upgrading, 113 

Symantec 
See pcANYWHERE 

T 

telephone circuits, protecting, 122 
telnet protocol, 125, 127 
TERMINAL port, 123 
terminal server 

connecting to DEFINITY, 125 
with ADU, 126 
with data modules, 129 

testing installation, 221 
troubleshooting, 222 

with pcANYWHERE, 173 
typographical conventions, 2 

U 

understanding 
pcANYWHERE, 174 
user groups, 66 

uninstalling, 184, 185 
upgrading 

DNA, 186 
documentation, 187 
switches, 113 

upload login, 115 
enabling, 117 

user groups 
adding users to, 214 
creating, 214 
understanding, 66 

userid, default, 190 
users 

adding, 206 
adding to groups, 214 

UUCP send/expect strings, 227 

V 

viewing online documentation, 183 

W 

Windows OSs and DNA, 175 
wiring, 123 

X 

Xon/Xoff, 125, 127, 130 
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